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About This Document 

 

Who Should Read This Guide 
 
Read this guide if you use AT&T Route It!™ to set up and manage call routing for your  
AT&T Toll-Free Service. This guide describes how to use the Edit Plans feature of  
Route It! to create and change call-routing plans. It also explains how to create and  
manage Customer Routing Point (CRP) tables (currently available only in the United  
States). Also, the guide describes how to use the Comm Log to get the status of  
activities you and others complete in Route It! Finally, this guide explains how to  
manage Route It! mail messages.  
AT&T Route It! is part of AT&T Toll-Free Routing Control. 

 
Reasons For Reissue 

 
This document is reissued to document the following items for this release:  
� 

 
Update release number to 200 

 
7.2 

 
How to Use This Guide 

 
Beginners should understand the concepts of nodes, branches, and routing plans, as  
described in Chapter 3, “Routing Plan Concepts.” In addition, beginners should  
familiarize themselves with the tools for building plans, as described in the section  
“Tools for Building or Editing a Plan” in Chapter 4, “Creating or Editing a Plan.”  
Advanced users may want to review the plan-building tools described in the section  
“Tools for Building or Editing a Plan” in Chapter 4, “Creating or Editing a Plan.”  
It is assumed that Route It! users are familiar with the Microsoft Windows  
environment. For information on using the MS-DOS operating system or  
Windows, refer to the user’s guides supplied with the software. 
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Conventions Used 
 
This guide uses different fonts and styles to distinguish different types of information.  
The conventions used are listed below:  
� 

 
Text that appears on your screen is shown in bold type, like this: System Admin.  
Screen text includes prompts, field names, menu items, error messages, or any  
other information displayed by the program.  

� 
 
The response the system makes after you enter a command is described on a  
new line, for example:  
From the File menu, choose Open.  
The Open dialog box appears.  

� 
 
Screen buttons are shown like this: OK.  

� 
 
The terms select and choose are used throughout this document to indicate that  
you should press and release the left mouse button when the pointer is on an item  
in the software, such as a menu option or list item.  
— The term select indicates the selection and highlighting of one or more items  

in a list. For example: Select a dialed number from the list box.  
— The term choose indicates the selection of a menu command or button that  

results in action being taken in the software. For example: From the File  
menu, choose Open.  

For certain functions, you may need to click the right mouse button. The  
documentation describes when you need to click the right mouse button.  

� 
 
The document contains reminders that alert you to additional and important  
information:  
; 

 
USAGE TIP:  
Provides helpful information, such as an alternate way of choosing a menu  
command.  
NOTE :  
Alerts you to additional information.  

+ 
 
IMPORTANT:  
Informs you that the feature described will be available in a future version of  
Route It! 

 
! 

 
CAUTION:  
Alerts you to the extra importance of information contained in an explanation  
or in a procedure. 

 
! 

 
WARNING:  
Indicates the presence of a hazard that will or can cause equipment damage,  
loss of software or data, or service interruption if the hazard is not avoided. 
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Glossary Conventions 
 
The glossary in this guide uses different fonts and styles to distinguish different types  
of information. The conventions used are listed below:  
� 

 
Text that appears on your screen is shown in bold type, like this: 999-000-3001.  

� 
 
When a term used in a definition is defined elsewhere in the glossary, it appears  
in bold type, like this: Allocator Node. 

 
Related Documentation 

 
This user’s guide is part of a four-document set that also includes:  
� 

 
AT&T Route It! Installation User’s Guide  
(Order # 585-236-165).  
This guide describes how to install and set up Route It! It also explains how to set  
up Route It! user permissions.  

� 
 
AT&T Route It! Schedules and Quick Changes User’s Guide  
(Order # 585-236-161-03).  
This guide explains how to schedule different aspects of your call-routing plans.  
For example, it describes how to schedule the use of one or more routing plans by  
day of week and by time of day. It also explains how to request quick changes to  
the schedules you create.  

� 
 
AT&T Route It! Administration Guide (Order # 585-236-162-03).  
This guide describes how to use the Customer Profile feature of Route It! to view  
information about provisioned data, such as dialed numbers, terminations,  
queues, and announcements. In addition, this guide explains how to update plan  
data using the Refresh function. 

 

AT&T — PROPRIETARY  
Use pursuant to Company Instructions 

 
AT&T Route It! 

 
 xxi 



  

 

Finding Route It! Information 
 
Use Table 1 to determine which Route It! guide contains general Route It! information.  
Use Table 2 to help locate information about a specific Route It! task. 

 
Table 1.  Finding General Information in Route It! Documents 

 
To Find Information About... 

 
See the AT&T Route It!... 

 
Route It! hardware and software  
requirements, installation proce-  
dures, setting Route It! user permis-  
sions, connecting your PC to the  
support system 

 
Installation User’s Guide. 

 
Route It! administrative features, that  
is, Customer Profile, Refresh, and  
System Administration 

 
Administration Guide. 

 
Route It! features and functions,  
AT&T Toll-Free Calling Services,  
AT&T Advanced Features, and start-  
ing Route It! 

 
Edit Plans User’s Guide, Chapter 1,  
“Overview.” 

 
Using Route It! with Windows 

 
Edit Plans User’s Guide, Chapter 2, “Using  
Route It! with Windows.”  

Possible changes made to your rout-  
ing plans when a new area code is  
created for a geographical region 

 
Edit Plans User’s Guide, Appendix A,  
“Managing Area Code Split Updates.” 

 
Validation performed by the support  
system when a dialed number sub-  
scribes to the Redirect or Alternate  
Destination Routing (ADR) AT&T  
Advanced Feature 

 
Administration Guide, Appendix A,  
“Advanced Feature Rules.” 
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Table 2.  Finding Specific Task Information in Route It! Documents 
 

For This  
Application 

 
To Find Information About... 

 
See the AT&T Route It! ... 

 
User Setup 

 
Adding, modifying, and removing  
setup information for Route It!  
users, and changing user permis-  
sions 

 
Installation User’s Guide,  
Chapter 4, “User Setup,”  
and Administration Guide,  
Chapter 5, “User Setup.” 

 
Edit Plans 

 
Changing your password 

 
Edit Plans User’s Guide,  
Chapter 1, “Overview.”  

Basic concepts of routing plans  
and their nodes and branches,  
Service Dates, Service View, and  
plan validation 

 
Edit Plans User’s Guide,  
Chapter 3, “Routing Plan  
Concepts.” 

 
Creating and editing routing plans,  
working with nodes and branches,  
overriding the percentages of Allo-  
cator node branches in an active  
schedule in five minutes or less,  
displaying plan information, dis-  
playing node and branch data, sav-  
ing, deleting, and printing plans,  
updating plan data, and getting  
plans validated in preparation for  
use in routing calls 

 
Edit Plans User’s Guide,  
Chapter 4, “Creating or  
Editing a Plan.” 

 
Creating, modifying, printing, and  
deleting labels for values or names  
in branch and node fields 

 
Edit Plans User’s Guide,  
Chapter 5, “Labels.” 

 
Inquiries 

 
Searching for Dialed Number and  
Terminating Routing Number infor-  
mation. 

 
Administration Guide,  
Chapter 6, “Inquiries.” 

 
CRP Tables 

 
Creating and editing CRP tables,  
creating and editing future  
changes to CRP tables, assigning  
CRP databases to tables, and get-  
ting information on CRP tables and  
terminations and announcements  
(currently available only in the  
United States) 

 
Edit Plans User’s Guide,  
Chapter 6, “CRP Tables.” 
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Table 2.  Finding Specific Task Information in Route It! Documents (Cont’d) 
 

For This  
Application 

 
To Find Information About... 

 
See the AT&T Route It! ... 

 
Mail 

 
Opening, sorting, printing, and  
deleting Route It! mail messages 

 
Edit Plans User’s Guide,  
Chapter 8, “Displaying Mail  
Messages.” 

 

Scheduler 

 

Features common to each sched-  
ule type, an overview of working  
with schedules and making quick  
changes 

 

Schedules and Quick  
Changes User’s Guide,  
Chapter 1, “Scheduler  
Basics.”  

Creating, editing, saving, and print-  
ing plan schedules, sending sched-  
ules to the support system, and  
changing the Service View 

 
Schedules and Quick  
Changes User’s Guide,  
Chapter 2, “Scheduling  
Plans.”  

Specifying the MCA (maximum  
calls allowed) at a given ATS  
(Alternate Termination Sequence)-  
type termination, specifying the  
MCQ (maximum calls in queue) 

 
Schedules and Quick  
Changes User’s Guide,  
Chapter 3, “Scheduling  
MCA and MCQ Values.” 

 
Quick Changes 

 
Overriding the values in an active  
schedule in either 5 or 15 minutes,  
resuming original schedule values,  
changing the query status of a  
CRP table in 5 minutes, and  
changing the Service View 

 
Schedules and Quick  
Changes User’s Guide,  
Chapter 4, “Quick  
Changes.” 

 
Comm Log 

 
Displaying, printing, and saving  
messages in the Comm Log and  
customizing the look of the Comm  
Log 

 
Edit Plans User’s Guide,  
Chapter 7, “Comm Log.” 
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Table 2.  Finding Specific Task Information in Route It! Documents (Cont’d) 
 

For This  
Application 

 
To Find Information About... 

 
See the AT&T Route It! ... 

 
Customer Profile Your provisioned data, using Cus-  

tomer Profile to rename data items,  
changing the service area of a ter-  
mination, or changing the timeout  
treatment for a queue 

 
Administration Guide,  
Chapter 2, “Customer  
Profile.” 

 
Rules for changing the service  
area of an access line 

 
Administration Guide,  
Chapter 2, “Customer Pro-  
file,” and Appendix B, “Ser-  
vice Area Rules.”  

Refresh 
 
Updating general AT&T informa-  
tion and detailed account-specific  
data, comparing the Route It! Ser-  
vice Dates with the support system  
Service Dates, requesting a list of  
transactions for a specific account 

 
Administration Guide,  
Chapter 3, “Refresh.” 

 
System Admin 

 
Disconnecting your PC from the  
support system, backing up and  
restoring your Route It! database,  
entering or changing selections for  
automatic Refresh, support system  
message polling, scheduled  
Refresh, purging Comm Log mes-  
sages, installing Route It! patches,  
removal of account data, and SMW  
(Service Management Worksta-  
tion) ID 

 
Administration Guide,  
Chapter 4, “System Admin-  
istration.” 

 
Setting Route It! user permissions,  
adding and modifying Route It!  
users, and removing Route It! user  
access 

 
Administration Guide,  
Chapter 5, “User Setup.” 

 
How to Order Documentation 

 
The order number for this document is 585-236-160-03. To order an additional copy of  
this document or any of the documents mentioned under the heading “Related  
Documentation,” contact your AT&T account representative. 
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Receiving Updates 
 
AT&T automatically provides Route It! software owners with updates of any Route It!  
software-related document. If you are not receiving updates, call 1 800 862-2237. Ask  
to be placed on the standing order list and indicate the documents by document order  
number. The document updates will be shipped to you as they become available. 

 
Getting Online Help 

 
Online help is available on every window through the Help menu. It is also available  
on every dialog box through the Help button. 

 
Route It! Security 

 
To help protect your Route It! data from theft or misuse, please adhere to these  
security requirements:  
� 

 
Store Route It! passwords and their corresponding user names separately.  

� 
 
When a user having Route It! access leaves your company, please call AT&T at  
1 800 862-2237 and choose Prompt 2 for Route It! support, within four hours, to  
have the user name and password reset.  

� 
 
If a laptop computer on which Route It! is installed is lost or stolen, please notify  
AT&T by calling 1 800 862-2237 and choosing Prompt 2 for Route It! support.  

In addition, it is your responsibility to perform virus checks on any software files  
residing on or used on the same PC where Route It! is installed. 

 
Route It! Training 

 
AT&T offers an instructor-led training course on Route It! at AT&T training  
facilities in Irvine, California. For scheduling  
and registration information on these courses, please contact your AT&T account  
representative. 

 
Route It! Support 

 
For technical support with your Route It! software, please call 1 800 862-2237 and  
choose Prompt 2 for Route It! support. Route It! support is available 24 hours a day,  
7 days a week, in all of the continental United States and Canada. 
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Overview 

 

 
This chapter provides an overview of AT&T Route It!, AT&T Toll-Free Calling Services,  
and AT&T Advanced Features, all part of AT&T Toll-Free Routing Control. This  
chapter also describes how to start Route It! 

 
Introduction to Route It! 

 
Route It! lets you use a PC to design and control the routing of incoming toll-free calls.  
With Route It!, you design a graphical call-routing plan or plan. To use the plan for call  
processing, you send it to the AT&T host support system, where it is validated and  
activated for call routing.  
The routing plans you create maximize your use of AT&T Advanced Features,  
allowing you to route calls according to your specific needs. For example, you can  
choose to route calls based on the time of day, or based on a call’s area code and  
exchange, or both. Route It! lets you specify the exact times, area codes, and  
exchanges—all from a familiar Windows environment.  
In addition, you can design and build alternate routing plans and store them on your  
PC for later activation. The Quick Changes feature of Route It! lets you change  
aspects of your call routing in minutes to accommodate unexpected changes in call  
traffic.  
This chapter provides background information on AT&T Toll-Free Calling Services and  
AT&T Advanced Features. 
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Chapter 1  Overview  
AT&T Toll-Free Calling Services 

 

AT&T Toll-Free Calling Services 
 
United States 

 
AT&T Toll-Free Service allows your customers to call your business free of charge.  
Route It! is used with any of these AT&T Toll-Free Services:  
AT&T Classic 800  
Service 

 
AT&T Classic 800 Service (also known as Basic 800 Service) pro-  
vides toll-free inbound calling by geographic regions, called service  
areas. Subscribers select the service area from which they want to  
receive calls. Calls are routed to dedicated access lines, which are  
used exclusively for incoming calls. Billing is based on the service  
area where the calls originate and the dedicated access line on  
which they terminate.   

AT&T Toll-Free  
MEGACOM 

 
®  

Service  

AT&T Toll-Free MEGACOM Service lets subscribers define geo-  
graphic areas or specific area codes from which to receive calls,  
thus giving them more control over their market coverage.  
MEGACOM provides toll-free calling to callers anywhere in the  
United States and Canada.  

AT&T Toll-Free  
READYLINE 

 
®  

Service  

AT&T READYLINE Service provides the same capabilities as other  
toll-free services (such as Basic 800 and Toll-Free MEGACOM).  
However, with READYLINE, calls are routed to regular telephone  
lines that are currently at a termination, making dedicated access  
lines unnecessary. This makes READYLINE attractive when traffic  
volume is too small to purchase dedicated access lines.   

AT&T Toll-Free  
MasterLine 

 
®  

Service  

AT&T Toll-Free MasterLine Service accepts interstate, intrastate,  
and Canadian toll-free calls on a single dedicated access line. It  
permits customers to combine all their usage requirements on a sin-  
gle access line, so the need to purchase separate lines for interstate  
and intrastate Numbering Plan Areas (NPAs) is eliminated. You can  
add I800 Inbound Service to the same line. Like Toll-Free MEGA-  
COM, MasterLine allows you to select the area codes from which  
calls will be received. 

AT&T I800 Inbound  
Service 

 
AT&T I800 Inbound Service provides toll-free inbound calling from  
overseas to terminations in the United States. I800 Inbound can be  
added on a termination with Toll-Free MEGACOM, READYLINE, or  
MasterLine, or it can be the single service type for a termination with  
Classic 800 Service.  

AT&T I800  
Outbound Service 

 
AT&T I800 Outbound Service provides toll-free service for calls that  
originate in the United States and route to foreign subscribers in  
another country. This service provides for the routing of calls to a  
single 7- to 12-digit international number. 
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AT&T Toll-Free  
CustomNet

 
®  

Service  

 
AT&T CustomNet is a combined domestic/international toll-free ser-  
vice that supports all Advanced Toll-Free Features and allows its  
subscribers to handle both I800 overseas/Mexico calls and originat-  
ing domestic calls. (This service type is equivalent to a previously  
available combination: AT&T READYLINE Service with an I800  
Inbound add-on.) 

FTS2000 
 
FTS2000 is a private government network offering toll-free service  
that serves the continental United States, Alaska, Hawaii, Guam,  
Puerto Rico, and the Virgin Islands.  

Toll-Free  
Multimedia 

 
Toll-Free Multimedia provides toll-free access to high-speed data  
transfer. It extends the traditional voice capability of toll-free service  
to include data, video, and images transmitted via PC or fax. Callers  
can use the same toll-free number for multiple applications and  
voice calls. 

 
Canada 

 
AT&T Toll-Free Service allows your customers to call your business free of charge.  
Route It! is used with any of these AT&T Toll-Free Services:  
AT&T Classic 800  
Service 

 
AT&T Classic 800 Service (also known as Basic 800 Service) pro-  
vides toll-free inbound calling by geographic regions, called service  
areas. Subscribers select the service area from which they want to  
receive calls. Calls are routed to dedicated access lines, which are  
used exclusively for incoming calls. Billing is based on the service  
area where the calls originate and the dedicated access line on  
which they terminate.   

AT&T Toll-Free  
MEGACOM 

 
®  

Service  

AT&T Toll-Free MEGACOM Service lets subscribers define geo-  
graphic areas or specific area codes from which to receive calls,  
thus giving them more control over their market coverage.  
MEGACOM provides toll-free calling to callers anywhere in the  
United States and Canada.  

AT&T Toll-Free  
READYLINE 

 
®  

Service  

AT&T READYLINE Service provides the same capabilities as other  
toll-free services (such as Basic 800 and Toll-Free MEGACOM).  
However, with READYLINE, calls are routed to regular telephone  
lines that are currently at a termination, making dedicated access  
lines unnecessary. This makes READYLINE attractive when traffic  
volume is too small to purchase dedicated access lines.   

AT&T Toll-Free  
MasterLine 

 
®  

Service  

AT&T Toll-Free MasterLine Service accepts interstate, intrastate,  
and Canadian toll-free calls on a single dedicated access line. It  
permits customers to combine all their usage requirements on a sin-  
gle access line, so the need to purchase separate lines for interstate  
and intrastate NPAs is eliminated. You can add I800 Inbound Ser-  
vice to the same line. Like Toll-Free MEGACOM, MasterLine allows  
you to select the area codes from which calls will be received.
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AT&T I800 Inbound  
Service 

 
AT&T I800 Inbound Service provides toll-free inbound calling from  
overseas to terminations in the United States. I800 Inbound can be  
added on a termination with Toll-Free MEGACOM, READYLINE, or  
MasterLine, or it can be the single service type for a termination with  
Classic 800 Service.  

AT&T I800  
Outbound Service 

 
AT&T I800 Outbound Service provides toll-free service for calls that  
originate in the United States and route to foreign subscribers in  
another country. This service provides for the routing of calls to a  
single 7- to 12-digit international number.  

AT&T Canada  
Northbound  
Service 

 
AT&T Canada Northbound Service provides toll-free service for  
calls that originate in the United States and route to alternate Cana-  
dian carriers. Calls are routed to Canada using either switched or  
direct egress.   

AT&T Toll-Free  
CustomNet

 
®  

Service  

AT&T CustomNet is a combined domestic/international toll-free ser-  
vice that supports all Advanced Toll-Free Features and allows its  
subscribers to handle both I800 overseas/Mexico calls and originat-  
ing domestic calls. (This service type is equivalent to a previously  
available combination: AT&T READYLINE Service with an I800  
Inbound add-on.)  

Uniline-Option 1/  
Unicom 800 

 
®  

AT&T Canada will provide its customers with Canadian versions of  
AT&T READYLINE Service and AT&T Toll-Free MEGACOM Ser-  
vice, called Uniline-Option 1 and Unicom 800, respectively. This  
service provides for intra-Canadian toll-free calls (calls originating  
and terminating in Canada). Uniline-Option 1 uses switched egress  
and Plain Old Telephone Service (POTS) traffic. Unicom 800 is a  
dedicated high-capacity service. 

Toll-Free  
Multimedia 

 
Toll-Free Multimedia provides toll-free access to high-speed data  
transfer. It extends the traditional voice capability of toll-free service  
to include data, video, and images transmitted via PC or fax. Callers  
can use the same toll-free number for multiple applications and  
voice calls. 
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AT&T Advanced Features 
 
United States 

 
AT&T Advanced Features give you more versatility and control in routing calls. You  
can subscribe to AT&T Advanced Features individually or in combinations. The call-  
routing plans you design will have one or more of these features:  
Alternate Destination  
Routing (ADR) 

 
This feature allows you to redirect a call to an alternate  
(secondary) termination rather than to the target (primary)  
destination if the call is not answered in a predefined period or if  
the call cannot be completed to the primary termination because  
of network congestion or egress failure.  

Alternate Termination  
Sequence (ATS),  
also known as  
Next Available Agent  
Routing (NAAR) 

 
This feature allows you to specify a sequence of terminations to  
which calls can be routed if the first termination reached is busy. It  
allows you to specify the maximum calls allowed (MCA) at each  
termination or to use a default value. A termination is considered  
busy when the total number of calls in progress meets or exceeds  
the MCA value for that termination.  

Area Code/Country  
Code Routing 

 
This feature allows you to specify different routes for calls that  
originate in different geographic areas, as defined by one or more  
area codes or, for I800 Service only, country codes.  

Caller Recognition  
Routing 

 
This feature allows you to route a call based upon the number  
from which the call originated. This is called Automatic Number  
Identification (ANI) Routing.  

Call Prompter 
 
This feature allows callers to route their own calls to one of  
several destinations by dialing one or more digits in response to a  
prompting announcement stored in the network. If the caller has a  
rotary-dial telephone or push-button telephone that generates  
rotary pulses, the call can be routed to an attendant for  
assistance. Invalid caller-dialed codes, or no response, are  
channeled along a default path that you have chosen.  
In addition, Automatic Speech Recognition (ASR) is an  
enhancement to the Call Prompter feature. ASR is available on a  
Controlled Introduction basis. 
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Caller Information  
Forwarding (CINFO) 

 
This feature allows special information to be forwarded with a call  
when it is routed to a termination. With CINFO, Caller Entered  
Digits (CEDs) are collected and passed on with a call. CINFO  
enhances customer service capabilities (for example, giving  
personnel at your answering locations instant access to an  
account number the caller has been prompted to enter). You may  
also use CINFO in combination with Intelligent Call Processing  
(ICP). When CINFO is used in conjunction with ICP, it allows  
additional Customer Database Provided Digits (CDPDs) to be  
collected and fowarded. When ICP is in effect (and your database  
is being queried for special routing instructions), other types of  
information stored in your database can also be passed along  
with a call.  

Courtesy Response 
 
This feature allows you to direct calls to an announcement as the  
final handling for the call. It is commonly used for calls received  
when an answering location is closed.  

Day Manager 
 
This feature allows you to specify different routes for calls made  
during different days of the week. It can be used to handle call  
traffic patterns that change predictably during the week.  

Dialed Number  
Decision 

 
This feature allows you to specify different routes for calls based  
on the toll-free number that was dialed. This service is useful  
when the same call-routing plan is used for more than one dialed  
number.  

Enroute  
Announcement 

 
This feature allows you to play an announcement at the beginning  
or middle of a routing plan.  

Exchange Routing 
 
This feature allows you to specify different routes for calls that  
originate in different geographic areas, as defined by one or more  
exchanges.  

Intelligent Call  
Processing (ICP) 

 
This feature allows you to implement specialized, call-by-call  
routing based on information in your own custom database. When  
ICP is in effect, network handling of an incoming call is  
temporarily suspended while your database is queried for any  
special routing instructions. Your database is referred to as a  
Customer Routing Point (CRP) application. (The process of  
consulting your database is known as a CRP query.)  
In addition, ASR is an enhancement to the digit prompter  
capability of the ICP feature. ASR is available on a Controlled  
Introduction basis. 
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Network  
Queuing 

 
This feature allows calls to be held in queue in the network until  
an ATS-type termination served by the queue is available to  
receive the call. With this feature, you can route calls to a delay  
announcement and music while calls are held in the AT&T  
network until they can be routed to an ATS-type termination or  
until they time out. Two types of network queues are supported:  
fixed queues and variable queues. A fixed queue is dedicated to  
one ATS-type termination, while a variable queue serves a  
variable number of ATS-type terminations.  

Quick Call Allocator 
 
This feature allows you to change the percentage of calls to be  
routed to each of two or more answering locations in five minutes  
or less. This is helpful when you need to make changes on an  
emergency basis. A single location can be assigned from 0 to 100  
percent of total call traffic. You can use this feature to distribute  
calls according to the differing sizes or capacities of various  
answering locations.  

Ring/Busy 
 
This feature allows you to direct calls to an audible ring or busy  
tone. This is a final-handling arrangement.  

Time Manager 
 
This feature allows you to specify different routes for calls made  
during different time intervals within a day. It can be used to route  
calls to answering locations in different time zones and also  
specify different call routing for calls placed after normal business  
hours.  

In addition to AT&T Advanced Features, Route It! also supports the Redirect feature.  
This feature, provided by a device in the AT&T network, allows your agents to use the  
AT&T network to redirect toll-free calls after they have answered them.  
There are two types of Redirect features, as described in Table 1-1.  

Table 1-1.  Redirect Features 
  

Post Answer Call  
Redirection  
(PACR),  
also known as  
Transfer Connect  

 
Enables agents to use their phones to transfer callers to other  
agents. PACR allows:  
� 

 
Blind transfer, where an agent transfers a call to a third party  
without verifying that the third party is available.  

� 
 
Consultation, where an agent transfers a call to a third party  
after verifying that the third party is available.  

� 
 
Conference, where an agent stays on the line while a third  
party is conferenced in.  

Recurrent Call  
Prompter (RCP) 

 
Enables agents to return toll-free callers to the initial call  
prompter announcement, from which they can reach other  
agents. 

 
Both PACR and RCP allow your customers to speak to other agents without having to  
hang up and redial. You may have subscribed to one or both Redirect features.  

NOTE :  
The Redirect features may be marketed under different names. 
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Canada 

 
AT&T Canada supports the following AT&T Advanced Features, referred to by AT&T  
Canada as Custom Routing Features. These features give you more versatility and  
control in routing calls. You can subscribe to AT&T Advanced Features individually or  
in combinations. The call-routing plans you design will have one or more of these  
features:  
Alternate Destination  
Routing (ADR) 

 
This feature allows you to redirect a call to an alternate  
(secondary) termination rather than to the target (primary)  
destination if the call is not answered in a predefined period or if  
the call cannot be completed to the primary termination because  
of network congestion or egress failure.  

Alternate  
Termination  
Sequence (ATS),  
also known as  
Next Available  
Agent Routing  
(NAAR) 

 
This feature allows you to specify a sequence of terminations to  
which calls can be routed if the first termination reached is busy. It  
allows you to specify the maximum calls allowed (MCA) at each  
termination or to use a default value. A termination is considered  
busy when the total number of calls in progress meets or exceeds  
the MCA value for that termination. 

 
Area Code Routing 

 
This AT&T feature allows you to specify different routes for calls  
that originate in different geographic areas, as defined by one or  
more area codes.  

Caller Recognition  
Routing 

 
This feature allows you to route a call based upon the number  
from which the call originated. This is called Automatic Number  
Identification (ANI) Routing.  

Call Prompter 
 
This feature allows callers to route their own calls to one of  
several destinations by dialing one or more digits in response to a  
prompting announcement stored in the network. If the caller has a  
rotary-dial telephone or push-button telephone that generates  
rotary pulses, the call can be routed to an attendant for  
assistance. Invalid caller-dialed codes, or no response, are  
channeled along a default path that you have chosen.  

Caller Information  
Forwarding (CINFO) 

 
This feature allows special information to be forwarded with a call  
when it is routed to a termination. With CINFO, Caller Entered  
Digits (CEDs) are collected and passed on with a call. CINFO  
enhances customer service capabilities (for example, giving  
personnel at your answering locations instant access to an  
account number the caller has been prompted to enter).  

Courtesy Response 
 
This feature allows you to direct calls to an announcement as the  
final handling for the call. It is commonly used for calls received  
when an answering location is closed.  

Day of Week 
 
This feature allows you to specify different routes for calls made  
during different days of the week. It can be used to handle call  
traffic patterns that change predictably during the week. 
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Dialed Number  
Decision 

 
This feature allows you to specify different routes for calls based  
on the toll-free number that was dialed. This service is useful  
when the same call-routing plan is used for more than one dialed  
number.  

Enroute  
Announcement 

 
This feature allows you to play an announcement at the beginning  
or middle of a routing plan.  

Exchange Routing 
 
This feature allows you to specify different routes for calls that  
originate in different geographic areas, as defined by one or more  
exchanges.  

Quick Call Allocator 
 
This feature allows you to change the percentage of calls to be  
routed to each of two or more answering locations in five minutes  
or less. This is helpful when you need to make changes on an  
emergency basis. A single location can be assigned from 0 to 100  
percent of total call traffic. You can use this feature to distribute  
calls according to the differing sizes or capacities of various  
answering locations.  

Ring/Busy 
 
This feature allows you to direct calls to an audible ring or busy  
tone. This is a final-handling arrangement.  

Time of Day 
 
This feature allows you to specify different routes for calls made  
during different time intervals within a day. It can be used to route  
calls to answering locations in different time zones and also to  
specify different call routing for calls placed after normal business  
hours. 

 
In addition to AT&T Advanced Features, Route It! also supports the Redirect feature.  
This feature, provided by a device in the AT&T network, allows your agents to use the  
AT&T network to redirect toll-free calls after they have answered them.  
The Redirect feature includes the Post Answer Call Redirection (PACR) feature, which  
is also known as the Transfer Connect Services feature. PACR enables agents to use  
their phones to transfer callers to other agents. PACR allows:  
� 

 
Blind transfer, where an agent transfers a call to a third party without verifying that  
the third party is available.  

� 
 
Consultation, where an agent transfers a call to a third party after verifying that the  
third party is available.  

� 
 
Conference, where an agent stays on the line while a third party is conferenced in.  

PACR allows your customers to speak to other agents without having to hang up and  
redial. 

 
The Support System and the Network 

 
The support system allows you to control and manage inbound call routing. After you  
create or update a plan in Route It!, you send it to the support system. The plan is  
checked for overall correctness. If the plan passes this check, it is validated and  
stored at the support system for use in the network. 
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The support system also stores your schedules that you create or edit in Route It!  
When these schedules indicate that a particular plan must be active for call routing,  
the plan is activated in the network.  
The term network is used throughout Route It! documentation to refer to the AT&T  
Global Transaction Network. The network routes your inbound calls according to your  
plans sent by the support system. 

 
Starting Route It! 

 
To start Route It!, follow these steps:  
1. Click Start on the Windows taskbar.  
2. Point to Programs. Then point to AT&T Routing Manager. Then click Route  

It!  
The Route It! Login dialog box appears.  

3. To log on to Route It!, follow these steps:  
a. In the User Name box, type your user name.  
b. In the Password box, type your password.  
c. Choose OK.  

The Route It! main window appears, as shown in Figure 1-1.  
NOTE :  
If you wish to change your password, see the following section, “Changing  
Your Password.” 

 

Figure 1-1.  Route It! Main Window  
Status messages, indicating communication status with the support system and  
network, appear in the status bar of the Route It! window.  
You can open any Route It! task from the Route It! window. Open a task by choosing  
the task name on the Route It! Tasks menu or by double-clicking the task icon. 
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NOTE :  
The User Setup task icon appears only when you log on to Route It! with the  
ADMIN ID. 

 
Changing Your Password 

 
To change your password, go to the Route It! main window (Figure 1-1) and follow  
these steps:  
1. From the User Info menu, select Change Password.  

The Change Password for User Name dialog box appears.  
2. In the Old Password text box, enter your current password.  
3. In the New Password text box, enter your new password.  
4. In the Confirm New Password text box, enter your new password again, then  

choose OK.  
The next time you log on to Route It!, you will enter your new password. 

 
Startup Settings 

 
The Startup Settings window allows the user to:  
� 

 
Select which Route It! tasks will open automatically after a successful login.  

� 
 
Select when the Transaction Manager and Database are started.  
z 

 
When you start Route It!  

z 
 
With the operating system.  

The Startup Settings selection is accessed from the Route It! main window under the  
User Info menu. 

 
Open Tasks Automatically 

 
To select tasks to be started automatically when you log into Route It!, go to the Route  
It! main window (Figure 1-1) and follow these steps:  
1. From the User Info menu, select Startup Settings.  

The Startup Settings dialog box appears.  
2. Select one or more tasks from the Task Setup list by clicking in the checkbox.  

(Click in the checkbox again to deselect a task.) 
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3. Choose OK.  

— Startup Settings dialog box closes.  
— Route It! main window is displayed  
— Message at bottom of main window is displayed, “Generating AT&T info  

refresh”  
The next time you log on to Route It!, your Task selections will open automatically.  

4. Choose Cancel to disregard selections and close the window. 
 
Set Transaction Manager and Database 

 
The Transaction Manager and Database can be started automatically when the  
operating system starts, or when Route It! starts. To choose when they start, follow  
these steps:  
1. From the User Info menu, select Startup Settings.  

The Startup Settings dialog box appears.  
2. Choose Settings.  

The Transaction Manager and Database Startup Settings window is displayed.  
3. Select one of the radio buttons.  

— To start with operating system, choose Start with Operating System.  
— To start with Route It!, choose Start with Route It!  

4. Choose OK.  
— Transaction Manager and Database Startup window closes.  
— Startup Settings Window displayed.  

5. Choose OK on Startup Settings window.  
— Startup Settings window closes.  
— Route It! main window is displayed.  
— Message displayed at bottom of Route It! main window, Generating AT&T info  

refresh... 
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Using Route It! with Windows 

 

 
This chapter describes several features of Microsoft Windows that are common to all  
task windows in AT&T Route It! Using these features can help you work more  
efficiently. For more complete information about Microsoft Windows, see your  
Windows documentation. 

 
Status Bar 

 
The status bar is located at the bottom of each task window. Check the status bar to  
see status messages about work you are doing. The status bar consists of up to four  
sections (depending on the task window), as shown in Figure 2-1. 

 

Figure 2-1.  Status Bar  
Table 2-1 describes the sections of the status bar from left to right. 

 
Table 2-1.  Status Bar Sections 

 
Section 

 
Description 

 
Message Bar 

 
The message bar displays a status message about an activity on  
which you are working. A message displayed here often provides  
confirmation of an activity at the time you complete it.  

NOTE :  
Sometimes, a message is displayed in a Windows message  
box instead.  

Customer Name 
 
The company name for the current Account ID is displayed in the  
first section to the right of the message bar section and to the left  
of the indicator section.  

Indicator Pane 
 
This section indicates information specific to some tasks.  

Account ID 
 
The right section of the status bar shows the current Account ID. 
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Displaying and Moving Toolbars 
 
Toolbars are located below the menu bar on a task window, as shown in Figure 2-2. 

 

Figure 2-2.  Toolbars  
The buttons and drop-down lists in a toolbar provide you with a quick way to choose  
frequently used menu commands and to select data.  
To better view data on a window of an open plan, you can temporarily remove or hide  
one or more toolbars. You can also move one or more toolbars to another part of the  
window.  
To display or hide a toolbar in an open plan, do the following at a task window in Route  
It!:  
1. Choose the View menu.  

On the View menu, a check mark by the toolbar name indicates that the toolbar is  
visible. No check mark indicates that the toolbar is hidden.  

2. From the View menu, choose the toolbar name.  
NOTE :  
The Standard Toolbar, Choices Toolbar, and Quick Toolbar commands are  
unavailable in the View menu if a plan is not open in Edit Plans.  

The applicable toolbar is alternately hidden or displayed each time you choose the  
Toolbar command.  
To move the toolbar, do the following:  
1. Click on a blank part of the toolbar and drag it to another part of the window.  

The toolbar appears as its own window with a title bar.  
2. To return the toolbar to its last location, double-click a blank part of the toolbar. 
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Working with List Boxes 
 
While using Route It!, you will encounter two types of list boxes. The types of list  
boxes, described in Table 2-2, are distinguished by the background color that appears  
within the list box. 

 
Table 2-2.  List Boxes 

 
List Box Type 

 
Description 

 
Black text on white background 

 
List boxes from which you can select an  
item, then perform an action based on  
that selection.  

Black text on gray background 
 
Read-only lists; no further action  
required. 

 
Working with Multiple Windows 

 
You can display multiple windows and then copy or move data among them. The  
Window menu in Route It! gives you several ways to arrange and access open  
windows.  
To arrange multiple windows, choose one of the following commands from the  
Window menu:  
Cascade 

 
Arranges windows in a diagonally overlapping format. The title bar of each  
window is displayed.  

Tile 
 
Arranges windows one next to the other with little or no overlap.  

The Window menu also shows a numbered list of all windows that are currently  
displayed in the task window. A check mark by a window indicates that it is the active  
window. (An active window is the one in which you are currently doing work.)  
When you select a window name from the list, its corresponding window becomes  
active. To select a window from the list, select its name to highlight it, or type its  
number. 

 
Getting Online Help 

 
Route It! provides a variety of online help.  
To see comprehensive online help for Route It!, display the Help menu from any task  
window and choose one of the following commands:  
Contents 

 
Displays a table of contents for Route It! online help.  

How to Use  
Help 

 
Explains how to use online help. 

 
About Route It! 

 
Displays version and copyright information about Route It! 
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To display online help about a specific task, choose the Help button displayed on the  
dialog box or window associated with the task.  
You can also see a brief description of a command that is listed in one of the menu bar  
menus. To display the description, choose a menu on the menu bar. Point to a menu  
command. The status bar displays information about the command.  
You can also display the name of a button on a toolbar by pointing the mouse on the  
button. A “balloon” containing the button’s name appears. 

 
Choices Button 

 
You may need to enter a data item, such as a dialed number or an announcement  
name, in a text box in Route It! When you are not sure how to populate a text box, you  
can choose the Choices (...) button, such as the one shown in Figure 2-3. 

 
Choices button 

 

Figure 2-3.  Choices Button  
Choosing the Choices button displays a Choice List dialog box similar to the one  
shown in Figure 2-4. You can select an item from the list to automatically populate the  
initial text box using either of the following methods. (Multiple selections are also  
possible in many of the Choice List dialog boxes.)  
� 

 
Use your mouse to click on an item. To choose more than one item, do one of the  
following:  
— To select sequential items, press and hold the Shift key while you click the  

first and last desired items. The items between your selections are selected  
automatically.  
Or  

— To select items that are not sequential, press the Ctrlkey while you click each  
desired item.  

� 
 
Use the arrow keys on your keyboard to select an item. To select more than one  
sequential item, press and hold the Shift key while you press the appropriate  
arrow key. 
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Figure 2-4.  Standard Choice List Dialog Box 
 
Some Choice List dialog boxes provide a Filter On text box that you can populate to  
help narrow your choices. You can enter the complete name of an item for which you  
are looking or only part of it, as explained in Table 2-3. 

 
Table 2-3.  Wild-Card Searches Used in Choice Lists 

 
To... 

 
Enter This  
Wild-Card  
Character... 

 
Example 

 
Substitute a sequence of  
characters contained in the  
term 

 
* 

 
To display all dialed numbers that start with the  
sequence 800-555, you would enter 800-555* in  
the Filter On text box.  

Represent a single  
unknown character in the  
term 

 
_  

(underscore) 

 
To display all dialed numbers that begin with the  
sequence 800-555 and end with the sequence  
001, you would enter 800-555-_001 in the Filter  
On text box. 

 
When you choose Filter, Route it! searches for and displays all items in the list that  
contain the characters you specified, plus any sequence of characters where the wild  
card was placed. The process of specifying search criteria is called filtering.  
If you need more information about an item displayed in a Choice List dialog box, click  
the item and choose the Info button.  
To display an item from the Choice List dialog box, do one of the following:  
� 

 
Select an item from the list and choose OK.  

� 
 
Double-click an item in the scrolling list. 
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Route It! automatically populates the text box on the initial dialog box with the item you  
selected.  

NOTE :  
The Filter On drop-down list box displays the filters you have applied in the  
current session of the dialog box.  

For some data, a Dual Filter Choice List dialog box, similar to the one shown in  
Figure 2-5, is displayed. It allows you to apply two filters to further narrow the list of  
choices. The two filters can work independently or in conjunction with each other.  

NOTE :  
The Account ID Choices dialog box shown in Figure 2-5 is accessed from the  
Change Service View dialog box only.  

Filtering is done using the same method previously described for a Choice List dialog  
box with a single filter. 

 

Figure 2-5.  Dual Filter Choice List Dialog Box 

 

AT&T—PROPRIETARY  
Use pursuant to Company Instructions 

 
2-6           AT&T Route It! 



  

 
Chapter 2  Using Route It! with Windows  
List View Control 

 

List View Control 
 
The list view control allows you to sort your columnar data, such as the Comm Log  
(discussed in Chapter 7). This control currently consists of two functions:  
� 

 
Report view, which allows you to sort data in the order you specify. Listed data is  
sorted in ascending or descending order. To change the sort order, click on a  
column header. That header becomes the key by which all other columns are  
sorted. Click the column header again to toggle between ascending and  
descending order.  
You can also change the width of any column by clicking on the column’s vertical  
border and dragging it until you have reached the desired width, then releasing  
the mouse button.  

� 
 
Large icon view, the default, which:  
— Displays icons in full size  
— Produces the label that is under each icon on the Route It! main window  
— Repositions the icons if the Route It! main window is resized. 

 
Info Menu 

 
You can obtain detailed information while in an open plan or open Customer Routing  
Point (CRP) table by choosing the Info menu on the menu bar. The information  
displayed depends on the task you are in, as indicated in Table 2-4.  

NOTE :  
Currently, the CRP Tables task is not supported by AT&T Canada.  

Table 2-4.  Information Available via Info Menu 
 
From This  

Task... 
 
You Can View Detailed Information on... 

 
Edit Plans 

 
� 

 
The plan opened  

� 
 
Announcements in the open plan  

� 
 
Terminations in the open plan  

� 
 
Dialed Numbers in the open plan  

CRP Tables 
 
� 

 
The table opened  

� 
 
Announcements in the open table  

� 
 
Terminations in the open table  

� 
 
Dialed Numbers in the open plan 
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Routing Plan Concepts 

 

 
This chapter explains the basic concepts of routing plans and the nodes and branches  
of which they are made. It also describes each of the Advanced Feature nodes and  
how they can be used in routing plans. Finally, this chapter explains the concepts of  
Service Dates, Service View, and plan validation.  

NOTE :  
AT&T Canada refers to their Advanced Features as Custom Routing Features. 

 
Basic Concepts 

 
A call-routing plan is a diagram that defines how calls will be routed. A routing plan, or  
plan, is composed of nodes and branches and their associated values, names, and  
labels. Figure 3-1 shows a sample call-routing plan. 

 

Figure 3-1.  Example of a Call-Routing Plan  
A node is primarily a routing plan “decision point” where, depending on the given  
input, a decision is made on where a call should be routed for further processing. A  
node represents a routing feature or final-handling treatment. In a plan, boxes  
represent nodes.  
A branch is an outcome of a node and connects one node to another. It represents the  
decision made on where a call should be routed for further processing. In a plan, line  
segments that connect one node to another represent branches. 

 
AT&T—PROPRIETARY  

Use pursuant to Company Instructions 
 
AT&T Route It! 

 
 3 

 
-1 



  

 
Chapter 3  Routing Plan Concepts  
Basic Concepts 

 
Any node in a routing plan has just one input. But, depending on the node type, a  
node can have one, several, many, or no output branches.  
The call-processing flow through a routing plan proceeds from left to right, starting at a  
root node (the first node in the routing plan) and ending either at a termination or at a  
final-handling arrangement, such as a recorded announcement. A call-processing  
path is the sequence of nodes traversed by a call. One plan can contain many call-  
processing paths. 

 
Node Categories 

 
A routing plan may contain three general kinds of nodes:  
� 

 
Feature Nodes  
A feature node represents an Advanced Feature that receives call input and,  
based on that input, makes a decision on where to route the call. Most of the node  
types available for a routing plan are feature nodes. The following nodes are  
feature nodes:  
— ADR  
— Allocator  
— Area  
— ATS  
— Call Type*  
— Caller ID  
— CRP*  
— Data Rate*  
— Day  
— Dialed #  
— Digit Prompter  
— Enroute  
— Exchange  
— Fix Queue*  
— Prompter  
— Time  
— Var Queue*  
*Currently not supported by AT&T Canada.  

� 
 
Final-Handling Nodes  
A final-handling node performs some final-handling treatment on a call. The four  
final-handling nodes and their associated final treatments are shown in Table 3-1. 
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Table 3-1.  Final-Handling Nodes 

 
Node 

 
Final-Handling Treatment 

 
Term 

 
Routes a call to a termination.  

ADR 
 
Redirects calls to an alternate (secondary) termination.  

Response 
 
Plays a recorded announcement to the caller.  

No Answer 
 
Responds with a ringing or busy tone to the caller. 

 
For more information on each type of final-handling node, see the section  
“Routing Plan Nodes and Rules,” later in this chapter.  

� 
 
Connecting Nodes  
There is only one connecting node, the Go To node, which redirects call routing to  
another path in the same routing plan. 

 
Node and Branch Fields 

 
Every node or branch contains fields in which you specify call-routing information.  
This section provides an overview of node and branch fields and the information they  
can contain.  
Figure 3-2 shows a node’s content and structure. 

 
2 

 

Node Number  
Node Type 

 
ADR 

 
BUSY 

 
Option  

Node Specific Data 
 
Label 

 
Figure 3-2.  Node Content and Structure  
The system assigns every node a node number that identifies it in a plan. In the node  
type field, you specify a node type, identifying what the node does.  
Some nodes have a node specific data field, in which you specify a value, name, or  
label. A value gives specific information about how a call is to be routed. For example,  
a value may identify the announcement to be played while a call is en route to its  
destination. To more easily identify a value, you can optionally give it a name. For  
example, if announcement 106 prompts callers to direct their calls based on the  
department they want to reach, you could name it DEPARTMENT. A label contains  
one or more values or names associated with a node or branch. 
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A few nodes contain an option field, in which you specify additional routing  
information. The field of every branch contains one or more of the following: a name, a  
specific value, a range of values, or a label defined with one or more names or values.  
Some node and branch fields require system-defined values, such as DEFAULT or  
OTHER. These values are often required during plan building. 

 
How Are Routing Plans Activated? 

 
Before you can use a new or updated plan to route call traffic, you need to complete  
these steps:  
1. Validate the plan.  

Route It! validates the plan locally to check its accuracy. After successful  
validation, Route It! stores the plan as a local plan.  
NOTE :  
At the completion of the validation process, you will be able to make corrections to  
the routing plan based on the results of the local routing plan validation.  

2. Send the plan to the support system.  
The support system validates the plan to check its accuracy. After successful  
validation, it stores the plan as an official plan.  

3. Schedule the time and day the plan is to be used.  
To schedule the use of one or more official plans to process call traffic, you use  
the Schedule Plans feature of AT&T Route It! Scheduling indicates the day of the  
week and the time of day an official plan should be used to route call traffic.  

4. Ensure the plan schedule has at least one working dialed number associated  
with it.  
You must assign one or more working dialed numbers to a plan schedule.  
Assigning dialed numbers activates the routing plans included in the plan  
schedule, allowing them to be used on a regular basis to route call traffic. 

 
Quick Changes 

 
You may need to quickly change the way calls are routed because of a disruption,  
such as the forced closing of a call center due to inclement weather. With the Quick  
Changes feature in Route It!, you can change the way calls are routed in a matter of  
minutes. Quick Changes lets you override the plans you regularly use to route calls  
with an override plan. You can also override certain settings, such as the number of  
calls allowed at a termination. Changes you make are activated in the AT&T network  
in either 5 or 15 minutes after they are received by the support system, depending on  
the change. Overrides made with Quick Changes remain in effect until you use Quick  
Changes again to resume the regular settings.  
For more information on Quick Changes, see Chapter 4, “Quick Changes,” in the  
AT&T Route It! Schedules and Quick Changes User’s Guide, and also see “Quick Call  
Allocator Changes” in Chapter 4, “Creating or Editing a Plan,” in this guide. 
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Routing Plan Nodes and Rules 
 
The following pages describe and illustrate each of the node types, in alphabetical  
order, and provide the basic rules for their creation. In the corresponding figures,  
Feature Name indicates the AT&T Advanced Feature associated with a node. For  
more information on creating nodes and branches, see Chapter 4, “Creating or Editing  
a Plan.” 

 
ADR Node 

 
The ADR node (Figure 3-3) allows calls to be redirected to an alternate (secondary)  
termination if they are not answered at the target (primary) destination in a predefined  
period or if network congestion or egress failure prevents the calls from going to the  
target (primary) termination. Both the primary and secondary destinations are non-  
ATS terminations. 

 
Feature Name: Alternate Destination Routing 

 
# 

 
ADR 

 
BUSY 

 
Label 

 
Figure 3-3.  The ADR Node for Primary and Alternate Terminations 
 
Basic Rules  
� 

 
The node specific data field of the ADR node must contain a label for the primary  
and secondary non-ATS terminations.  

� 
 
The option field of an ADR node must specify the condition under which calls will  
be redirected to the secondary termination. These conditions are described in  
Table 3-2. 

 
Table 3-2.  Secondary Termination Redirect Conditions 
 
RNA  
(Ring No  
Answer) 

 
A call is not answered within a predefined period at the primary  
destination. 

 
BUSY 

 
The call cannot be completed at the primary termination because of  
network congestion or egress failure.  

BOTH 
 
Calls are redirected for both RNA and BUSY situations. 

 
� 

 
If the node option is BUSY, the primary termination cannot have switched or 
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dedicated access to the Local Exchange Carrier (LEC) egress.  

� 
 
The primary and secondary terminations assigned to an ADR node must be  
different.  

� 
 
A termination that subscribes to the Redirect feature cannot be used as a primary  
or secondary termination.  

� 
 
If an ADR node is in the data path of a Call Type node, both the primary and  
secondary terminations must be Toll-Free Multimedia terminations.  

� 
 
The primary and secondary terminations assigned to an ADR node cannot have  
the I800 Outbound Service type.  

� 
 
If an ADR node is in the data path of a Call Type node, all of the terminations  
referenced in the node must be Toll-Free Multimedia terminations.  

� 
 
An ADR node cannot be followed by any other node type. 
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Allocator Node 

 
The Allocator node (Figure 3-4) allows calls to be distributed among call-processing  
paths according to percentages that you specify. 

 
Feature Name: Quick Call Allocator 

 
y% 

 
ALLOCATOR 

 
#  

z% 

 

Figure 3-4.  The Allocator Node for Call Allocation  
In Figure 3-4, y and z represent two different percentages. 
 
Basic Rules  
� 

 
Each branch flowing from an Allocator node must be assigned a percentage for  
call distribution and may contain a comment.  

� 
 
Each branch can be assigned from 0 to 100 percent of calls.  

� 
 
The total percentages for all related branches must add up to 100 percent. They  
cannot total less than, or more than, 100.  

� 
 
One or more branches can be assigned 0 percent and used as a placeholder.  

� 
 
The maximum number of branches is 100, not counting any placeholder branches  
mentioned previously.  

� 
 
An Allocator node cannot proceed a Queue node or Call Type node. 
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Area Node 

 
The Area node (Figure 3-5) routes calls according to the area codes (or NPAs) and/or  
country codes (CCs) from which the calls originate.  

NOTE :  
Currently, country codes are not supported by AT&T Canada. 

 
Feature Name: Area Code/Country Code Routing 

 
XXX 

 
AREA 

 
#  

XXX,XXX,XXX 

 
Label 

 
DOM 

 
INTL 

 

Figure 3-5.  The Area Node for NPA/CC Routing  
In Figure 3-5, each XXX represents a different NPA. 
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Basic Rules  
� 

 
Each branch flowing from an Area node must contain one of the following:  
— a three-digit area code between 200 and 999  
— a two-alphanumeric country code  
— a label (1 to 16 characters), defined with one or more NPA or CC values  
— the value DOM or INTL  

� 
 
DOM and INTL branches route calls when all area codes and country codes have  
not been accounted for on other branches. The DOM branch routes all NPAs not  
appearing in the other branches. The INTL branch routes all CCs not appearing in  
the other branches.  

� 
 
In a plan, each Area node must be assigned a DOM branch (and an INTL branch  
if any of the terminations in the plan have I800 Service type).  

� 
 
DOM and INTL branches can each be used only once for a single Area node.  

� 
 
A single path may contain more than one Area node; however, the NPA or CC  
values in subsequent Area nodes must be referenced in their “ancestor” nodes  
earlier in the call path to enable calls to be routed by the branch from the second  
Area node.  

� 
 
In a single path, an Area node cannot follow an Exchange node or a Caller ID  
node. 
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ATS Node 

 
The ATS node (Figure 3-6) defines a sequence of ATS-type terminations to which  
calls can be routed. The defined terminations are accessed, in sequence, to process a  
call. For example, a call is first directed to the primary termination at the top of the list;  
if that termination is busy, the next termination in the list is accessed, and so forth.  
This sequential access for availability continues until an available termination is found  
to access the call. Or, if no termination is available for handling the call, a final-  
handling treatment is applied via the ALL BUSY branch.  
Any ATS-type termination in the defined sequence is considered busy whenever the  
total number of calls in progress at that termination equals or exceeds the MCA value  
defined for the termination. Conversely, a termination is available if the number of  
calls in progress is less than the MCA value. 

 
Feature Name: Next Available Agent Routing 

 

ATS 

 
# 

 
ALL BUSY 

 
Label 

 
Figure 3-6.  The ATS Node for a Sequence of ATS-Type Terminations 
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Basic Rules  
� 

 
In the node specific data field of the ATS node, one of the following must be  
specified:  
— one ATS access line  
— one ATS termination name  

NOTE :  
The order of individual ATS access lines or termination names  
determines the order in which they are accessed by calls.  

— a label defined with a sequence of one or more ATS terminations or access  
lines. To specify more than one ATS access line or termination name, you  
must use a label.  

NOTE :  
The sequence in which the terminations are defined within a label is the  
same sequence in which the terminations are accessed for call routing.  

� 
 
Any ATS node must have one branch, the ALL BUSY branch, that directs calls to  
further call processing whenever all the ATS-type terminations are busy. The ALL  
BUSY branch is automatically generated when you press Enter after creating an  
ATS node.  

� 
 
An ATS termination can be used only once in a sequence and cannot be repeated  
in another sequence in the same path.  

� 
 
If a termination in the ATS sequence subscribes to Recurrent Call Prompter, then  
there must be an ancestor Prompter node.  

NOTE :  
Currently, RCP is not supported by AT&T Canada.  

� 
 
If an ATS node is in the data path of a Call Type node, all of the ATS terminations  
referenced in the node must be Toll-Free Multimedia terminations. In addition,  
none of the terminations can have the RCP Redirect feature. 
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Call Type Node 

 
NOTE :  
Currently, this node is not supported by AT&T Canada.  

A Call Type node (Figure 3-7) directs calls to either a voice or a data call-processing  
path. 

 

# 

 
DATA 

 
CALL TYPE  

VOICE 

 

Figure 3-7.  The Call Type Node for Voice and Data Call Routing 
 
Basic Rules 
 
� 

 
When used in a plan, a Call Type node must be the first node in the plan (the root  
node).  

� 
 
The Call Type node must be followed by two branches, each containing a system-  
defined value. One branch must have the value VOICE; the other branch must  
have the value DATA.  

� 
 
A termination node on a data path of a Call Type node must have a Toll-Free  
Multimedia termination service type. However, a termination used in the voice  
path may or may not be a Toll-Free Multimedia termination.  

NOTE :  
If Toll-Free Multimedia is not yet activated, the terminating node of a call path  
containing a Call Type node must be a No Answer node, and the node  
specific data field must state DISCONNECT. 
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Caller ID Node 

 
The Caller ID node (Figure 3-8) routes calls according to the telephone number of the  
calling party (the full 10-digit ANI number). The ANI feature inherent with this node  
identifies the call before it is answered. Consequently, calls from one or more  
telephone numbers belonging to special callers can be routed differently than those  
calls originating from others. 

 
Feature Name: Caller Recognition Routing 

 
XXX-XXX-XXXX 

 
CALLER ID 

 
#  

OTHER 

 
DEFAULT 

 

Figure 3-8.  The Caller ID Node for Caller Recognition Routing  
In Figure 3-8, XXX-XXX-XXXX represents the telephone number of the caller (the full  
10-digit ANI number). 
 
Basic Rules 
 
� 

 
Each branch flowing from a Caller ID node must be identified with the 10-digit  
telephone number of a caller or a label defined with one or more 10-digit  
telephone numbers.  

� 
 
One branch must specify the system-defined value OTHER. That branch routes  
all ANI calls from telephone numbers not appearing in any of the other branches.  

� 
 
One branch must specify the system-defined value DEFAULT. That branch  
routes calls for which ANI is not available. 
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CRP Node 

 
NOTE :  
Currently, this node is not supported by AT&T Canada .  

The CRP node (Figure 3-9) provides routing instructions on a call-by-call basis. It  
receives information about a call, such as the calling number or area code, and  
queries a database table to determine where to route the call. The database is  
identified with an ID or name. The query results in a code that provides routing  
instructions. Each code identifies either a termination routing number, an  
announcement, a ring tone, a busy tone, or a post feature code. A post feature code  
refers to additional call processing provided in the path of the routing plan. 

 
Feature Name: Intelligent Call Processing 

 
f 

 
CRP 

 
#  

OTHER 
 
c  

DEFAULT 

 

Figure 3-9.  The CRP Node for Call-by-Call Routing  
In Figure 3-9, c represents a CRP ID or CRP name; f represents a CRP  
post feature code. 
 
Basic Rules  

NOTE :  
You can create and edit CRP nodes and branches only if you have the ICP  
feature.  

� 
 
The node specific data field specifies a CRP ID (6 digits) or a CRP name (up to 16  
characters).  

� 
 
One branch flowing from the CRP node must specify the system-defined value of  
DEFAULT. That branch routes calls if there is no response from the CRP or if the  
response is garbled. The DEFAULT branch also handles calls if the CRP ID  
query is turned off, if there is failed tariff routing, or if an error is returned from the  
CRP.  
Following the DEFAULT branch, you must specify any additional nodes and  
branches required to complete call routing. 
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� 

 
One branch flowing from the CRP node must specify the system-defined value of  
OTHER. That branch routes calls when a CRP code is not found.  
Following the OTHER branch, you may specify any additional nodes and  
branches required to complete call routing.  

� 
 
One or more branches can optionally specify a CRP post feature code. Each  
branch can contain one CRP code.  
Following the branch containing a CRP post feature code, you must specify any  
additional nodes and branches required to complete call routing.  

� 
 
A call path can have only one CRP node.  

� 
 
A CRP node cannot be followed immediately by a fixed or variable queue node.  

� 
 
A CRP node cannot be used on the data portion of the routing plan. 
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Data Rate Node 

 
NOTE :  
Currently, this node is not supported by AT&T Canada .  
A Data Rate node (Figure 3-10) routes data calls based on their rate of data  
transfer. 

 
56K 

 
DATA RATE 

 
#  

OTHER 

 
64K 

 
Figure 3-10.  The Data Rate Node for Data Routing 
 
Basic Rules  
� 

 
Each branch flowing from a Data Rate node must contain a single data rate or a  
label that specifies one or more data rates. Valid data rates are:  
— 56K  
— 64K CLEAR  
— 384K CLEAR  
— 1536K CLEAR  

� 
 
A Data Rate branch cannot contain two or more individual data rates, unless they  
are included in a label.  

� 
 
One branch must specify the system-defined value OTHER. That branch routes  
calls with valid data rates that are not specified on the other Data Rate branches.  

� 
 
One Data Rate node must immediately follow the DATA branch of a Call Type  
node.  

� 
 
A call path can contain multiple Data Rate nodes. The data rates specified on the  
“descendant” branches must be referenced in the previous Data Rate node’s  
branches.  

� 
 
A Data Rate node cannot be on the voice portion of a call path. 
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� 

 
These nodes cannot follow a Data Rate node: CRP, Digit Prompter, Enroute, Fix  
Queue, Prompter, Response, and Var Queue.  

� 
 
All terminations in the path of a Data Rate node must be Toll-Free Multimedia  
terminations.  

NOTE :  
If Toll-Free Multimedia is not yet activated, the terminating node of a call path  
containing a Data Rate node must be a No Answer node, and the node  
specific data field must state DISCONNECT. 
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Day Node 

 
The Day node (Figure 3-11) routes calls according to the day or days of a week. A  
week is defined as the period from Sunday through Saturday. 

 
Feature Name: Day Manager 

 
MO 

 
DAY 

 
#  

WE-FR 

 
OTHER 

 

Figure 3-11.  The Day Node for Day-of-Week Routing 
 
Basic Rules  
� 

 
The days of a week are designated as SU, MO, TU, WE, TH, FR, and SA.  

� 
 
Each branch flowing from a Day node can be assigned one or more days (for  
example, MO or MO, TU, WE), or a range of days (for example, MO-FR).  

� 
 
The maximum number of branches from a Day node is seven, one branch for  
each day of the week.  

� 
 
If the branches flowing from a Day node do not account for all seven days of the  
week, one branch must have the system-defined value OTHER. That branch  
routes all calls not assigned to the other branches.  

� 
 
Overlapping days are not allowed (if, for example, you assign SU-WE to a branch,  
you cannot also assign TU to a branch). 
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Dialed # Node 

 
The Dialed # node (Figure 3-12) routes calls based on the number dialed by a caller.  
You can specify different routing for different dialed numbers within the same routing  
plan. For example, with a Dialed # node, customer calls to a sales number are routed  
differently than calls to a product support number. 
 
Feature Name: Dialed Number Decision 

 
XXX-XXX-XXXX  

# 
 
DIALED # 

 
Label 

 
OTHER 

 

Figure 3-12.  The Dialed # Node for Dialed Number Decision Routing 
 
Basic Rules 

  
�  Each branch flowing from a Dialed # node must contain a dialed number, a dialed  

number name, or a Dialed Number label. (See
 
NOTE

 
below.)  

� 
 
One branch must have the system-defined value of OTHER. That branch routes  
all numbers not identified by any of the other branches.  

� 
 
All dialed numbers must consist of 10 digits. (See 

 
NOTE 

 
below.)  

NOTE :  
The entry cannot contain an 11-digit Universal International Freephone  
Numbering (UIFN) dialed number, that is, 800-XXX-XXXXX. 
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Digit Prompter Node 

 
The Digit Prompter node (Figure 3-13) prompts a caller with a recorded  
announcement to enter digits corresponding to specific customer information, such as  
a customer account number. It collects the digits and forwards them to the CRP  
database, where unique routing data and arrangements are stored. The CRP instructs  
the AT&T network to route each incoming call to a termination, announcement, or  
final-handling arrangement.  

NOTE :  
AT&T Canada offers digit prompting without forwarding to the CRP database. 

 
Feature Name: Intelligent Call Processing 

 
# 

 
5-10 DIGITS 

 
DIGIT PRO 

 
VB:N  

DEFAULT  
a 

 
Figure 3-13.  The Digit Prompter Node for Digit Prompting and Collection  
In Figure 3-13, a represents an announcement name or number. 
 
Basic Rules  
� 

 
The node specific data field specifies an announcement name or number.  

� 
 
The option field specifies Y or N for the Voiceback indicator. When set to Y,  
callers can hear a vocal confirmation of their entered digits.  

NOTE :  
Currently, Voiceback is not supported by AT&T Canada.  

� 
 
One branch flowing from the Digit Prompter node specifies either a range of digits  
from 1 to 30 or a single digit between 1 and 30. This branch indicates the correct  
number of digits to be collected.  

� 
 
One branch must specify the system-defined value DEFAULT. This branch  
routes calls when an incorrect number of digits is entered.  

� 
 
A single path can contain a maximum of 48 Prompter, Digit Prompter, and  
Enroute nodes in combination.  

� 
 
It is recommended that a Digit Prompter node is followed by a CRP node at some  
point in the call path.  

� 
 
A Digit Prompter node cannot be used on the data portion of the routing plan. 

 

AT&T—PROPRIETARY  
Use pursuant to Company Instructions 

 
3-20           AT&T Route It! 



  

 
Chapter 3  Routing Plan Concepts  
Routing Plan Nodes and Rules 

 
Enroute Node 

 
The Enroute node (Figure 3-14) plays an announcement to the caller while the call is  
en route (being routed through a call-processing path) to the final-handling  
arrangement. 

 
Feature Name: Enroute Announcement 

 
# 

 
ENROUTE 

 
CONTINUE 

 
a 

 
Figure 3-14.  The Enroute Node for an Enroute Announcement  
In Figure 3-14, a represents an announcement name or number. 
 
Basic Rules  
� 

 
The node specific data field of the Enroute node specifies the name or number of  
the announcement to be played to the caller.  

� 
 
The Enroute node has one output branch, automatically identified as CONTINUE.  
After the enroute announcement is played to the caller, this branch continues call  
processing to the next node in the path.  

� 
 
The Enroute node can be placed at the beginning, within, or at the end of a  
particular call-processing path.  

� 
 
There can be a maximum of 48 Enroute and Prompter and/or Digit Prompter  
nodes in a call-processing path.  

� 
 
An Enroute node cannot be used in the data portion of the routing plan. 
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Exchange Node 

 
The Exchange node (Figure 3-15) routes calls according to the telephone area  
exchange (a six-digit ANI number, NPA-NXX) from which the calls originate. 

 
Feature Name: Exchange Routing 

 
XXX-XXX 

 
EXCHANGE 

 
#  

DEFAULT 

 
OTHER 

 

Figure 3-15.  The Exchange Node for NPA-NXX Routing 
 
Basic Rules  
� 

 
Each branch flowing from an Exchange node can specify one of the following:  
— one six-digit NPA-NXX exchange code  
— two comma-separated NPA-NXX codes  
— a label defined with one or more NPA-NXX codes. To specify more than two  

NPA-NXX codes, you must use a label.  
� 

 
One branch must specify the system-defined value OTHER. That branch routes  
calls from all exchanges not specified in any of the other branches.  

� 
 
One branch must specify the general option DEFAULT. That branch routes calls  
for which ANI is not available. 
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Fix Queue Node 

 
NOTE :  
Currently, this node is not supported by AT&T Canada.  

The Fix Queue node (Figure 3-16) allows calls to be held in a Fix queue until the ATS-  
type termination served by that queue is available for receiving them. A fixed queue  
serves only one termination. A termination becomes available to receive a call  
whenever the number of calls in progress at that termination is less than its scheduled  
MCA value. 

 
Feature Name: Fix Queue 

 
#  

FIX QUEUE 
 
FULL 

 
q 

 
Figure 3-16.  The Fix Queue Node for One ATS-Type Termination  
In Figure 3-16, q represents the unique queue ID or name of the fixed queue. 
 
Basic Rules  
� 

 
The node specific data field of the Fix Queue node specifies the unique queue ID  
or name of the fixed queue.  

� 
 
A queue id cannot reference more than one termination.  

� 
 
A Fix Queue node cannot reference a Variable Queue ID.  

� 
 
The Fix Queue node has one branch, automatically populated with FULL. That  
branch directs calls to customer-determined handling whenever all the slots in the  
queue are filled.  
A queue is full when the number of calls in queue is equal to or greater than the  
queue’s scheduled maximum calls in queue (MCQ) value.  

� 
 
The node preceding a Fix Queue node is typically an ATS node or another Fix  
Queue node.  

� 
 
The ATS-type termination that is associated with a Fix Queue node must be  
included in the ATS node that precedes the Fix Queue node.  

� 
 
A particular Fix Queue can be used only once in a path.  

� 
 
A Fix Queue node cannot be in the same path as a Var Queue node.  

� 
 
A Fix Queue node cannot be used on the data poriton of the routing plan. 
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Go To Node 

 
The Go To node (Figure 3-17) is a pointer to another node. It immediately redirects  
call processing to a numbered node on a different path within the same routing plan.  
The use of the Go To node minimizes the time needed for creating or editing a routing  
plan; it also minimizes the amount of memory required for storing a routing plan. 

 
Feature Name: None 

 
# 

 
GO TO 
 
n 

 
Figure 3-17.  The Go To Node for Unconditional Branching  
In Figure 3-17, n represents a node number. 
 
Basic Rules  
� 

 
The node specific data area of the Go To node specifies the node number to  
which call processing should immediately and unconditionally proceed.  

� 
 
A target node must not precede its corresponding Go To node. Validation  
prevents any combination of Go To nodes that would create such an infinite loop.  

� 
 
Multiple Go To nodes can reference the same target node.  

� 
 
A maximum of 5,000 Go To nodes are allowed in a routing plan, with a maximum  
of 100 successive Go To nodes in any one processing path.  

� 
 
A Go To node cannot be followed by any other node type. 
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No Answer Node 

 
The No Answer node (Figure 3-18) directs calls to a final-handling arrangement, such  
as an audible busy or ring tone. 

 

# 
 
NO ANSWER 
 
BUSY 

 
Figure 3-18.  The No Answer Node for Busy or Ring Tone 
 
Basic Rules 
 
� 

 
The node specific data field of the No Answer node contains one of these entries:  
— RING or BUSY, on the voice portion of a plan.  
— DISCONNECT, on the data portion of a plan.  

� 
 
A No Answer node cannot be followed by any other node type. 
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Prompter Node 

 
The Prompter node (Figure 3-19) prompts a caller with a recorded announcement to  
enter one or more digits corresponding to the desired destination. The caller  
determines the call-processing path taken in the routing plan by entering or speaking  
digits from 0 to 9. The node then routes the call according to the received digits. The  
recorded announcement, for instance, might be: “For product information, please  
press 1. For technical assistance, please press 2. Or, for operator assistance, please  
press 0 now.” Or, possibly, “Please enter your personal identification number.” 

 
Feature Name: Call Prompter  

1 

 
PROMPTER 

 
#  

VB:N 

 
2 

 
a 

 
OTHER 

 

Figure 3-19.  The Prompter Node for Caller Prompting  
In Figure 3-19, a represents an announcement name or number. 
 
Basic Rules 
 
� 

 
The node specific data field of the Prompter node must contain an announcement  
number or name.  

� 
 
The option field specifies Y or N for the Voiceback indicator. This capability is  
available on a Controlled Introduction basis. If you are not participating in the  
Controlled Introduction, N is the only value permitted for plan validation.  

NOTE :  
Currently, Voiceback is not supported by AT&T Canada.  

� 
 
The Caller Entered Digits aggregation specifies the way CEDs are collected for  
forwarding. If this is set to NONE, only the set of Caller Entered Digits from the  
last Prompter node is forwarded. 
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� 

 
All prompter digit codes specified for the branches of a Prompter node must be  
the same length.  

� 
 
One branch must specify the system-defined value OTHER. That branch handles  
invalid responses, no responses, or responses from either a rotary-dial telephone  
or a push-button telephone that generates rotary pulses.  

� 
 
A Prompter branch may include a comment.  

� 
 
A single path can contain a maximum of 48 Prompter, Digit Prompter, and  
Enroute nodes in combination.  

� 
 
A Prompter node cannot be used in the data portion of the routing plan. 
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Response Node 

 
The Response node (Figure 3-20) terminates calls by directing them to a recorded  
announcement (either customized or generic). It performs final-handling treatment of  
calls. 

 

# 
 
RESPONSE 
 
a 

 
Figure 3-20.  The Response Node for Courtesy Responses  
In Figure 3-20, a represents an announcement name or number. 
 
Basic Rules 
 
� 

 
The node specific data field of the Response node specifies the number or name  
of an announcement (courtesy response) played to the customer.  

� 
 
A Response node cannot be followed by any other node type.  

� 
 
A Response node cannot be used on the data portion of a routing plan. 
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Term Node 

 
The Term node (Figure 3-21) is a non-ATS termination that represents the end point  
of a call-processing path. 

 

# 
 
TERM 
 
t 

 
Figure 3-21.  The Term Node for a Non-ATS Termination  
In Figure 3-21, t represents a non-ATS access line, the name of a non-ATS  
termination, or a label identifying a non-ATS termination. 
 
Basic Rules 
 
� 

 
The node specific data field of the Term node specifies one of the following: a  
non-ATS access line, the name of a non-ATS termination, or a label identifying a  
non-ATS termination.  

� 
 
A termination that subscribes to RCP must be preceded in the path by a Prompter  
node.  

NOTE :  
Currently, RCP is not supported by AT&T Canada.  

� 
 
When used in the same path as a Data Rate node, the Term node must specify a  
Toll-Free Multimedia termination in its node specific data field.  

� 
 
A termination included on the data path of a Call Type node cannot have the RCP  
Redirect feature.  

� 
 
A Term node cannot be followed by any other node type. 
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Time Node 

 
The Time node (Figure 3-22) routes calls according to different time slots or intervals  
within a day. A day is defined as the 24-hour period starting at midnight. 

 
Feature Name: Time Manager 

 
08:00a-05:00p 

 
TIME 

 
#  

05:01p-06:00p 

 
OTHER 

 

Figure 3-22.  The Time Node for Time-of-Day Routing 
 
Basic Rules 
 
� 

 
Each branch flowing from a Time node must be assigned a specific time range  
within a single 24-hour period.  

� 
 
The minimum time interval is five minutes, starting at any five-minute point.  

� 
 
Time values are specified in the format of hh:mmx-hh:mmx, where hh is the  
hour, mm are the minutes, and x represents a for a.m., p for p.m., n for noon, or  
m for midnight. For example, 08:00a-05:00p.  

� 
 
Time ranges cannot overlap.  

� 
 
If all 5-minute time intervals within a 24-hour period are not represented by the  
branches following a Time node, then one of the branches must have the system-  
defined value OTHER. That branch routes calls during those times not assigned  
to the other branches.  

� 
 
The maximum number of branches for a Time node is 288, since there are 288  
5-minute increments in 24 hours.  

� 
 
A Time node can have other Time nodes as ancestors. However, the branches on  
the ancestor nodes must account for all time periods specified by the first Time  
node. 
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Var Queue Node 

 
NOTE :  
Currently, this node is not supported by AT&T Canada.  

The Var Queue node (Figure 3-23) allows calls to be held in a variable queue until any  
one of multiple terminations served by that queue is available for receiving calls. A  
variable queue serves any two or more ATS-type terminations. From a variable  
queue, a call is routed to the next termination with a free line. A termination becomes  
available to receive a call whenever the number of calls in progress at that termination  
is less than its scheduled MCA value. 

 
Feature Name: Network Queuing 

 
ALL BUSY 

 
VAR QUEUE 

 
#  

FULL 

 
q 

 

Figure 3-23.  The Var Queue Node for ATS-Type Terminations  
In Figure 3-23, q represents the unique queue ID or name of the variable queue. 
 
Basic Rules  
� 

 
The node specific data field of the Var Queue node specifies the unique queue ID  
or name of the variable queue.  

� 
 
A queue ID cannot reference more than one termination.  

� 
 
A Var Queue cannot reference a Fix Queue ID.  

� 
 
The Var Queue node has one branch, automatically populated with FULL. That  
branch directs calls to customer-determined handling whenever all the slots in the  
queue are filled.  
A queue is full whenever the number of calls in queue is equal to or greater than  
the queue’s scheduled MCQ value.  

� 
 
The node that precedes a Var Queue node must be an ATS node. Accordingly,  
the branch serving as the input to the Var Queue node has the system-defined  
value of ALL BUSY.  

� 
 
The ATS-type terminations that are associated with a Var Queue node must be  
included in the previous ATS node.  

� 
 
A Var Queue node cannot be in the same path as a Fix Queue node. 
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� 

 
There can be only one Var Queue node in a path.  

� 
 
An ATS-type termination can be served by only one queue.  

� 
 
A Var Queue node cannot be used on the data portion of the routing plan. 
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Service Dates and Service View 
 
This section describes the terms Service Date and Service View. You use these terms  
when viewing and working with plans and call-routing information in Route It!  
A Service Date is the start date of a particular call-routing environment. The  
environment includes call-routing plans, schedules, terminations, and  
announcements.  
You can have a maximum of 15 Service Dates for a 13-month period. An active or  
working Service Date identifies the starting day for a plan(s) currently being used to  
route calls. All other Service Dates are pending.  
A Service View is made up of a Service Date and an account number. The Service  
View gives you a way of selecting specific routing information to view or work with in  
Route It! Before working with call-routing information in the software, you often need  
to specify an account number and a Service Date. 
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Plan Validation 
 
Validation ensures that a routing plan meets all system and call-routing requirements.  
A plan cannot become an official plan until it is validated.  
There are three levels of plan validation, as described in Table 3-3. 
 
Table 3-3.  Levels of Plan Validation 
 
Field validation 

 
Field validation checks for errors in branch and node fields at the  
time you edit them. Errors can include incorrectly formatted,  
invalid, or missing data. Field validation also ensures that certain  
data, such as an announcement name, exists for the current  
Account ID or Service View.  
If an error is found, an error message appears immediately when  
you attempt to leave the field. You must correct the error before  
you can continue.  

Intra-nodal  
validation 

 
Intra-nodal validation checks for errors between a node and the  
adjoining branches to its right. It makes sure that the branches  
follow the rules for the node. It ensures, for example, that a  
required branch has not been omitted. Route It! performs this  
validation while you work with a plan.  
An error message appears at the time an error is found. You can  
choose to correct the error right away or at a later time. To save  
time, you can also choose to build or edit a plan without intra-  
nodal validation. For more information, see the section  
“Performing Intra-Nodal Validation” in Chapter 4, “Creating or  
Editing a Plan.”  

Inter-nodal  
validation 

 
Inter-nodal validation ensures that there are no errors in the inter-  
action of nodes across a plan. Inter-nodal validation ensures, for  
example, that the number of nodes in a path does not exceed  
125.  
A routing plan can be validated and corrected locally before the  
plan is sent to the support system to be validated and made offi-  
cial.  
In addition, the support system automatically performs field, intra-  
nodal and inter-nodal validation on every plan sent to it. 

 

AT&T—PROPRIETARY  
Use pursuant to Company Instructions 

 
3-34           AT&T Route It! 



  

 

Creating or Editing a Plan 

 

 

Contents 
 
Working with Routing Plans 

 
4-1  

Tools for Building or Editing a Plan 
 
4-2  

�  
�  
�  
�  
�  
�  
� 

 
Edit Menu  
Shortcut Menu  
Choices Toolbar and Choices Dialog Box  
Label Builders  
Undo  
Redo  
Autobuild 

 
4-2  
4-3  
4-3  
4-4  
4-4  
4-5  
4-5  

Opening a Plan 
 
4-6  

�  
� 

 
Opening a New Plan  
Opening an Existing Plan  
– Searching for a Plan 

 
4-6  
4-6  
4-8  

Creating Branches and Nodes 
 
4-9  

�  
� 

 
Adding or Inserting a Branch  
Adding or Inserting a Node 

 
4-9  
4-10  

Deleting Branches and Nodes 
 
4-11  

Displaying Names or IDs 
 
4-11  

Editing Node and Branch Fields 
 
4-12  

�  
�  
� 

 
� 

 
Considerations  
Using the Choices Toolbar or Dialog Box  
Typing Data into Node and Branch Fields  
– Typing Data into Node Fields  
– Typing Data into Branch Fields  
Changing Node Fields 

 
4-13  
4-13  
4-16  
4-16  
4-18  
4-22  

Quick Call Allocator Changes 
 
4-23  

� 
 
Opening a Plan in Quick Call Allocator Mode  
– Prerequisites  
– Opening Quick Call Allocator Mode  
– Choosing a Tab 

 
4-23  
4-23  
4-24  
4-24 

 
AT&T—PROPRIETARY  

Use pursuant to Company Instructions 
 
AT&T Route It! 

  
4 

 
-i 



  

 
Chapter4  Creating or Editing a Plan  
Contents 

 

�  
� 

 
�  
�  
� 

 
– Selecting a Plan by Plan Name  
– Selecting a Plan by Schedule Set  
Editing Allocator Branch Fields  
Displaying a Summary of Quick Call Allocator Changes  
– Displaying a Summary Any Time Before a Send  
– Displaying a Summary Automatically on Send  
Sending Quick Call Allocator Changes to the Support System  
Working with the Quick Toolbar  
Closing a Plan in Quick Call Allocator Mode 

 
4-25  
4-27  
4-29  
4-29  
4-29  
4-30  
4-31  
4-31  
4-32  

Creating New Labels 
 
4-33  

Getting Plan Information 
 
4-33  

Displaying Detail Data for a Node or Branch Field 
 
4-38  

Saving a Plan 
 
4-38  

�  
� 

 
Saving a Titled Plan  
Saving a New Plan or Renaming an Existing Plan 

 
4-39  
4-39  

Performing a Local Plan Validation 
 
4-41  

Sending a Plan to the Support System 
 
4-42  

Printing a Plan 
 
4-45  

Closing a Plan and Quitting Edit Plans 
 
4-47  

Performing Intra-Nodal Validation 
 
4-49  

Moving Among and Selecting Branches and Nodes in a Plan 
 
4-50  

�  
�  
� 

 
Selecting Items in a Plan  
Moving Between Node Fields  
Moving Between Nodes and Branches 

 
4-50  
4-51  
4-51  

Moving and Copying Plan Portions 
 
4-52  

�  
� 

 
Using Cut-and-Copy Editing  
Using Drag-and-Drop Editing 

 
4-52  
4-53  

Renumbering Nodes 
 
4-56  

Finding a Node or Branch 
 
4-56 

�  
� 

 
Finding a Node  
Finding a Branch 

 
4-58 
4-60  

Replacing Terminations and Announcements 
 
4-62  

Changing the Service View 
 
4-64  

Deleting a Local or Official Plan 
 
4-66  

�  
� 

 
Deleting a Local Plan  
Deleting an Official Plan 

 
4-68  
4-68  

Displaying Summary Information About a Plan 
 
4-69  

Customizing the Edit Plans Window 
 
4-70  

�  
� 

 
Displaying or Hiding Toolbars  
Displaying the Viewbox 

 
4-71  
4-72 

 
AT&T—PROPRIETARY  

Use pursuant to Company Instructions 
 
4-ii           AT&T Route It! 



  

 
Chapter4  Creating or Editing a Plan  
Contents 

 
� 

 
Resizing a Plan 

 
4-73  

Updating Plan Data 
 
4-74 

 

AT&T—PROPRIETARY  
Use pursuant to Company Instructions 

 
AT&T Route It! 

 
       4-iii 



  

 
Chapter4  Creating or Editing a Plan  
Contents 

 

AT&T—PROPRIETARY  
Use pursuant to Company Instructions 

 
4-iv           AT&T Route It! 



  

 

Creating or Editing a Plan 

 

 
This chapter explains how to use Edit Plans to create and edit routing plans. It  
describes how to work with nodes and branches, edit portions of plans, get call-  
routing information, and save or delete plans. It also explains how to get a plan  
validated in preparation for its use in routing calls. 

 
Working with Routing Plans 

 
The Edit Plans window is where you create and edit the nodes and branches that  
make up your routing plans.  
By using the toolbars and the menu commands in Edit Plans, you can open a new  
plan, create a node, and populate its fields with routing information. As you build a  
call-processing path with nodes and branches, Edit Plans checks your work and can  
even anticipate the next node or branch that needs to be created.  
While you work with a plan, you can display information about a specific node or  
branch field. Or you can view information about all items in a category, such as all  
announcements or all terminations.  
For easier editing, nodes and branches change color as you select them. For  
example, if you click on the header of a node, the node and everything following it  
turns green. You can then copy the selected part of the call path and paste it to a  
different part of the plan or to a new plan. The Cut, Copy, and Paste functions let you  
reuse plan portions without re-creating them.  
When you have finished creating or editing a plan, you can validate and/or save it on  
your PC. You can then send it to the support system, which validates it by checking  
for any errors. A plan that passes validation at the support system is called an official  
plan. (Plans that have not yet been sent to the support system and also pass  
validation at the support system are called local plans.) For actual call routing,  
however, an official plan must be included in a plan schedule. (For information on plan  
schedules and other schedules, see the AT&T Route It! Schedules and Quick  
Changes User’s Guide.) 

 

AT&T—PROPRIETARY  
Use pursuant to Company Instructions 

 
AT&T Route It! 

 
4 

 
-1 



  

 
Chapter 4  Creating or Editing a Plan  
Tools for Building or Editing a Plan 

 

Tools for Building or Editing a Plan 
 
AT&T Route It! provides you with tools to help you build and edit plans. You can  
access and use these functions while you work with a plan. This section provides an  
overview of seven Edit Plans tools. 

 
Edit Menu 

 
Use the Edit menu on the Edit Plans window to perform these activities:  
� 
 
�  
�  
�  
�  
�  
� 

 
undo the previous action (for a list of changes that can be undone, see Table 4-2,  
later in this chapter)  
redo the previous undo action  
cut, copy, and paste plan sections within a plan and among plans  
create, edit, or delete branches and nodes  
renumber nodes  
display detail  
find and replace nodes or branches  

To Access:  
Select the Edit menu on the Edit Plans main window. Undo, Cut, Copy, and Paste  
can also be accessed on the toolbar by choosing the appropriate button. 
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Shortcut Menu 

 
Use the Shortcut menu to create, edit, and delete nodes and branches without moving  
your mouse. When you display a Shortcut menu, it appears on the screen as a small  
window listing commands pertaining to your selection.  
To Access:  
Click the right mouse button on a node or branch while you are working with an  
opened plan.  
The Shortcut menu contains a subset of the functions of the Edit menu. Table 4-1  
summarizes the functions offered by both. 

 
Table 4-1.  Edit and Shortcut Menus 

 
To... 

 
Use the  

Edit Menu 

 
Use the Shortcut  

Menu 
 
Create and delete nodes and branches 

 
  z 

 
  z 

 
Cut, copy, and paste sections of a plan 

 
  z 

 
Change node information 

 
  z 

 
  z 

 
Find and replace terminations or announcements 

 
  z 

 
Use the Choices dialog box to fill in node and  
branch data 

 
  z 

 
Display detail data about node and branch data 

 
  z 

 
  z 

 
Renumber nodes 

 
  z 

 
Undo the last action performed 

 
  z 

 
Choices Toolbar and Choices Dialog Box 

 
You can use the Choices toolbar or the Choices dialog box to specify routing  
information in node and branch fields. Both functions contain lists of valid values,  
names, and labels, eliminating your need to remember specific routing information for  
a field.  
If you already know the information for a node or branch field, you can also type it  
directly into the field.  
To Access:  
Select a data field on a node or branch and then do one of the following:  
� 

 
Make selections on the Choices toolbar.  

� 
 
To display the Choices dialog box, press F2 on your keyboard, or, from the Edit  
menu, choose Choices. 
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Label Builders 

 
You may need to create a new label at the time you are building or editing a plan. A  
label is an identifier for one or more values or names. You can specify a label in some  
branch or node fields instead of typing multiple values or names. For a list of the  
branch and node fields that can contain labels, see “Relationship Among Values,  
Names, and Labels” in Chapter 5, “Labels.”  
To create labels quickly, you use Label Builders. These dialog boxes provide valid  
values and names from which you can select to create a label. You can also use a  
Label Builder to edit an existing label.  
To Access:  
Do one of the following:  
� 

 
Type the name of a new label in an empty branch or node field.  
The system displays a message prompting you to confirm the creation of a new  
label.  

� 
 
From the Labels menu on the Edit Plans menu bar, choose New.  

� 
 
For more information, see Chapter 5, “Labels.” 

 
Undo 

 
The Undo command lets you immediately reverse an editing change that you have  
made to a plan. You can undo up to the last 25 “undoable” actions. (Table 4-2 lists  
changes you can and cannot undo.) If you change your mind and want to keep an  
action you just undid, choose the Redo command. 
 
Table 4-2.  The Undo Function 

 
You Can Undo These Changes 

 
You Cannot Undo These Changes 

 
�  
�  
�  
�  
�  
�  
�  
�  
� 
 
�  
�  
�  
� 
 
� 

 
add branch  
add node  
insert branch  
insert node  
delete branch  
delete node  
cut  
paste  
copy (via drag-and-drop editing,  
described later in this chapter)  
typing  
replace announcement or termination  
change node  
move (via drag-and-drop editing,  
described later in this chapter)  
renumber nodes 

 
�  
� 

 
send  
save 
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Tools for Building or Editing a Plan 

 
To Access: 
 
From the Edit menu, choose Undo. 

 
Redo 

 
Choose the Redo command to restore an action you have reversed with the Undo  
command. The Redo function becomes available only after you have done an Undo  
action. Once you have performed an edit after using the Undo command, the Redo  
action is no longer available until you choose Undo again. 

 
Autobuild 

 
When you complete a new node or branch, Autobuild anticipates the next node or  
branch required in the path and creates it automatically for you. Autobuild also finds  
incomplete paths you may have missed and prompts you to complete them.  
To Access:  
Perform one of the following functions:  
� 

 
Start a new plan.  

� 
 
Add a branch.  

� 
 
Insert a branch.  

� 
 
Add a node.  

To start Autobuild, data in a field must be validated by pressing Enter.  
Once Autobuild has been started, it remains in effect until you do one of the following:  
� 

 
Use the mouse or arrow keys to move within a plan.  

� 
 
Click the right mouse button to bring up the pop-up edit menu.  

� 
 
Display the Shortcut menu.  

� 
 
Select any item from the Edit menu other than Choices.  

� 
 
Select Save, 

 
Save and Validate 

 
, Save As, Close, or Exit from the File menu.
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Opening a Plan 
 
This section describes how to open a new plan and how to open one or more existing  
plans.  
; 

 
USAGE TIP:  
To save time, you can turn off intra-nodal validation while you build or edit a  
routing plan. See “Performing Intra-Nodal Validation,” later in this chapter. 

 
Opening a New Plan 

 
To open a new plan, do the following:  
1. From the File menu, choose New Plan.  

Or  
On the toolbar, choose the New button.  
Route It! creates a new, local plan with the temporary name Untitled1. The plan  
contains an empty root node, as shown in Figure 4-1, which is the first node in a  
plan. 

 

Figure 4-1.  New Plan  
To see the procedure for specifying the node type and other routing information  
on the root node, see the section “Editing Node and Branch Fields,” later in this  
chapter. 

 
Opening an Existing Plan 

 
You can quickly open one of the last plans displayed. Or you can select a plan from a  
list of all plans for the Service View.  
To open one of the last four plans you displayed, choose that plan from the bottom of  
the File menu. Each plan name is followed by (official), (local), or (quick alloc) to  
indicate that it is either an official or a local plan, or that it was opened in Quick Call  
Allocator mode.  
To open an existing plan from a list of all plans for the Service View, follow these  
steps:  
1. From the File menu, choose Open Plan.  

Or 
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Opening a Plan 

 
On the toolbar, choose the Open button.  
The Open Plan dialog box appears, as shown in Figure 4-2. 

 

Figure 4-2.  Open Plan Dialog Box  
The list box displays the plans for the current Service View.  
� 

 
L or O follows each plan name to identify it as a local or an official plan.  

� 
 
The Remarks text box contains read-only remarks, if any, about the plan that  
has been selected from the list box.  

2. To open a listed plan, do one of the following:  
� 

 
Type the plan name in the text box, then choose OK.  

NOTE :  
If you enter a plan name that exists but has been previously filtered out of  
the list, you will receive a message stating that the plan is not in the  
filtered list.  

� 
 
Select a plan name from the list and choose OK.  

� 
 
Double-click a plan name in the list.  

The plan you selected appears. If the plan is the first one you are opening in the  
current Edit Plans session, the viewbox also appears by default. You can use the  
viewbox to navigate to a different section of the plan. For more information, see  
“Displaying the Viewbox,” later in this chapter. 
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Opening a Plan 

 
Searching for a Plan  

To search for a plan to open, you can expand or narrow the list of plans.  
To expand or narrow the plan list, at the Open Plan dialog box, make selections for  
one or more of the choices under List Only, then choose Apply: 

 
Status 

 
Select to display local plans only (Local Only), official plans  
only (Official Only), or both local and official plans (Both).  

Announcement 
 
To display names of plans that contain a specific announce-  
ment, type or select an announcement from the Announce-  
ment box.  

Category 
 
To display names of plans belonging to a specific category,  
type or select a category from the Category box.  

Dialed Number 
 
To display official plans referenced by a particular dialed  
number, type or select a dialed number from the Dialed  
Number box.  

NOTE :  
This option is available only when you select Official  
Only in the Status area.  

A dialed number may reference a plan through its schedule  
set, default schedule, exception date, or an active plan quick  
change.  
The dialed number entry will contain 10 digits unless the  
number is an 11-digit Universal International Freephone  
Numbering (UIFN) dialed number, that is, 800-XXX-XXXXX.  

Schedule Set 
 
To display names of official plans that are contained in a  
specific official plan schedule, type or select an official  
schedule set in the Schedule Set box. (If you type the  
schedule set, dashes are optional if the schedule set is in the  
same format as the dialed number.) 

 
NOTE :  
This option is available only when you select Official  
Only in the Status area.  

Termination 
 
To display names of plans that contain a specific termination,  
type or select a termination name in the Termination box.  

Term Routing # 
 
To display names of plans that contain one or more termina-  
tions associated with a particular termination routing number  
(TRN), type or select a TRN in the Term Routing # box.  

NOTE :  
To display all plans for the current Service View, choose List All. Selecting  
List All removes all filters. 
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After expanding or narrowing the plan list, do one of the following to open a plan:  
� 

 
Type the plan name in the text box and choose OK.  

� 
 
Select a plan name from the list and choose OK.  

� 
 
Double-click a plan name in the list. 

 
Creating Branches and Nodes 

 
This section explains how to add or insert branches and nodes. 

 
Adding or Inserting a Branch 

 
To create a branch to the right of a node, use one of the following commands:  
�  
� 

 
Add Branch  
Insert Branch  

Using either command puts you into Autobuild mode. You can create additional  
branches and nodes while you work in Autobuild mode.  
To Access:  
Choose these commands from either the Edit menu or the Shortcut menu.  
Table 4-3 describes how to use Add Branch and Insert Branch. Table 4-4 explains  
how to add branches when you are in Autobuild mode. 
 
Table 4-3.  Creating a Branch with Add Branch or Insert Branch 

 
To Create a Branch... 

 
Do This 

 
To the right of a node 

 
Select the node and choose Add Branch.  
If the node has existing branches, a new branch  
is added below the last existing branch.  

Below a selected branch 
 
Select the branch and choose Add Branch.  

Above a selected branch 
 
Select the branch and choose Insert Branch.  

To the right of a node as the last  
branch 

 
Choose Add Branch.  
The branch adds as the last branch in the list.  

To the right of a node as the first  
branch 

 
Choose Insert Branch.  
The branch adds as the first branch in the list. 
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Table 4-4.  Creating a Branch in Autobuild Mode 

 
To Create a Branch... 

 
Do This 

 
To the right of the current node while in  
Autobuild mode 

 
Complete all the fields of the current  
node.  
Type a value and press Return or Enter  
on your keyboard.  
Or  
Select an item from a choice list.  

Below the current branch while in  
Autobuild mode 

 
Type a value and press Return or Enter  
on your keyboard.  
Or  
Select an item from a choice list. 

 
Adding or Inserting a Node 

 
To create a new node in a plan, use the Add Node and Insert Node commands.  
These commands let you create a node to the right or left of a branch.  
Using Add Node activates Autobuild, which can help you to create additional nodes  
and branches.  
To Access:  
To access the Add Node and Insert Node commands, you select them from either  
the Edit menu or the Shortcut menu.  
Table 4-5 describes how to use Add Node and Insert Node. Table 4-6 explains how  
to add a node in Autobuild mode. 
 
Table 4-5.  Creating a Node with Add Node or Insert Node 

 
To Create a Node... 

 
Do This 

 
To the right of a selected branch without  
a node following it 

 
Select the branch and choose Add  
Node.  

To the left of a selected node 
 
Select the node and choose Insert  
Node.  
An empty branch is added between the  
existing node and the new node to its  
left. 
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Table 4-6.  Creating a Node in Autobuild Mode 

 
To Create a Node... 

 
Do This 

 
To the right of the first branch created  
during this Autobuild session 

 
Press Return or Enter on your keyboard  
with any branch selected.  
The branch is deleted and a new node is  
added after the first empty branch  
created during this Autobuild session. 

 
Deleting Branches and Nodes 

 
When you use the Delete Branch or the Delete Node command, you delete a  
selected branch or node and all nodes and branches in its path to the right.  
To delete a selected branch or node and all nodes and branches to the right of it,  
follow these steps:  
1. Select the initial branch or node to be deleted.  
2. From the Edit menu or the Shortcut menu, choose Delete Branch or Delete  

Node.  
3. At the confirmation dialog box, choose Yes.  

The selected branch or node and all nodes and branches to the right of it are  
deleted. 

 
Displaying Names or IDs 

 
You can choose to display data in nodes and branches as either values or names. To  
identify announcements more easily in your plans, for example, you can display them  
as names rather than as announcement numbers.  
To customize how this information appears, you make selections in the Names or IDs  
dialog box, available through the View menu on the Edit Plans window. Labels, used  
to group names and values, are unaffected by how you display names or IDs.  
The settings you make in the Names or IDs dialog box remain in effect during all Edit  
Plans sessions until you change them again. You can still type or select a value for a  
field that has been set to display as a name. Route It! converts the value to its  
corresponding name. Conversely, when you type a name in a field set to display as a  
value, the name is converted to a value.  
To display names or IDs in your plans, follow these steps:  
1. Display a new or existing plan in the active window.  
2. From the View menu, choose Names or IDs.  

The Names or IDs dialog box appears, as shown in Figure 4-3. 
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Editing Node and Branch Fields 

 

Figure 4-3.  Names or IDs Dialog Box  
3. For each category, select to display either names or values. Values may be either  

numbers, IDs, digits, or access lines, depending on the category of data.  
Table 4-7 lists the node and branch fields affected by selections you make. 
 
Table 4-7.  Fields Affected by Names or IDs Selections 

 
Making Selections  

for... 
 
Affects These Node and Branch Fields 

 
Announcements 

 
The node specific data fields of Digit Prompter, Enroute,  
Prompter, and Response nodes  

CRPs 
 
The node specific data fields of CRP nodes (currently  
not supported by AT&T Canada)  

Dialed Numbers 
 
Branches following Dialed # nodes  

Queues 
 
The node specific data fields of Fix and Var Queue  
nodes  

Terminations 
 
The node specific data fields of ATS and Term nodes 

 
4. After you have made your selections, choose OK.  

Route It! displays data in node and branch fields in the format you selected. 

 
Editing Node and Branch Fields 

 
After you create a new node or branch, you need to specify routing information in the  
node or branch fields. You can also change existing data in a branch or node field. For  
example, to create an Enroute node, you need to specify its node type in the node  
type field. You also need to specify an announcement name or number in the node  
specific data field.  
There are three ways to add or change routing information in a node or branch field,  
as described in Table 4-8. 

 
AT&T—PROPRIETARY  

Use pursuant to Company Instructions 
 
4-12           AT&T Route It! 



  

 
Chapter 4  Creating or Editing a Plan  
Editing Node and Branch Fields 

 
Table 4-8.  Adding or Changing Node or Branch Field Information 
 
To Add or Change a Node  

or Branch Field... 
 
Do This 

 
Choices toolbar 

 
Located on the Edit Plans window, the Choices toolbar gives you  
a convenient way to select node and branch field entries.  

NOTE :  
You may find the Choices dialog box, described below, more  
useful because it always displays a large number of choices,  
and it also allows you to use keyboard commands.  

Choices dialog box 
 
The Choices dialog box provides the same function as the  
Choices toolbar. It is available through the Choices command  
on the Edit menu in Edit Plans.  
; 

 
USAGE TIP:  
You can also press F2 to display the Choices dialog box.  

Typing directly into a field 
 
You can type an entry into a field when you know the data item  
you need. 
 
; 

 
USAGE TIP:  
If you press and hold the Shift key while pressing the left or  
right arrow key, you can move within a field one character at  
a time. 

 
Considerations 

 
Keep in mind the following when you add to or change a branch or node field:  
� 

 
You must add a valid entry to a node type or branch field before you can leave the  
field.  

� 
 
You must have valid data in all node fields before you can leave the node.  

� 
 
If you change the node type, be aware of the following:  
— After you enter a new node type, any existing node specific data is removed.  

Branch data on branches following the node is also removed.  
— If you change a node with branches to a terminating node, all branches to the  

right of the node are deleted.  
— Only the root node can have a node type of Call Type. 

 
Using the Choices Toolbar or Dialog Box 

 
Use the Choices toolbar or Choices dialog box when you want to select routing data  
for a branch or node field, or when you want to change existing data in a branch or  
node field. Each function contains drop-down lists of valid entries specific to the type  
of field you are editing. Using either function eliminates your need to remember exact  
data items. 
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You can choose to display items in the drop-down lists as either names, values, or  
labels, depending on the current node or branch field. After an entry is chosen for a  
field, it appears in the plan according to the current setting in the Names or IDs dialog  
box. For more information on this setting, see the section “Displaying Names or IDs,”  
earlier in this chapter.  
System-defined values, such as DEFAULT or OTHER, are displayed at the top of the  
drop-down lists. Node specific data, branch, or options fields may require these  
entries. Each system-defined option is indicated with an asterisk (*).  
You can type comments in some branches. A comment must follow the branch value  
or name and is separated from it with a hyphen (-). A front slash (/) is not allowed in a  
comment. Comments cannot be added to a label. The following branches can contain  
comments:  
� 

 
Allocator branch 

 
� 

 
NOTE :  
Colons cannot be used in an Allocator branch.  

Prompter branch  
To use the Choices toolbar or Choices dialog box, follow these steps:  
1. Position the cursor on a node or branch field.  

The field turns yellow to indicate it is selected.  
2. If the Choices toolbar is not displayed, you can display it by choosing Choices  

Toolbar on the View menu. (For more information, see the section “Customizing  
the Edit Plans Window,” later in this chapter.)  
The Choices toolbar is shown in Figure 4-4. 

 

Figure 4-4.  Choices Toolbar  
Or  
To display the Choices dialog box, from the Edit menu, choose Choices, or  
simply press F2.  
The Choices dialog box appears, as shown in Figure 4-5. 
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Figure 4-5.  Choices Dialog Box  
3. For the currently selected node or branch field, make a selection from one or more  

of the list boxes from either the Choices dialog box or the Choices toolbar, as  
shown in Table 4-9.  

NOTE :  
The branch or node field currently selected in the plan determines from which  
of the list boxes you can make selections. 

 
Table 4-9.  Selecting from the Choices Toolbar 

 
For the Field... 

 
Select from This List Box 

 
Node type 

 
Node  

Option 
 
Option  

Node specific data 
 
Choice Type and then Choices, as follows:  

Or  
Branch 

 
a. From the Choice Type list box, choose whether to  

select from values, names, or labels, as appropriate,  
in the Choices list box.  

NOTE :  
Not all selections are available for every node  
and branch field.  

b. From the Choices list box, choose an entry for the  
field. 

 
If you selected an entry from the Choices toolbar or Choices dialog box, the item  
appears in the branch or node field in the plan.  

4. After you have selected an entry from the Choices dialog box, choose OK.  
The data item appears in the branch or node field in the plan. 
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Typing Data into Node and Branch Fields 

 
If you know the routing information you want for a node or branch field, you can type it  
into the field instead of using the Choices toolbar or the Choices dialog box. Type  
information in a field when you have just created a node or branch, or when you want  
to change existing information in the field.  
This section provides the format for typing routing information into node and branch  
fields.  
Depending on the field, an entry can be one of three types of information, as  
described in Table 4-10.  
Table 4-10.  Node and Branch Field Information Types 
 
Value 

 
A specific unit of information, such as the dialed number 800-555-1212 or the  
data rate 64c.  

Name 
 
An identifier for a single value. You can create a name for a value to help you  
more easily identify it.  
For example, you can give the name FLIGHT_INFO to the dialed number  
800-555-1212. That name then can be entered directly on the branch to refer  
to that one specific dialed number.  

Label 
 
An identifier for a group of values and/or names.  
For example, an ATS label can contain the values (access line identifiers)  
M2020 and M2021 and the ATS-type termination names CATERM and  
NVTERM. 

 
Names and labels both have the same format, regardless of whether they appear on a  
branch or a node. Each can be up to 16 characters long and can contain letters, the  
digits 0 to 9, and the symbols # $ . , % & _ - + ’. A colon (:) can also be used, except  
in an Allocator node. The first character of a name must be alphanumeric. The first  
character of a label must be a letter. 

 
Typing Data into Node Fields  

Table 4-11 shows the required fields for the different nodes in Route It! As you enter  
node field entries, keep in mind the following:  
� 

 
All nodes require a node type. To save time, you can enter an abbreviation of the  
node type name. Route It! automatically converts it to the full node type name.  
The Node Type Abbreviation column of Table 4-11 shows the abbreviations you  
can enter.  

� 
 
Only certain nodes require information in the node specific data and options fields.  
The Node Specific Data and Node Options columns of Table 4-11 show the  
information required, if any, for these fields. In Table 4-11, na (not applicable)  
indicates that no entry is required.  

; 
 
USAGE TIP:  
To remove an entry you just typed in a node field, press Esc before pressing  
Enter. 
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NOTE :  
Nodes followed by an asterisk (*) in Table 4-11 currently are not supported by  
AT&T Canada.  

Table 4-11.  Node Entry Options 

 
Node 

 
Node Type  

Abbreviation 
 
Node Specific Data 

 
Node Options 

 
ADR 

 
adr 

 
ADR label 

 
B (for BUSY),  
R (for RNA), or  
BO (for BOTH)  

Allocator 
 
all 

 
na 

 
na  

Area 
 
are 

 
na 

 
na  

ATS 
 
ats 

 
ATS termination name(s),  
ATS access line(s), or label 

 
na 

 
Call Type* 

 
cat 

 
, 
 
ct 

 
na 

 
na  

Caller ID 
 
cal 

 
, 
 
ci 

 
na 

 
na  

CRP* 
 
crp 

 
CRP name or ID 

 
na  

Data Rate* 
 
dat 

 
, 
 
dr 

 
na 

 
na  

Day 
 
day 

 
na 

 
na  

Dialed # 
 
dia 

 
, 
 
dn 

 
na 

 
na  

Digit Prompter 
 
dig 

 
, 
 
dp 

 
announcement name or  
number 

 
Y, N 

 
Enroute 

 
enr 

 
announcement name or  
number 

 
na 

 
Exchange 

 
exc 

 
na 

 
na  

Fix Queue* 
 
fix 

 
, 
 
fq 

 
queue name or ID 

 
na  

Go To 
 
got 

 
, 
 
gt 

 
node number 

 
na  

No Answer 
 
noa 

 
, 
 
na 

 
R (for Ring),  
B (for Busy), or  
D (for Disconnect) 

 
na 

 
Prompter 

 
pro 

 
announcement name or  
number 

 
Y, N 

 
Response 

 
res 

 
announcement name or  
number 

 
na 

 
Term 

 
ter 

 
, 
 
tel 

 
non-ATS termination name,  
non-ATS access line, or  
label 

 
na 

 
Time 

 
tim 

 
na 

 
na 
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Table 4-11.  Node Entry Options (Cont’d) 

 
Node 

 
Node Type  

Abbreviation 
 
Node Specific Data 

 
Node Options 

 
Var Queue* 

 
var 

 
, 
 
vq 

 
queue name or ID 

 
na 

 
Table 4-12 shows the format for values you type in node fields. 
 
Table 4-12.  Format of Node Values 

 
Node Specific Data Value 

 
Format 

 
Access line 

 
Five characters long: The first character is a letter; the  
last four characters are digits.  

Announcement number 
 
A number from 0 to 65535.  

CRP ID 
 
Six digits.  

Go To number 
 
A number of a node in the current plan.  

Queue ID 
 
Three alphanumeric characters within the following  
range: numbers 0 to 9 and lowercase letters a to e. 

 
Typing Data into Branch Fields  

This section provides the format for entries that you type in branch fields.  
As you type branch field entries, keep in mind the following:  
� 

 
Every branch must contain a value, name, or label.  

� 
 
The maximum length for a branch field entry is 16 characters.  

� 
 
Some branches take system-defined values, such as OTHER or FULL. For more  
information on system-defined values, see the section “Routing Plan Nodes and  
Rules” in Chapter 3, “Routing Plan Concepts.”   

�  You can add comments to some branches. A comment must follow the branch  
entry and is separated from it with a hyphen (-

 
). A front slash (

 
/ 
 
) is not allowed in a  

comment. 
 
; 

 
USAGE TIP:  
To remove an entry you just typed in a branch field, press Esc before pressing  
Enter.  

Table 4-13 shows the rules and options of branch fields for each node type. For more  
information on rules affecting branches, see the section “Routing Plan Nodes and  
Rules” in Chapter 3, “Routing Plan Concepts.”  

NOTE :  
Nodes followed by an asterisk (*) in Table 4-13 currently are not supported by  
AT&T Canada. 
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Table 4-13.  Branch Entry Rules and Options 

 
Node Type 

 
Branch Field Entry 

 
System-Defined  

Values 

 
Comments  
Allowed? 

 
ADR 

 
An ADR node has no branches.  

Allocator 
 
Each branch must contain a whole number  
value between 0 and100. 

 
None 

 
Yes 

 
Area Code 

 
An Area Code branch can contain these  
entries: 

 
INTL, DOM 

 
No 

 
� 
 
� 

 
� 

 
one or more three-digit area codes,  
separated by commas  
one or more two-alphanumeric country  
codes, separated by commas (country  
codes are not applicable in Canada)  
a label  
NOTE:  
A branch can contain both area and  
country codes.  

ATS 
 
Automatically added in Autobuild mode. 

 
ALL BUSY 

 
No  

Call Type* 
 
Automatically added in Autobuild mode. 

 
VOICE, DATA 

 
No   

Caller ID  A Caller ID branch can contain these entries:  
� 

 
10-digit number in the format NPA-NXX-  
XXXX, where NPA is the area code and  
NXX-XXXX is the exchange and last four  
digits of a phone number 

 
DEFAULT,  
OTHER  

 
No  

 
NOTE: 

 
� 

 
Dashes are optional.  

a label  
CRP* 

 
A CRP code from 1 to 10 digits long. 

 
DEFAULT,  
OTHER 

 
No 
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Table 4-13.  Branch Entry Rules and Options (Cont’d) 

 
Node Type 

 
Branch Field Entry 

 
System-Defined  

Values 

 
Comments  
Allowed? 

 
Data Rate* 

 
A Data Rate branch can contain these  
entries: 

 
OTHER 

 
No 

 
� 

 
one of the following:   
—  
—  
—  
— 

 
56 

 
, for 56 kilobits per second (Kbps)  

64c 
 
, for 64Kbps clear  

384c 
 
, for 384Kbps clear  

1536c
 
, for 1536Kbps clear 

� 
 
a label  
NOTE:  
A Data Rate branch cannot contain  
multiple data rates. You must create a  
label instead.  

Day 
 
A Day branch can contain the values SU,  
MO, TU, WE, TH, FR, SA in these  
combinations: 

 
OTHER 

 
No 

 
�  
� 
 
�  
� 

 
a single entry, such as SA  
a comma-separated list, such as  
SU, MO  
a range, such as TU-FR  
a list and range together, such as  
SU, MO, TU-FR  

Dialed # 
 
A Dialed Number branch can contain these  
entries: 

 
OTHER 

 
No 

 
� 

 
a 10-digit dialed number  

NOTE: 
 
�  
�  
� 

 
Dashes are optional.  

a name  
a label  
dialed number digits  

Digit  
Prompter 

 
A Digit Prompter branch can contain these  
entries: 

 
DEFAULT 

 
No 

 
�  
� 

 
a single number between 1 and 30  
a range of numbers between 1 and 30,  
such as 5-15  

Enroute 
 
Automatically added in Autobuild mode. 

 
CONTINUE 

 
No 
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Table 4-13.  Branch Entry Rules and Options (Cont’d) 

 
Node Type 

 
Branch Field Entry 

 
System-Defined  

Values 

 
Comments  
Allowed? 

 
Exchange 

 
An Exchange branch can contain these  
entries: 

 
DEFAULT,  
OTHER 

 
No 

 
� 

 
one area code/exchange in the format  
NPA-NXX, where NPA is the area code  
and NXX is the exchange.  

NOTE: 
 
� 
 
�  
� 

 
Dashes are optional.  

two or more comma-separated NPA-NXX  
codes  
an area code  
a label containing one or more NPA-NXX  
codes  

Fix Queue* 
 
Automatically added in Autobuild mode. 

 
FULL 

 
No  

Go To 
 
A Go To node has no branches.  

No Answer 
 
A No Answer node has no branches.   

Prompter  A Prompter branch can contain these entries:  
� 

 
a value consisting of the digits 0 to 9,  
and/or the symbols #, *.  

� 
 
a label  
NOTE:  
A Prompter branch cannot contain  
multiple values. You must create a label  
instead. 

 
OTHER  

 
Yes, if the  
branch field  
entry is a  
value.  
No, if the  
branch field  
entry is a  
label.  

 
Response 

 
A Response node has no branches.  

Term 
 
A Term node has no branches.  

Time 
 
A time range in the format of hh:mmx-  
hh:mmx, where hh is the hour, mm are the  
minutes, and x represents a for a.m., p for  
p.m., n for noon, or m for midnight. For exam-  
ple, 08:00a-05:00p. 

 
OTHER 

 
No 

 
NOTE:  
The minimum time interval is five  
minutes, starting at any five-minute point.  

Var Queue* 
 
Automatically added in Autobuild mode. 

 
FULL 

 
No 
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Changing Node Fields 

 
To change all the fields of a node, use the Change Node command. Information in  
each node field is erased, allowing you to enter new information.  

NOTE :  
Node field changes cannot be undone.  

To change all fields of a node, do the following:  
1. Select a node.  
2. From the Edit menu or the Shortcut menu, choose Change Node.  

All data in the node fields is removed.  
3. Enter new information in the node.  

After you enter a node type, all data is removed from the fields of adjoining  
branches to the right of the node.  
To cancel your change, choose Undo Node Change.  

4. After you complete the node fields, complete the fields of the adjoining branches  
to the right of the node. 
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Quick Call Allocator Changes 
 
You can change the percentages assigned to existing Allocator node branches in five  
minutes or less. Use the Open Quick command or button on the File menu or toolbar,  
respectively, to open a plan in Quick Call Allocator mode.  
In Quick Call Allocator mode, you can change the percentages of Allocator branches  
on one or more Allocator nodes. You can also add or change the comments on  
Allocator branches. Use Open Quick when you need to make changes on an  
emergency basis.  
When a plan appears in Quick Call Allocator mode, you can edit only the values and  
comments on Allocator branches. Intra-nodal validation is always on in Quick Call  
Allocator mode, but it is limited to ensuring that the branches of Allocator nodes total  
100 percent.  
There is no limit to the number of changes to Allocator nodes you can make with a  
single Send command. Route It! sends one request for each of the 34 Allocator nodes  
on Send. The override remains in effect until you make another quick change and  
specify the use of different percentages, or until you make a change to the routing  
plan in Edit Plans.  

NOTE :  
Your quick changes are complete in five minutes or less after the request is  
received by the support system. Your request may be delayed in getting to the  
support system if other applications are running on your PC. Running other  
applications may cause port contention or slow the processing on your PC. You  
can avoid these delays by running only Route It! on your PC.  

Overriding values on Allocator branches is one type of quick change in Route It! You  
can also perform quick changes on plan schedules and on MCA and MCQ schedules.  
For more information on these quick changes, see Chapter 4, “Quick Changes,” in the  
AT&T Route It! Schedules and Quick Changes User’s Guide.  

NOTE :  
Currently, MCQ is not supported by AT&T Canada. 

 
Opening a Plan in Quick Call Allocator Mode 
 
Prerequisites  

To be opened in Quick Call Allocator mode, a plan must be official and contain at least  
one Allocator node. For Quick Call Allocator changes to activate in the network, a plan  
must be part of an official plan schedule that has at least one dialed number assigned  
to it, or it must be an override plan for the plan schedule.  

NOTE :  
The Open Quick command may not be available if you do not have send  
permissions for the Quick Call Allocator task. See your Route It! system  
administrator for more information. 
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Opening Quick Call Allocator Mode  

To open the Quick Call Allocator mode, follow these steps:  
1. Open the Edit Plans main window.  
2. Do one of the following:  
� 

 
From the File menu, choose Open Quick.  
Or  

� 
 
On the toolbar, choose the Open Quick button.  

; 
 
USAGE TIP:  
You can also press Ctrl + Q to open the Quick Call Allocator mode.  

The Open Quick Call Allocator dialog box appears, as shown in Figure 4-6. Each  
tab is used to access an official plan according to your specifications. 

 

Leave this check box selected if you want  
the Plan tab to display on startup of Quick  
.Call Allocator. 

 
Figure 4-6.  Open Quick Call Allocator Dialog Box - Plan Tab 

 
Choosing a Tab  

To select a plan to open, choose one of the tabs as follows, then continue accordingly:  
� 

 
To open a plan by the plan name, select the Plan tab, then go to the following  
section, “Selecting a Plan by Plan Name.”  

� 
 
To choose an active plan associated with an official schedule set, select the  
Schedule Set tab, then see the section “Selecting a Plan by Schedule Set,” later 
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in this chapter. 

 
Selecting a Plan by Plan Name 

 
The list box on the Plan tab (Figure 4-6) displays official plans for the active Service  
Date. The Remarks text box contains read-only remarks about a plan that has been  
selected from the list box.  
To open a plan from the Plan tab, do one of the following:  
� 

 
Type the plan name in the Official Plan text box, then choose OK.  

NOTE :  
If you enter a plan name that exists but has been previously filtered out of the  
list, you will receive a message stating that the plan is not in the filtered list.  

� 
 
Select a plan name from the list and choose OK.  

� 
 
Double-click a plan name in the list.  

� 
 
Expand or narrow the selections in the list as described in the following section.  

The plan you selected appears in the Edit Plans main window, as shown in  
Figure 4-7.  

NOTE :  
If you want to see a helpful tip on using Quick Call Allocator each time you open a  
plan in the Quick Call Allocator mode, select the Show tip on Open Quick check  
box. This automatically selects the check box on the Schedule Set tab also. 

 
Searching for an Official Plan  
To search for an official plan to open, you can expand or narrow the list of plans.  
To expand or narrow the official plan list, do the following:  
1. Make selections for one or both of the Dialed Number or Schedule Set choices  

under List Only. 

 
Dialed Number 

 
To display a list of plans associated with a dialed number,  
type or select a dialed number in the Dialed Number box.  
(If you type the dialed number, dashes are optional.)  

Schedule Set 
 
To display names of official plans that are associated with  
a particular schedule set, type or select an official schedule  
set in the Schedule Set box.  
Plans listed are associated with the schedule set in either  
of these ways:  
� 

 
The plan is used in the plan schedule for a default day,  
exception date, or active plan quick change override.  

� 
 
The plan is contained in the list of plans available for  
an active plan quick change override for the schedule  
set. 
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2. To find and display the active plan for the specified dialed number or schedule set,  

choose Show Active Plan.  
3. Choose Apply.  

NOTE :  
Multiple filters can be applied. The List All choice removes the effects of your  
search from the list of plans.  

The Show Active Plan text box displays the name of the plan that is currently  
active for the dialed number and schedule set specified. If the active plan name is  
displayed in red, it is also an override plan.  

4. After narrowing or expanding the plan list, to open a plan, do one of the following:  
� 

 
Select a plan name from the list and choose OK.  

� 
 
Double-click a plan name in the list.  

The plan you selected appears in the Edit Plans main window, as shown in  
Figure 4-7. 

 

Figure 4-7.  Plan Opened in Quick Call Allocator Mode  
All Allocator nodes are highlighted in magenta. Only branches of Allocator nodes are  
editable in Quick Call Allocator mode. 
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Selecting a Plan by Schedule Set  

You can select an active plan that is associated with an official schedule set using the  
Schedule Set tab (Figure 4-8). The list box on the Schedule Set tab displays official  
schedule sets for the active Service Date. The Remarks text box contains read-only  
remarks about a schedule set that has been selected from the list box.  
To open an active plan for an official schedule set, do one of the following from the  
Schedule Set tab:  
� 

 
Type the schedule set name in the Select the Official Schedule Set for which  
the Active Plan will be opened text box, then choose OK.  

NOTE :  
If you enter a schedule set that exists but has been previously filtered out of  
the list, you will receive a message stating that the schedule set is not in the  
filtered list.  

� 
 
Select a schedule set name from the list and choose OK.  

NOTE :  
Expand or narrow the selections in the list as described in the following  
section, “Searching for an Official Schedule Set.”  

� 
 
Double-click a schedule set name in the list.  

The plan you selected appears in the Edit Plans main window, as shown previously in  
Figure 4-7. 

 

Click this check box to display the Schedule  
Set tab on startup of Quick Call Allocator. 

 
Figure 4-8.  Open Quick Call Allocator Dialog Box - Schedule Set Tab 
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NOTE :  
If you want to see a helpful tip on using Quick Call Allocator each time you open a  
plan in the Quick Call Allocator mode, select the Show tip on Open Quick check  
box. This automatically selects the check box on the Plan tab also. 

 
Searching for an Official Schedule Set  
To search for an official schedule set, you can expand or narrow the list of schedule  
sets.  
To expand or narrow the official schedule set list, do the following:  
1. Display a list of schedule sets associated with a dialed number by typing or  

selecting a dialed number in the Dialed Number box located under List Only. (If  
you type the dialed number, dashes are optional.)    

2. Choose Apply, then click on the schedule set name in the list box. 
schedule set name in the list box.  

NOTE :  
Multiple filters can be applied. The List All button removes the effects of your  
search from the list of schedule sets.  

The schedule set name appears in the small text box on the left of the screen. The  
Active Plan text box displays the name of the scheduled plan that is currently  
active for the schedule set specified. If the active plan name is displayed in red, it  
is also an override plan.  

3. After narrowing or expanding the plan list, to open a plan, do one of the following:  
� 

 
Select a plan name from the list and choose OK.  

� 
 
Double-click a plan name in the list.  

The plan you selected appears in the Edit Plans main window, as shown  
previously in Figure 4-7.  

All Allocator nodes are highlighted in magenta. Only branches of Allocator nodes are  
editable in Quick Call Allocator mode. 
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Editing Allocator Branch Fields 

 
You can type over branch field entries to edit them.  
Keep in mind the following:  
� 

 
Every branch must contain a value from 0 to 100.   

�  
 
You can add comments to Allocator branches. A comment must follow the branch  
entry and is separated from it with a hyphen (-

 
). A front slash (

 
/ 
 
) is not allowed in a  

comment.  
� 

 
The maximum length for a branch field, including the comment length, is 16  
characters.  

� 
 
The branches of each Allocator node must total 100 percent.  

To complete a quick change, you must send the changes to the support system. For  
information about sending changes to the support system, see the section “Sending  
Quick Call Allocator Changes to the Support System,” later in this chapter. 

 
Displaying a Summary of Quick Call Allocator Changes 

 
You can display a read-only summary of information about the changes made in  
Quick Call Allocator mode. This summary can be displayed at any point while editing  
in Quick Call Allocator mode, and it can also be selected to display automatically  
before changes are sent to the support system. 

 
Displaying a Summary Any Time Before a Send  

To display a summary of the changes made in Quick Call Allocator mode, choose  
Summary Info from the File menu.  
The Summary of Allocator Changes dialog box appears, as shown in Figure 4-9. 

 

Figure 4-9.  Summary of Allocator Changes Dialog Box 
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The fields on the Summary of Allocator Changes dialog box are described in  
Table 4-14. 
 
Table 4-14.  Summary of Allocator Changes Fields 
 
Node # 

 
The node number of each Allocator node that has been changed  
in this Quick Call Allocator mode session.  

Old Branch 
 
The value of the branch before the change was made.  

New Branch 
 
The value of the branch after the change was made.  

Change 
 
The percentage of the change between the Old Branch and  
New Branch values. If the comment was changed, COMMENT  
appears in this column.  

Show Sum-  
mary on Send 

 
Select to automatically display the Send Allocator Changes dia-  
log box when sending your quick change request to the support  
system. 

 
To close the Summary of Allocator Changes dialog box, choose Close. 

 
Displaying a Summary Automatically on Send 

 
The Send Allocator Changes dialog box displays a summary of the changes made in  
the current session of Quick Call Allocator mode. This dialog box is automatically  
displayed before changes are sent to the support system if Show Summary on Send  
is selected on the Summary of Allocator Changes dialog box. The Send Allocator  
Changes dialog box is shown in Figure 4-10. 

 

Figure 4-10.  Send Allocator Changes Dialog Box  
The fields on the Send Allocator Changes dialog box are identical to those on the  
Summary of Allocator Changes dialog box. For a description of each field, see the  
previous section, “Displaying a Summary Any Time Before a Send.”  
Choosing Send on this dialog box will send the changes to the support system, as  
described in the following section, “Sending Quick Call Allocator Changes to the  
Support System.” 
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Sending Quick Call Allocator Changes to the Support  
System 

 
Use the Send command on the File menu or the Send icon on the toolbar when you  
have finished editing a plan in Quick Call Allocator mode and want to send the  
changes to the support system.  
When you choose Send, if Show Summary on Send is selected on either the  
Summary of Allocator Changes or the Send Allocator Changes dialog box, the Send  
Allocator Changes dialog box, shown in Figure 4-10, appears. For information on the  
Send Allocator Changes dialog box, see the previous section, “Displaying a Summary  
Automatically on Send.”  
When you choose Send, if all changes have passed validation, they are sent to the  
support system in the order in which they were made.  
To see the status of the update, check the Comm Log.  
The change request appears in the message list as the following:  

NOTE :  
[Plan Name] is the name of the plan sent to the support system.  

— Quick Change: Modify alloc % for Plan [Plan Name].  
The response from the support system appears in the message list as one of the  
following:  
— Quick Change: Alloc % in Plan [Plan Name] Modified.  
— Quick Change of Alloc % failed.  
To see any additional information about a change transaction, check the message  
detail.  
When the quick change has been activated in the network, your original request  
message is updated. The detail for this message contains the exact time that the  
change became effective. 

 
Working with the Quick Toolbar 

 
The Quick toolbar is initially located below the menu bar and to the right of the  
Standard toolbar on a Quick Call Allocator window, as shown in Figure 4-11. 

 

Quick Toolbar 
 
Figure 4-11.  Quick Toolbar  
The Quick toolbar provides you with two tools: the Total indicator and the Changes  
indicator. The Total indicator indicates the sum of percentages across all branches of 
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the same node. The Changes indicator provides a running count of the number of  
Allocator nodes changed in the current editing session.  
To better view data on a window, you can temporarily remove or hide the Quick  
toolbar. You can also move the toolbar to another part of the window.  
To display or hide the Quick Toolbar, do the following:  
1. Choose the View menu.  

On the View menu, a check mark beside the Quick Toolbar indicates that it  
appears. No check mark indicates that the toolbar is hidden.  

2. From the View menu, choose Quick Toolbar.  
The toolbar is alternately hidden or displayed each time you choose the toolbar  
command.  

To move the Quick toolbar, do the following:  
1. Click on a blank part of the toolbar and drag it to another part of the window.  

The Quick toolbar appears as its own window with a title bar.  
2. To return the toolbar to its last location, double-click a blank part of the toolbar. 

 
Closing a Plan in Quick Call Allocator Mode 

 
To close a plan opened in Quick Call Allocator mode, choose Close from the File  
menu.  
If any edits made in the current Quick Call Allocator mode session have not been sent  
to the support system, a message appears. To send the edits to the support system  
and close the plan, choose Yes. To discard the edits and close the plan, choose No.  

NOTE :  
The message described above also appears if any edits made in the current  
Quick Call Allocator mode session have not been sent to the support system  
when you attempt to exit Edit Plans. 
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Creating New Labels 
 
You can create a new label as you build and edit a plan. You can also create labels  
from the Edit menu. To create a label, do one of the following:  
� 

 
Type the name of the new label in a branch or node specific data field.  
After you type the new label name, a message prompts you to confirm that you  
are creating a label.  
If you choose Yes, a Create Labels dialog box appears, and you can immediately  
create the label for that field.  
If you choose No, you can create the labels later. The label name serves as a  
placeholder.  

� 
 
Choose New from the Labels menu.  
In the resulting New Label dialog box, you specify the node type for the label and  
the name of the label.  
NOTE :  
A label name can be up to 16 characters long and can contain letters, the digits  
0 to 9, and the symbols # $ . , % & _ - + ’. The first character of a label must be  
alpha.  

Each method displays a dialog box called a Label Builder. The Label Builder contains  
valid names and values from which you select to create the label. For more detailed  
procedures on creating a label, see Chapter 5, “Labels.” 

 
Getting Plan Information 

 
The Info menu on the Edit Plans window provides general information about the  
current plan and about announcements and terminations. The plan can be local or  
official. You may want to display general information when you are adding or changing  
routing information in a branch or node field.  
For example, you may need to review a list of terminations contained in the plan in the  
active Edit Plans window. Using the Plan selection on the Info menu, you can display  
all terminations contained in the active plan by selecting the Terminations tab.  
The Info menu allows the following selections:  

� 
 
Plan Info  

� 
 
Announce Summary  

� 
 
Term Summary  

These selections are further explained in Table 4-15. Figure 4-12 shows the Term  
Summary window. In addition to the termination information, the TRNT information  
can be filtered using the selection boxes located at the bottom of the window. The  
TRNT filter portion of the screen allows you to select the following TRNT types:  

� 
 
Call Origin  

� 
 
Call Prompter 
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� 

 
Dialed Number  

� 
 
None  

The filter allows you to perform the search based on:  
� 

 
Text entered in Search For text box  

� 
 
Value  

� 
 
Label Names  

� 
 
TRNT Routing #  

NOTE :  
Checking both Value and Label Name will return terminations that contain either  
one or both criteria.  

The Apply button applies the selected criteria to the termination search. The Clear  
Filters button clears any selected check boxes. 
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Right-most Columns: 

 

Left-most Columns: 

 

Figure 4-12.  Information on Terminations 
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Table 4-15 shows the read-only information provided by the commands on the Info  
menu. 
 
Table 4-15.  Info Menu Commands 

 
This Command 

 
Shows General Information About... 

 
Plan Info 

 
Routing data used in the current plan.  
The Plan command displays a window with tabs containing  
information about these categories:  
� 

 
Overall Info—Provides general information about the  
plan, such as category, rotary screening, time zone,  
daylight saving time, CED aggregation, CRP indicator,  
and ICP International information.  

� 
 
Node Summary—Lists each node type and the number  
of each that is included in the current plan.  

� 
 
Terminations—Lists the terminations used in the  
current plan. An asterisk (*) preceding a termination  
indicates that it is an ATS termination. You can select  
one of the terminations listed and display more  
information. The Export button sends terminations  
information for the open routing plan to a text file.  

� 
 
Announcements—Lists announcements used in the  
plan in the active Edit Plans window. You can select one  
of the announcements listed and display more  
information. The Export button sends announcement  
information for the open routing plan to a text file.  

� 
 
Plan Schedules—Lists the plan schedules that contain  
the plan in the active Edit Plans window. You can select  
one of the plan schedules listed and display more  
information. The Export button sends a list of all the  
plan schedules that contain the open plan to a text file.  

Changes to a routing plan are not reflected in the Plan Info  
window until the modified plan has been saved. Once saved  
and the Plan Info window is reopened, the window reflects  
the changes made to the plan prior to being saved.  

Announce Summary 
 
Summary of all announcements available based on the  
Account ID. 
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Table 4-15.  Info Menu Commands (Cont’d) 

 
This Command 

 
Shows General Information About... 

 
Term Summary 

 
Summary of all terminations available for the Service View.  
You can display a map that shows the service area for a  
selected termination. (For more information on the service  
area map, see the section “Terminations” in Chapter 2, “Cus-  
tomer Profile,” of the AT&T Route It! Administration guide.)  
Refer to the previous section and Figure 4-12 for additional  
information on the TRNT filter search capability.  
If you have access lines that subscribe to Terminating Rout-  
ing Number Translation (TRNT), you can select one on the  
Term Info window and choose the Display TRNT button to  
view information about that access line including:  
� 

 
TRNT routing numbers  

� 
 
TRNT type (Call Origin, Dialed Number, Call Prompter)  

Dialed Number Sum-  
mary 

 
Summary of all dialed numbers available for a Service View. 
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Displaying Detail Data for a Node or Branch  
Field 

 
For some node or branch fields, you can display detail data. Use the Display Detail  
command on the Edit menu to see detail about the current branch or node specific  
data field of either a local or an official plan. You can see additional information about  
a selected value, name, or label. Detail about a value or name is read-only.  
When you display detail for a label contained in a currently open plan, the  
corresponding Label Builder appears. You can use the Label Builder to view or  
change the contents of the label. For more information about Label Builders, see  
Chapter 5, “Labels.”  
To display detail about a node or branch field, follow these steps:  
1. Select a branch or node specific data field.  

The field turns yellow to indicate it is selected.  
2. From the Edit menu, choose Display Detail.  

Or  
On the toolbar, choose the Display Detail button.  
For a value or name, a read-only detail dialog box appears. For a DOM branch off  
of an Area node, a read-only version of the Map window appears showing all area  
codes controlled by the selected branch. For a label, the corresponding editable  
Label Builder appears.  

NOTE :  
For more information on the individual fields displayed, see online help.  

3. For instructions on modifying the contents of a label using a Label Builder, see the  
section “Label Builders” in Chapter 5, “Labels.”  

4. To close a detail dialog box, choose Close.  
Or  
To close a Label Builder, choose Cancel . 

 
Saving a Plan 

 
To save an opened plan locally on your PC, use the Save or the Save As command.  
Saving a plan saves the current plan in local data.  
When you save an incomplete plan, a message warns you that required data is  
missing. A plan is considered incomplete under the following conditions:  
�  
�  
� 

 
A call path does not end with a final-handling node.  
A node is missing one or more required branches.  
A branch is left blank.  

Although you can save an incomplete plan, you must correct these errors before  
sending the plan to the support system. 
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To close a saved plan, choose the Close command from the File menu. 

 
Saving a Titled Plan 

 
Use the Save command to save a titled local plan on your PC and continue working  
with it.  
To save a local plan, do the following:  
1. Make sure the plan you want to save is in the active window.  
2. From the File menu, choose Save.  

Or  
On the toolbar, choose the Save button.  
If the plan is complete, a message confirms the save. If the plan is incomplete, the  
plan is saved and a warning message appears indicating that required data is  
missing. 

 
Saving a New Plan or Renaming an Existing Plan 

 
Use the Save As command to save a new, unnamed plan or to rename an existing  
plan. Renaming an existing plan saves another copy of the plan under a different  
name. You can also use Save As to specify or change summary information about  
the plan, such as a text description of the plan that appears in the Remarks list box of  
the Open Plan dialog box.  
To save a plan under a new name, follow these steps:  
1. Make sure the plan you want to save is in the active window.  
2. For a new plan, from the File menu, choose Save or Save As.  

Or  
For an existing plan that you want to rename, choose Save As.  
The Save As dialog box appears, as shown in Figure 4-13. 
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Figure 4-13.  Save As Dialog Box  
3. Type a new name for the plan in the Plan Name text box. A plan name can be up  

to 16 characters long and can contain lowercase and uppercase letters, the digits  
0 to 9, and the symbols # $ . , % & _ - + ’. The first character must be a letter.  
Or  
Select a plan name from the list displayed.  

NOTE :  
If you rename a plan with the name of an existing plan, Route It! warns you  
that you will overwrite the existing plan.  

4. Optionally type comments in the Remarks text box. The text can be up to 120  
characters long and can include any character, except @ or +.  

5. Specify or edit the following information: 

 
Category 

 
Type or select a category for the account. The categories  
listed depend on the current Service View. If you select [Not  
Defined], the plan cannot be filtered by a category when it is  
opened.  
Each category is user-defined. You can type the name of an  
existing category or create a new one. A category name can  
be up to 16 characters long and can contain letters, the digits  
0 to 9, and the symbols # $ . , % & _ - + ’.  

Rotary Screening 
 
Select whether calls are to be screened for rotary dialing.  
Default is No. 
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Daylight Savings 

 
Select whether daylight saving time applies to your Day and  
Time nodes in your routing plans. The default is the previous  
value chosen for this plan or, if one does not exist, the setting  
in the Customer Profile.  

Time Zone 
 
Select a time zone. The default is the previous value chosen  
for this plan or, if one does not exist, the setting in the  
Customer Profile.  

NOTE :  
Currently, the Newfoundland time zone is not supported.  
Customers must make adjustments manually by  
changing the eastern time to a half hour later than the  
standard eastern time. For example, if Atlantic time is  
5:30 p.m., the corresponding Newfoundland time is 6:00  
p.m.  

CED Aggregation 
 
Choose whether or not to aggregate Caller Entered Digits:  
� 

 
To aggregate CEDs for all Digit Prompter nodes in each  
call-processing path, select Digit Prompter Only.  

� 
 
To aggregate CEDs for all Prompter and Digit Prompter  
nodes, select All.  

� 
 
To collect only the digits from the last Digit Prompter  
node, select None.  

� 
 
Choose Yes or No for “Across CRPs”  

ICP International  
(currently not  
supported by  
AT&T Canada) 

 
Choose whether to use the CRP tables referenced in this  
plan to route international toll-free traffic.  
�

 
To use the CRP tables, select Yes.   

� 
 
If you do not want to use the CRP tables, select No.  

The last value saved for the current plan is shown as the  
default. If none exists, the default is No.  

6. To save the plan after making selections, choose OK.  
If the plan is complete, a message on the status bar confirms the save. If the plan  
is incomplete, the plan is saved and a warning message appears indicating that  
required data is missing.  
Or  
To continue working with the plan without saving, choose Cancel. 

 
Performing a Local Plan Validation 

 
Use the 

 
Validate and Save command on the File menu to validate and save your plan  

locally. During the validation process a pop-up window will be displayed. You will be  
able to discontinue the validation process by clicking the “Cancel” button. 
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If you do not cancel the process, validation will complete and the results of the  
Validate and Save will be displayed to you. At this time, you will be able to make  
corrections to the routing plan based on the results of the local routing plan validation.  
+ 

 
IMPORTANT:  
Local Plan Validation is not intended to replace the validations performed when  
the plan is sent to the support system (see “Sending a Plan to the Support  
System”). For the plan to become official, you must send the plan to the Support  
System for final validation. 

 
To validate and save a local plan, do the following:  
1. Make sure the plan you want to validate and save is in the active window.  
2. From the File menu, choose Validate and Save.  

A pop window will be displayed advising you that the Plan validation is in  
progress. If you want to abort this process, you can cancel the validation of the  
plan by clicking on the Cancel validation button. 

 
Sending a Plan to the Support System 

 
Use the Send command on the File menu or the Send icon on the toolbar when you  
have finished creating or revising a plan and want to send it to the support system.  
After the plan passes validation at the support system, it becomes an official plan.  
The plan you send must be local. You cannot send untitled or official plans. At the time  
you send the plan, Route It! checks for the following errors:  
� 

 

�  
� 

 
a call path that does not end with one of these nodes:  
— ADR  
— Go To  
— No Answer  
— Response  
— Term  
a node that is missing one or more required branches  
a branch that is left blank  

If an error is found, Route It! displays an error message and cancels the send. You  
must correct the error and resend the plan.  

NOTE :  
The Send command may be unavailable if you do not have permission to use it in  
Edit Plans. Contact your Route It! system administrator for details.  

To send a plan to the support system, follow these steps:  
1. Display a plan in the active window.  
2. From the File menu, choose Send or select the Send icon from the toolbar.  

The Send Plan dialog box appears, as shown in Figure 4-14. The Service Date  
field shows the current Service Date for the plan you are sending. 
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Figure 4-14.  Send: Plan [Plan Name] Dialog Box 
 
3. To have the plan validated for the current Service Date and all pending Service  

Dates, under Onward, select Yes.  
Or  
To have the plan validated for the current Service Date only, select No. 
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4. Under Go To Validation, select one of the options described in Table 4-16.  
5. Click in the Save Selection as Default, to save the option selected.  

NOTE :  
The setting is identified with the user logged into the system. 
 
Table 4-16.  Go To Validation Options 

 
Option 

 
Description 

 
Report Actual Node  
#s 

 
With this type of validation, the support system reports  
the node number of the node where the error actually  
occurred. A message containing that node number  
appears in the message detail of the Comm Log.  

NOTE :  
This is the recommended selection since it is the  
most complete type of validation.  

Report Go To Target  
Node #s 

 
With this type of validation, the support system reports  
the node number of the node where the error actually  
occurred in the following instances:  
� 

 
When an error occurs before a Go To target node.  

� 
 
When the first path containing a Go To target node is  
checked.  

However, if subsequent paths containing the same Go  
To target node exist in the plan, the support system  
reports only the Go To target node number. This target  
node number appears with an asterisk (*) in the Comm  
Log. The asterisk indicates that the problem could be in  
any one of the nodes in the path following the Go To  
target node. 

 
6. Choose Send.  

A status bar message indicates that the plan has been sent to the host. Route It!  
also saves a copy of the plan locally on your PC.  
If an error has been found, an error message appears and the send is cancelled.  

7. If you receive an error message, you must correct the error and resend.  
8. After the send, check the Comm Log to see if the plan passed validation at the  

support system. For more information, see Chapter 7, “Comm Log.” 

 

AT&T—PROPRIETARY  
Use pursuant to Company Instructions 

 
4-44           AT&T Route It! 



  

 
Chapter 4  Creating or Editing a Plan  
Printing a Plan 

 

Printing a Plan 
 
To print a routing plan, use the Print command on the File menu. You can print the  
entire plan or just a portion of the plan.  
To print a routing plan, follow these steps:  
1. Display the plan in an active Edit Plans window.  
2. From the File menu, choose Print.  

Or  
On the toolbar, choose the Print button.  
The Print Graphical Plan dialog box appears, as shown in Figure 4-15. 

 

Figure 4-15.  Print Graphical Plan Dialog Box  
3. Select the settings for the printout, as described in Table 4-17. 

 
Table 4-17.  Printout Setting Selections 

 
Setting 

 
Selection 

  
Graphical  
Plan Range  

Select the amount of the plan to be printed:  
�

 
To print the entire plan, select Entire Plan.   

� 
 
To print a portion of a plan, select Subplan starting at  
Node #. In the text box, type the number of a node in the  
plan where you want the printout to start.  

Print  
Proportion 

 
Select how large or small you want the plan to appear on the  
printout.  
At 100 percent, the nodes on the printout are approximately the  
same size as those displayed in the Edit Plans window. The pro-  
portion you choose may increase or decrease the number of  
pages printed. 
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Table 4-17.  Printout Setting Selections (Cont’d) 
 
Copies 

 
Select the number of copies.  

Save Settings 
 
Select to save the settings you entered for Print Proportion  
and Copies. 

 
4. To print the plan from the Print Graphical Plan dialog box, choose OK.  

A confirmation dialog box shows the number of pages of the printout.  
Or  
To preview before printing, choose Print Preview.  
The Print Preview dialog box appears, as shown in Figure 4-16. 

 

Figure 4-16.  Print Preview Dialog Box  
NOTE :  
The Print Preview dialog box can also be accessed from the File menu.  
� 

 
To change the proportions in which the plan will print, under Print  
Proportion, type or select a percentage in the Percent text box, or adjust the  
percentage slider, and choose Apply.  
Or  

� 
 
To resize the plan for better viewing, under Zoom To, type a percentage in  
the Percent text box, or adjust the percentage slider, and choose Apply.  

NOTE :  
Selections made under Zoom To do not affect the proportions of the plan  
printout. 
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� 

 
To print the plan from the Print Preview dialog box, choose Print.  
A status bar message confirms the start of printing.  
Or  

� 
 
To return to the Print Graphical Plan dialog box, choose Close.  

5. To print, choose Yes at the confirmation dialog box.  
A status bar message confirms the start of printing.  
For printouts that span more than one page, the plan is printed in segments,  
similar to the sections of a map grid. Page numbers are located in the upper left-  
hand corner of each page. Each page number consists of a letter followed by a  
number. The letter shows the order of plan segments from left to right. The  
number shows the order of plan segments from top to bottom.  
Figure 4-17 shows the order of a plan printout that has multiple pages. The page  
numbers are enlarged in the figure. 

 
A/1 

 
B/1 

 
C/1 

 

A/2 

 

B/2 

 

C/2 

 

Figure 4-17.  Page Numbering on a Plan Printout 

 
Closing a Plan and Quitting Edit Plans 

 
Close a plan with which you have finished working to free up memory. If several plans  
are open, you may close each one individually, or select Exit from the File menu. You  
will be prompted to save any unsaved edits.  
To close a plan, follow these steps:  
1. Make sure the plan you want to close is in the active window.  
2. From the File menu, choose Close.  

The plan is closed if all changes to the plan have been saved. If you made  
changes but did not save them, a confirmation dialog box appears, as shown in  
Figure 4-18. 
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Figure 4-18.  Confirmation Dialog Box 
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3. If the confirmation dialog box appears, do one of the following:  

To save any edits and close the plan, choose Yes.  
For an existing plan, the edits are saved and the plan is closed. For a new plan,  
the Save As dialog box appears. For more information on saving a new plan, see  
the earlier section “Saving a New Plan or Renaming an Existing Plan.”  
Or  
To close the plan without saving the edits, choose No.  
The edits are not saved and the plan is closed.  
Or  
To continue working with the plan without saving, choose Cancel.  
You are returned to the plan in the active window.  

4. To quit Edit Plans, choose Exit from the File menu.  
Edit Plans is closed. 

 
Performing Intra-Nodal Validation 

 
To save time, you can turn off intra-nodal validation while you build or edit a routing  
plan. Intra-nodal validation checks for errors between a node and the adjoining  
branches following it. For more information, see the section “Plan Validation” in  
Chapter 3, “Routing Plan Concepts.”  
To turn off intra-nodal validation while you work with a plan, choose Validation from  
the Options menu. Select one of the two validation options, as described in  
Table 4-18. 
 
Table 4-18.  Intra-Nodal Validation Options 

 
Perform Intra-Nodal  

Validation... 
 
Description 

 
Dynamically, while editing  
the plan 

 
At the time you make an intra-nodal error, an error  
message appears. Upon selecting OK, you can fix  
the error or continue working in Edit Plans.  

Only on receipt by the sup-  
port system 

 
Intra-nodal validation errors are not checked at the  
time you work on a plan. To have intra-nodal vali-  
dation performed, you must send the plan to the  
support system. 

 
If you turn off intra-nodal validation, when you send the plan to have it validated, intra-  
nodal and all other types of validation are performed at the support system. After you  
send the plan, check the Comm Log to display any errors. The Comm Log message  
for unsuccessful validation contains detail on errors.  

NOTE :  
Any setting you choose for intra-nodal validation remains in effect for all sessions  
in Edit Plans until it is changed. 
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To select when intra-nodal validation is performed, follow these steps:  
1. Open a new or existing plan.  
2. From the Options menu on the Edit Plans window, choose Validation.  

The Validation Options dialog box appears.  
3. To have intra-nodal validation performed at the time you work with a plan, select  

Dynamically, while editing the plan.  
Or  
To turn off intra-nodal validation while you work with plans, select Only on  
receipt by the support system.  

4. Choose OK. 

 
Moving Among and Selecting Branches and  
Nodes in a Plan 

 
This section describes how to use keyboard keys and the mouse to select and move  
among nodes and branches in a plan. 

 
Selecting Items in a Plan 

 
To select a portion of a plan for editing, you use your mouse. Each time you click on a  
field, node, or branch, it changes color to help you easily see your selection.  
Table 4-19 explains how to select items in a plan and the color changes that occur. 
 
Table 4-19.  Selecting Items in a Plan 

 
To... 

 
Do This 

 
Select a node 

 
Click anywhere in the node body except in the header.  
The outline of the node turns blue, indicating that it is  
the current node.  

NOTE :  
The color of the target of a Go To node is always  
red.  

Select a branch 
 
Click the branch.  
The branch turns blue, indicating that it is the current  
branch.  

Select a field in a node or on  
a branch 

 
Click on the field.  
The field turns yellow, indicating that it can be edited. 
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Table 4-19.  Selecting Items in a Plan (Cont’d) 

 
To... 

 
Do This 

 
Select a node and all nodes  
and branches following it in  
a path for cutting or copying 

 
Click the header of the first node.  
The node selected and all others following in the path  
turn green. You can cut or copy this highlighted section  
of the plan. 

 
Moving Between Node Fields 

 
To select a field in a node, click on it with your mouse. You can also use keyboard  
keys to move between the fields of a node. When a field is selected, it turns yellow,  
indicating that it can be edited. To move between node fields, press Tab on your  
keyboard. 

 
Moving Between Nodes and Branches 

 
To move between nodes and branches in a plan, you can use either your mouse or  
the arrow keys of your keyboard. The arrow keys allow you to move between nodes  
and branches in sequence, such as along a path. You can also move vertically  
between the nodes or branches of a parent node. Table 4-20 describes how to move  
between nodes and branches in a plan using the arrow keys. 
 
Table 4-20.  Moving Between Nodes and Branches 

 
To... 

 
Use... 

 
Move from left to right along a path 

 
The right arrow key  

Move from right to left along a path 
 
The left arrow key  

Move upward between nodes (or branches) having the same  
parent node 

 
The up arrow key 

 
Move downward between nodes (or branches) having the  
same parent node 

 
The down arrow key 
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Moving and Copying Plan Portions 
 
Using Cut-and-Copy Editing 

 
To save time in plan building, you can reuse a plan portion in another part of the plan  
or in a different plan. To reuse part of an existing plan, you use the Cut, Copy, and  
Paste commands.  
� 

 
When you use the Copy command, you make a copy of the plan portion and  
paste (insert) it in another location. The original portion is unchanged.  

� 
 
When you use the Cut command, you remove a plan portion from its original  
location and move it to a new location.  

The portion you copy or cut is temporarily stored in the Clipboard while you work in  
Edit Plans. You can paste the contents of the Clipboard multiple times. However, the  
Clipboard contents are replaced when you make a different copy or cut, and they are  
lost when you exit Edit Plans.  
To reuse a plan portion during multiple Edit Plans sessions, cut or copy the plan  
portion, open a new plan, paste the plan portion in an empty node or branch with no  
node following it, and then save the new plan under a descriptive name.  
The numbering of pasted nodes continues from the last number previously used in the  
plan. When plan portions are added, nodes may need to be renumbered using the  
procedure in the section “Renumbering Nodes,” later in this chapter.  
If a Go To node is added without its target node, the node specific data will be set to 0.  
To copy or move a plan portion, follow these steps:  
1. Select the header of the first node in the path you would like to copy or move.  

The node and all nodes and branches following it in the path are outlined in green.  
2. Copy or move your selection as follows:  

To copy the plan portion, do one of the following:  
� 

 
From the toolbar, choose the Copy button.  
Or  

� 
 
From the Edit menu, choose Copy.  

A status message indicates that a portion of the plan has been copied to the  
Clipboard.  
Or  
To move the plan portion, do the following:  
a. On the toolbar, choose the Cut button.  

A message prompts you to confirm the cut.  
b. Choose Yes.  

The portion is removed from the current plan and copied to the Clipboard. 

 
AT&T—PROPRIETARY  

Use pursuant to Company Instructions 
 
4-52           AT&T Route It! 



  

 
Chapter 4  Creating or Editing a Plan  
Moving and Copying Plan Portions 

 
3. To paste the plan portion to a new location in the same plan, do the following:  

a. Select an empty node or branch with no node following it.  
Your selection turns blue.  

b. On the toolbar, choose the Paste button.  
The portion is pasted in the new location. A status bar message confirms the  
paste.  

Or  
To paste the plan portion to a new location in a different plan, do the following:  
a. Select a different plan.  
� 

 
If the plan is already open but not displayed, select it from the Window  
menu.  

� 
 
If the plan is partially displayed on your screen, select it.  

� 
 
If the plan has not been opened, open it. For more information on opening  
a plan, see the earlier section “Opening a Plan.”  

� 
 
If you are pasting to a new plan, from the File menu, choose New.  

b. Select an empty node or branch with the node following it in the target plan.  
Your selection turns blue.  

c. On the toolbar, choose the Paste button.  
The portion is pasted in the new location. A status bar message confirms the  
paste.  

NOTE :  
If the plan portion you pasted contains a label of the same label type and name,  
but different contents, as a label contained in the plan to which you pasted, a  
message appears. This message tells you which labels are in conflict. Upon OK,  
contents of labels in the plan portion on the Clipboard are updated to reflect the  
contents of the labels in the plan to which you are pasting. 

 
Using Drag-and-Drop Editing 

 
Use drag-and-drop editing to quickly copy or move a section of a plan without using  
menu commands. You can copy or move a plan portion within the same plan or to a  
different plan. The portion of the plan to be moved or copied is not put on the Edit  
Plans clipboard.  
Drag-and-drop editing cannot be done across Service Views since plans from  
different Service Views cannot be open at the same time.  
The target drop location of the copy or move must be one of the following:  
� 

 
an empty node  

� 
 
a branch that does not have a node following it 
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Exceptions:   

(1) Nodes and branches within the portion of the plan to be moved are invalid  
target drops, even if they meet the above criteria.  

(2) If a root node within the portion of the plan to be moved or copied begins with  
a Call Type node (see

 
NOTE

 
below), the only valid target drop is a root node  

of another plan. 
NOTE :  
Currently, the Call Type node is not supported by AT&T Canada.  

To copy or move a section of a plan, follow these steps:  
1. Display the plan to be edited, or, if you are copying/moving between two plans,  

display both plans so that they are visible on your screen at the same time.  
2. Click the node head of the first node in the path that you want to copy or move.  

The node and all nodes and branches following it are outlined in green.  
3. Hold down the left mouse button and drag the pointer to the target location, which  

should be blue. You may need to hold down Ctrl as you drag the pointer, as  
indicated in Table 4-21. 
 
Table 4-21.  Control Key Usage in Drag-and-Drop Editing 

 
To... 

 
a Plan Section... 

 
Press Ctrl? 

 
Move 

 
in the same plan 

 
No  

between two plans 
 
Yes  

Copy 
 
in the same plan 

 
Yes  

between two plans 
 
No 

 
As you move your mouse, the pointer symbol changes to indicate valid and invalid  
target locations for copying and moving as follows: 

 
valid target location for a  
copy 

 
valid target location for a  
move 

 
invalid location for a copy or  
move (see

 
NOTE

 
below) 

 
NOTE :  
When you see this symbol, you can cancel the drag-and-drop edit by  
releasing the mouse button. 
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4. At the valid target location, release the mouse button (and Ctrl key, if pressed) to  

place the plan section in the new location.  
NOTE :  
During a copy or move, you can scroll to a part of the target plan that is not  
displayed. To scroll, move the pointer toward the borders of the window. The  
plan automatically scrolls in the direction of the pointer if there is more of the  
plan to display.  

To undo a copy or move, from the Edit menu, choose Undo, or choose the Undo  
toolbar button.  
For a move between two plans, you can partially or completely undo the move by one  
or both of these methods:  
� 

 
To remove a moved section from the target location:  
1. Display the plan with the target location in the active window.  
2. From the Edit menu, choose Undo Move To, or choose the Undo toolbar  

button.  
The section is removed from the target location.  

� 
 
To replace a moved section back to its original location:  
1. Display the plan from which the section was moved in the active window.  
2. From the Edit menu, choose Undo Move From, or choose the Undo toolbar  

button.  
The section is replaced in the original location.  

Keep in mind the following when copying or moving Go To nodes or labels:  
� 

 
Copying or moving Go To nodes—If a Go To node is added without its  
corresponding target node, its node specific data field will be set to 0.  

� 
 
Copying or moving labels—You can copy or move a label into a plan that already  
has a label with the same name and type, but with different contents. A message  
appears that gives you the option to continue or cancel the copy or move. If you  
decide to continue, the contents of the label you are copying or moving will be  
overwritten with the contents of the label already contained in the plan. 
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Renumbering Nodes 
 
Use the Renumber Nodes command on the Edit menu to establish a left-to-right,  
top-to-bottom sequence of node numbers. Node numbers can become out of order  
after you add a node without using Autobuild, remove a node, or cut or paste a node  
with a plan portion.  
To renumber nodes on a displayed plan, from the Edit menu, choose Renumber  
Nodes.  
Nodes in the plan are renumbered.  

NOTE :  
If a plan contains a Go To node, the node specific data field of a Go To node is  
updated with the new number of its target node when the plan is renumbered. If  
the target node no longer exists, you must update the plan by creating a new  
target node or by deleting the Go To node. 

 
Finding a Node or Branch 

 
Use the Find command to search for nodes and branches in a plan. To find a node or  
branch, you must specify one of the following:  
� 

 
the announcement name or number  

� 
 
the termination routing number  

� 
 
the node number  

� 
 
specific information contained in a node or branch field  

This list appears as options on the Edit Plan Find Dialog Box. The last option selected  
on the Find window will be saved and will become the default. If the option selected is  
Node Type, the entry in the Node Type field is also saved.  
As a result of the search, Route It! shows a list of all nodes or branches matching your  
criteria. You can then quickly display any matching node or branch in the routing plan  
itself. 
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Keep in mind the following as you specify branch or node fields for your search:  
� 

 
If your search criterion is a name, the search finds all nodes or branches having  
that name or the corresponding value.  

� 
 
Your search can include a system-defined value, such as OTHER or DEFAULT,  
on a branch.  

� 
 
Your search criteria can include a range of values. For example, you can search  
for a branch following a Day node that has the range MO-SA. Or you can search  
for a branch following a Digit Prompter node that has the range 1-15.  

� 
 
For certain nodes and branches, if you specify a value (or name) that is part of a  
label, the search finds any nodes or branches having that value (or name) in its  
label, as well as those nodes or branches that have that value.  
For example, you might want to search for an ADR node that has an access line  
of B1111. Your search would find all ADR nodes with that value and all ADR  
nodes that have labels containing that value.It is possible for a node or branch to  
appear on the list/scrolling list, even though it is no longer part of the routing plan.  
This may occur when you delete a node or branch when the Find mode is still  
active. If you highlight such a node or branch in a list/scrolling list, an error  
message is displayed to explain that the node or branch is not in the plan.  

� 
 
If you use the Previous or Next button to select a node or branch that is no longer  
a part of the plan, Find will skip over it in the list/scrolling list.  

� 
 
For a Dialed # node, the Branch Data field cannot be populated with an  
11-digit UIFN dialed number.  

The nodes and branches that can be searched for the contents of their labels are  
indicated in Table 4-22. 

 
Table 4-22.  Label Contents Search 

 
Nodes 

 
Search in Node Specific Data 

 
Search in Branch Data 

 
ADR 

 
X  

Area Code 
 
X  

ATS 
 
X  

Caller ID 
 
X  

Data Rate 
 
X  

Dialed # 
 
X  

Exchange 
 
X  

Prompter 
 
X  

Termination 
 
X 

 
NOTE :  
Nodes not listed do not use labels in their node specific or branch data. 
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Finding a Node 

 
To find a node, follow these steps:  
1. Display a plan in the active window.  
2. From the Edit menu, choose Find.  

Or  
On the toolbar, choose the Find button.  
; 

 
USAGE TIP:  
You can also press Ctrl + F to find a node.  

The Find dialog box appears, as shown in Figure 4-19. 

 

Figure 4-19.  Find [Plan Name] (Official or Local) Dialog Box  
3. To search for a node, follow the steps for your search criteria in Table 4-23. 

 
Table 4-23.  Finding Nodes 

 
To Search for a Node... 

 
Do This 

 
With a specific announcement 

 
1. Select Announcement and type or select an  

announcement in the text box.  
2. Choose Apply.  

With a specific terminating  
routing number 

 
1. Select Term Routing # and type or select a  

TRN in the text box.  
2. Choose Apply. 
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Table 4-23.  Finding Nodes (Cont’d) 

 
To Search for a Node... 

 
Do This 

 
With a specific node number 

 
1. Select Node Number and type a node  

number in the text box. (The node number can  
contain up to 10 digits.)  

2. Choose Apply.  
Based on information in its node  
fields 

 
1. Select Node Type and type or select a node  

type.  
2. In the Node Specific Data and Node Option  

boxes, optionally type information for one or  
both of these node fields.  

NOTE :  
For the format of node field data, see the  
section “Typing Data into Node and  
Branch Fields,” earlier in this chapter.  

3. Choose Apply. 
 
If one matching node is found, it appears in the plan window. If multiple nodes are  
found, the system lists the matching nodes in the Find dialog box, as shown in  
Figure 4-20. 

 

Figure 4-20.  Matching Nodes in the Find Dialog Box  
The nodes are listed as they appear in a plan, from left to right and from top to  
bottom. The scrolling list shows this information about matching nodes:  
From Node 

 
The number of the node.  

From  
Branch 

 
The number of the branch. 

 
4. To display one of the nodes listed in the plan window, select the node from the  

scrolling list and choose Find.  
The node selected appears in the plan window.  

5. To display the next or previous matching node, select Next or Previous.  
The next or previous node appears in the plan window. It is also highlighted in the  
scrolling list. 
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6. To clear all boxes in the Find dialog box before making another search, choose  

Reset.  
7. To close the Find dialog box, choose Close.  

NOTE :  
You can use the toolbar buttons or the Ctrl and arrow keys to move between the  
next and previous nodes after closing. 

 
Finding a Branch 

 
To find a branch, follow these steps:  
1. Display a plan in the active window.  
2. From the Edit menu, choose Find.  

Or  
On the toolbar, choose the Find button.  
; 

 
USAGE TIP:  
You can also press Ctrl + F to find a branch.  

The Find dialog box appears, as shown previously in Figure 4-19.  
3. Select Node Type and type or select the node type of the node preceding the  

branch.  
4. In the Branch Data box, type a name, label, or value for the field of the branch for  

which you are searching. For the format of branch field information, see the  
section “Typing Data into Node and Branch Fields,” earlier in this chapter.  

NOTE :  
To search for a branch with specific comments, you must type a branch  
name, label, or value and the comments, exactly as they appear in the branch  
field.  

5. Choose Apply.  
If one matching branch is found, it appears in the plan window highlighted in blue.  
If multiple branches are found, the system lists them in the Find dialog box, as  
shown in Figure 4-21. 

 

Figure 4-21.  Matching Branches in the Find Dialog Box  
Branches are listed in the order in which they appear in the plan, from left to right 
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and from top to bottom. The scrolling list shows this information about matching  
branches:  
From Node  
Number 

 
The number of the node preceding the matching branch. 

 
To Node 

 
The number and type of the node following the matching  
branch.  

6. To display a branch matching your criteria in the plan window, select the branch  
from the scrolling list and choose Find.  
The branch selected appears in the plan window.  

7. To display the next or previous matching branch, select Next or Previous.  
The next or previous branch appears in the plan window. It is also highlighted in  
the scrolling list.  

8. To clear all boxes in the Find dialog box for another search, choose Reset.  
9. To close the Find dialog box, choose Close. 
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Replacing Terminations and Announcements 
 
Use the Replace command to find a specific termination or announcement in a plan  
and replace one, some, or all occurrences of it with a different termination or  
announcement. If a label contains a replaced termination or announcement, the label  
name remains the same, but its contents are updated.  
To replace a termination or an announcement, follow these steps:  
1. Display the plan in the active window.  
2. From the Edit menu, choose Replace.  

The Replace dialog box appears, as shown in Figure 4-22. 

 

Figure 4-22.  Replace Dialog Box 
 
3. Select either Termination or Announcement.  

The headings for the text boxes display either Find Termination/Replace with  
Termination or Find Announcement/Replace with Announcement,  
depending on your selection.  

4. In the Find text box, type or select the ATS-type or non-ATS-type termination  
name or access line you would like to replace.  
Or  
Type or select the announcement name or number you would like to replace.  
Use one of the formats described in Table 4-24. 
 
Table 4-24.  Announcement Name and Number Formats 

 
Name 

 
Number Format 

 
Access line 

 
Must be five characters long: The first character is alpha; the  
last four characters are numeric.  

Termination name 
 
Can be up to 16 characters long and can include the digits  
0 to 9 and the symbols # $. , % & _ - + ’ . Letters must be in  
uppercase. The first character must be a letter. 
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Table 4-24.  Announcement Name and Number Formats (Cont’d) 
 
Announcement  
number 

 
Must be a number from 0 to 65535. 

 
Announcement  
name 

 
Can be up to 16 characters long and can include the digits  
0 to 9 and the symbols # $. , % & _ - + ’ . Letters must be in  
uppercase. The first character must be a letter. 

 
5. In the Replace with box, type or select the replacement termination name or  

access line.  
NOTE :  
The original termination name or access line and the replacement termination  
name or access line must both be either ATS-type or non-ATS-type  
terminations.  

Or  
Type or select the replacement announcement name or number.  

6. After making selections, choose Replace.  
The Confirm Replace Termination or Announcement dialog box appears.  

7. To confirm your choice for replacement, follow the instructions in Table 4-25. 
 
Table 4-25.  Replacing Terminations and Announcements 

 
To Replace... 

 
Do This 

 
Only the termination or announcement  
specified on the message 

 
Choose Yes. 

 
All instances of the termination or  
announcement in the active plan 

 
Choose Yes to All. 

 
None of the terminations or  
announcements in the node or label  
specified 

 
Choose No or Cancel. 

 
You are returned to the selected plan window. 
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Changing the Service View 
 
To choose the routing plan information with which you want to work, you select or  
change the Service View. A Service View is the plan information associated with a  
specific Account ID and Service Date. The Service View option is available for most  
Route It! tasks.  
You can change both the Account ID and the Service Date from Edit Plans. However,  
if a Quick Call Allocator window is active, only the Account ID can be changed.  
You can also change the Service View for the current task only or for all tasks in  
Route It! 
 
! 

 
CAUTION:  
Changing the Service View should be done with all routing plans closed. If a plan  
is open, work will be lost unless you save or send it. 

 
When changing a Service View, you need to decide whether to change it for the  
current task only or for all Route It! tasks. See Table 4-26 for a description of each  
selection. 

 
Table 4-26.  Changing the Service View 
 
When You Change the  

Service View for... 
 
Then... 

 
The current task only 

 
The Service View remains in effect for the current task  
session only.  

All Route It! tasks 
 
The Service View applies to all tasks in Route It!, whether  
they are currently running or started later. It becomes the  
default Service View for all tasks until you choose a new  
Service View for all Route It! tasks. 
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To change a Service View, follow these steps:  
1. From the View menu, select Svc View.  

Or  
On the toolbar, choose the Service View button.  
The Change Service View dialog box appears, as shown in Figure 4-23. 

 

Figure 4-23.  Change Service View Dialog Box  
2. In the Account ID text box, do one of the following:  

Type an Account ID and choose Apply.  
If changes are made to the Account ID field, the APPLY button must be selected  
before choosing the OK button.  
Or  
Click the Choices (...) button and select an Account ID from the Choice List dialog  
box.  
The Customer Name and Service Date fields update with the associated  
information.  

3. In the Service Date text box, type or select a Service Date. The format is  
mm/dd/yy, where mm is the month, dd is the day, and yy is the year.  

NOTE :  
All Service Dates for that Account ID are listed, except dates earlier than the  
active Service Date. If a Quick Call Allocator window is active, the Service  
Date text box is read-only.  

Each Service Date is followed by a read-only indicator displaying whether the  
Service Date is manually or automatically activated. The indicators are explained  
as follows: 

 
Manual  
Activate 

 
The work center must change the indicator to  
Auto Activate to activate the Service Date.  

Auto Activate 
 
The Service Date becomes active when the  
effective date is the same as the current date. 
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4. Under Change In, select whether to change the Service View for the Current  

Task Only or for All Route It! Tasks.  
NOTE :  
Change In is dimmed if your account access permissions for the selected  
Account ID have been changed by your Route It! system administrator.  

5. Choose OK.  
A message warns you about the potential loss of unsent edits and prompts you to  
confirm the Service View change.  

6. To complete the Service View change, choose Yes.  
The status bar shows the Account ID chosen for the Service View. 

 
Deleting a Local or Official Plan 

 
You can delete one or more local plan(s) stored on your PC or one or more official  
plan(s) stored at the support system. When you delete an official plan(s), you send a  
delete request to the support system.  
To delete one or more local or official plan(s), follow these steps:  
1. Display the plan in the active window.  
2. From the File menu, choose Delete.  

The Delete Plan dialog box appears, as shown in Figure 4-24. 

 

Figure 4-24.  Delete Plan Dialog Box  
3. Type or select the name of the plan to be deleted and choose Delete. 
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4. To delete multiple plans, use the Control or Shift to make multiple selections,  

and then choose Delete.  
A confirmation dialog box appears, asking you to confirm your deletion.  
Continue with a procedure in one of the next two sections, depending on whether  
you are deleting a local or an official plan.  
Or  
To return to the plan in the active window without deleting, choose Close. 
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Deleting a Local Plan 

 
To delete one or more local plan(s), do the following at the confirmation dialog box,  
shown in Figure 4-25. 

 

Figure 4-25.  Confirmation to Delete a Local Plan  
1. To delete the plan, choose Yes to delete a single plan or Yes to All to delete  

multiple plans.  
The local plan is deleted from your PC, as indicated by a status bar message.  
Or  
To return to the Delete Plan dialog box without deleting, choose No. 

 
Deleting an Official Plan 

 
To delete one or more official plan(s), do the following at the Delete Official Plan  
dialog box, shown in Figure 4-26. 

 

Figure 4-26.  Delete Official Plan Dialog Box  
1. Make sure the Service Date is correct.  
2. To have the plan deleted for the current Service Date and all pending Service  

Dates, beside Onward, select Yes.  
Or  
To have the plan deleted for the current Service Date only, in the Onward area,  
select No.  

3. Choose Send to delete a single plan or Send All to delete multiple plans. 
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NOTE :  
If the Send command is unavailable, contact your Route It! system  
administrator for more information.  

The delete request is sent to the support system, as indicated in the status bar  
message.  

NOTE :  
To confirm the success of your delete request, check the Comm Log.  

Or  
To cancel without deleting the official plan, choose Cancel.  
You are returned to the Delete Plan dialog box. 

 
Displaying Summary Information About a  
Plan 

 
Use the Summary Info command on the File menu to display and change summary  
information about a local plan.  
To display and change summary information about a plan, follow these steps:  
1. Display a local plan in the active window.  
2. From the File menu, choose Summary Info.  

The Summary Info on Plan dialog box appears.  
3. Make selections for each field as follows: 

 
Category 

 
Type or select a category for the account. The categories  
listed depend on the current Service View. If you select [Not  
Defined], the plan cannot be filtered by a category type  
when it is opened.  

Time Zone 
 
Select a time zone. The default is the previous value chosen  
for this plan or, if one does not exist, the setting in the  
Customer Profile.  

NOTE :  
Currently, the Newfoundland time zone is not supported.  
Customers must make adjustments manually by  
changing the eastern time to a half hour later than the  
standard eastern time. For example, if Atlantic time is  
5:30 p.m., the corresponding Newfoundland time is 6:00  
p.m.  

Remarks 
 
Optionally type comments in the Remarks text box. The text  
can be up to 120 characters long and can include any char-  
acter, except @ or +.  

Rotary Screening 
 
Specify whether calls are to be screened for rotary dialing.  
The default is No. 
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Daylight Savings 

 
Specify whether daylight saving time applies to the Day and  
Time nodes in your routing plans. The default is the previous  
value chosen for this plan or, if one does not exist, the setting  
in the Customer Profile.  

CED Aggregation 
 
Choose whether to aggregate Caller Entered Digits:  
� 

 
To aggregate CEDs for all Digit Prompter nodes in each  
call-processing path, select Digit Prompter Only.  

� 
 
To aggregate CEDs for all Prompter and Digit Prompter  
nodes, select All.  

� 
 
To collect only the digits from the last Digit Prompter  
node, select None.  

ICP International  
(currently not  
supported by  
AT&T Canada) 

 
Choose whether to use the CRP tables referenced in this  
plan to route international toll-free traffic.  
�

 
To use the CRP tables, select Yes.   

� 
 
If you do not want to use the CRP tables, select No.  

The last value saved for the current plan is shown as the  
default. If none exists, the default is No. 

 
4. To save any changes to summary information, choose OK. 

 
Customizing the Edit Plans Window 

 
You can use the commands on the View menu to customize the way your routing  
plans are displayed. You can:  
�  
�  
� 

 
hide or display the Standard or Choices toolbar  
display a small diagram of a plan called a viewbox  
enlarge or reduce the size of a plan  

The settings you make with commands on the View menu remain in effect during all  
Edit Plans sessions until you change them again. You can also show data in nodes  
and branches as either names or IDs. For more information, see the section  
“Displaying Names or IDs,” earlier in this chapter. 
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Displaying or Hiding Toolbars 

 
Use the Standard Toolbar or Choices Toolbar commands to temporarily remove or  
“hide” these toolbars from the Edit Plans window. Hiding one or both of these toolbars  
allows you to display more of a plan in the Edit Plans window. Figure 4-27 shows each  
toolbar. 

 

Figure 4-27.  Standard and Choices Toolbars 

 

AT&T—PROPRIETARY  
Use pursuant to Company Instructions 

 
AT&T Route It! 

 
                       4-71 



  

 
Chapter 4  Creating or Editing a Plan  
Customizing the Edit Plans Window 

 
To display or hide the Standard and/or Choices toolbar, do the following:  
1. Display a new or existing plan.  
2. Select the View menu.  

A check mark by Standard Toolbar or Choices Toolbar indicates that the  
toolbar appears. No check mark indicates that the toolbar is hidden.  

3. From the View menu, choose either Standard Toolbar or Choices Toolbar or  
both.  
The selected toolbar is alternately hidden or displayed each time you choose the  
toolbar command. 

 
Displaying the Viewbox 

 
A viewbox contains a condensed representation of the plan that is currently displayed  
in an Edit Plans window. You can use the viewbox as a guide to move to different  
parts of a plan when the plan is too large to be displayed all at once in a window. The  
viewbox appears by default when you first open a plan in Edit Plans.  
Figure 4-28 shows a viewbox. 

 

Figure 4-28.  Viewbox  
The shaded area of the viewbox shows the portion of the plan currently displayed in  
the window. The nodes in the viewbox are displayed in the same color scheme as  
those shown in the Edit Plans window.  
To display or remove the viewbox, follow these steps:  
1. Open a new or existing plan.  
2. Choose the View menu.  

On the View menu, a check mark by Viewbox indicates that the viewbox is  
visible. No check mark indicates that the viewbox is hidden.  
From the View menu, choose Viewbox.  
The viewbox is alternately displayed or removed each time you choose Viewbox.  
If you choose to hide the viewbox, it remains hidden for all plans you open in the  
current Edit Plans session until you change the viewbox setting again.  

NOTE :  
You can resize the viewbox. 
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3. To move to another part of the plan using the viewbox, drag the gray portion in the  

viewbox.  
The plan portion displayed in the gray section is also displayed in the Edit Plans  
window. The gray section turns black as you drag it.  
Or  
To move from one node or branch to another, use the vertical and horizontal scroll  
bars.  
NOTE :  
When the user exits Edit Plans, the viewbox properties are saved in relation to the  
User ID. The next time this user opens Edit Plans, the viewbox is presented the  
same way it was last displayed or hidden. The properties include: position  
(relation to the top left corner of the Edit Plans task window), size, and display  
state (displayed or hidden). 

 
Resizing a Plan 

 
Use the Zoom command or the drop-down list on the toolbar to change how large or  
small a plan appears on an Edit Plans window. You can enlarge the plan to see detail  
more clearly, or you can reduce the plan to see more of the plan at once in a window.  

NOTE :  
The Zoom command does not affect the proportions of your plan printout.  

To resize a plan using the Zoom command, follow these steps:  
1. Open a new or existing plan.  
2. From the View menu, choose Zoom.  

The Zoom dialog box appears, as shown in Figure 4-29. 

 

Figure 4-29.  Zoom Dialog Box 
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3. Type a percentage in the Percent text box.  

Or  
Adjust the percentage slider.  

NOTE :  
To reset the setting in the dialog box to match the current zoom setting of the  
plan in the active Edit Plans window, choose Reset.  

4. Choose OK.  
The plan appears at the percentage chosen.  

To resize a plan using the drop-down menu on the toolbar, follow these steps:  
1. Choose the arrow on the toolbar.  

A list of percentages appears.  
2. Choose a percentage from the list, or type a percentage in the text box.  

The plan appears at the percentage chosen. 

 
Updating Plan Data 

 
You can update one or more official plans on your PC with official data from the  
support system. Updating your official plans keeps them in sync with the data at  
the support system.  
For the procedure to update official plans on your PC, see Chapter 3, “Refresh,” in  
the AT&T Route It! Administration guide. 
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This chapter describes how to create or modify labels you use in your routing plans. 

 
Working with Labels 

 
A label lets you group several values or names under one identifier. You can use  
labels in branch and node fields instead of specifying individual values or names.  
Labels can help you save time when you create or edit a routing plan. They can also  
help you logically group information together.  
You can create a new label immediately at a blank node or branch field, or you can  
create many labels all at once. You can also copy and rename labels in AT&T Route  
It! You can remove multiple data elements from the following labels at once:  
� 

 
Prompts - CEDs  

� 
 
ATS - Terminations  

� 
 
Data Rate - Data Rates  

� 
 
Dialed Number - Dialed Numbers  

To quickly create or modify the contents of labels, you make choices from Label  
Builders. Each Label Builder contains lists of valid values and names specific to the  
type of label you are building. There is a Label Builder dialog box for almost every type  
of node or branch label you need to create. The Exchange Label Builder provides an  
Edit dialog box that allows you to enter additional exchanges. Area Code labels make  
use of a graphical format for creating label contents, instead of using Label Builders.  
This chapter explains how to create a new label and build its contents. It also  
describes how to display and change the contents of an existing label and how to  
copy, rename, delete, or print the contents of one or more labels.  

NOTE :  
For nodes currently not supported by AT&T Canada Long Distance Services, see  
the section “Node Categories” in Chapter 3, “Routing Plan Concepts.” 

 
Relationship Among Values, Names, and Labels 

 
In a plan, node and branch fields can contain routing information in one or more of the  
formats described in Table 5-1. 
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Chapter 5  Labels  
Working with Labels 

 
Table 5-1. Node and Branch Field Information Types 
 
Value 

 
A specific unit of information, such as the dialed number 800-555-1212 or  
the data rate 64c.  

Name 
 
An identifier for a value. You can create a name for a value to help you more  
easily identify it.  
For example, the dialed number 800-555-1212 can be given the name  
FLIGHT_INFO. That name then can be entered directly on the branch to  
refer to that one specific dialed number.  

Label 
 
An identifier for a group of values and/or names.  
For example, an ATS label can contain the values (access line identifiers)  
M2020 and M2021 and the ATS-type termination names CATERM and  
NVTERM. 

 
Some branch and node fields can contain labels, as described in Table 5-2. 

 
Table 5-2. Node and Branch Fields That Can Contain Labels 

 
Branches Following These Nodes Can  

Contain Labels 

 
The Node Specific Data Fields of These  

Nodes Can Contain Labels 
 
�  
�  
� 

 
�  
�  
� 

 
Area Code  
Caller ID  
Data Rate (currently not supported  
by AT&T Canada Long Distance  
Services)  
Dialed #  
Exchange  
Prompter 

 
�  
�  
� 

 
ADR  
ATS  
Term 

 
Using Labels 

 
Table 5-3 shows some ways you may want to use labels to group individual node or  
branch values associated with each node type. 

 
Table 5-3. Using Labels with Different Node Types 

 
Node Type 

 
Ways to Use Labels with This Node 

 
ADR 

 
You can associate one termination or access line with another termi-  
nation or access line to use as a backup. 
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Chapter 5  Labels  
Working with Labels 

 
Table 5-3. Using Labels with Different Node Types (Cont’d) 

 
Node Type 

 
Ways to Use Labels with This Node 

 
Area Code 

 
You can group together area codes that correspond to the geo-  
graphic areas from which calls originate. For example, using Area  
Code nodes, calls originating in the western United States could be  
routed to Denver while calls originating in the eastern United States  
could be routed to Chicago. An Area Code node could have a branch  
label called EAST, which could include area codes 201, 908, 609,  
212, 203, 732, and 215. All these area codes would be assigned to  
one branch by using EAST as the branch label.  

ATS 
 
You can group access lines to indicate the sequence in which calls  
should be routed to them.  

Caller ID 
 
You can include originating numbers so that calls from these num-  
bers can be routed the same way. In other words, you can group  
telephone numbers so calls from those numbers are routed differ-  
ently than calls originating from telephone numbers not included in  
the label.  

Data Rate 
 
To specify multiple data rates on a branch, you must use a label.  

(currently not  
supported by  
AT&T Canada  
Long Dis-  
tance Ser-  
vices)  
Dialed # 

 
You can group together telephone numbers so that calls to these  
numbers can be directed appropriately. Since you can have more  
than one dialed number assigned to a plan, you can group dialed  
numbers so calls to telephone numbers included in the same label  
are all routed the same way.  

Exchange 
 
You can group together exchanges within area codes that corre-  
spond to the geographic areas from which calls originate.  

Prompter 
 
You can group two or more sets of digits that callers will use to direct  
their calls. Ordinarily, each set of prompter digits would route calls to  
a different branch. However, if you want two or more prompter digits  
to route calls the same way (during particular time periods, for exam-  
ple), you can group the digits and assign them to the same branch by  
using a label. Any prompter digits that are not defined are assigned  
the system-defined label OTHER.  

Term 
 
You can use a label to designate a new way to identify an access line  
or termination, as appropriate within the context of a particular plan.  
For example, if you have a termination name of CHICAGO that you  
use in most plans but in another plan you would prefer to call it U.S.,  
you can choose to give it the U.S. label for that other plan. 
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Chapter 5  Labels  
Working with Labels 

 
Sort Sequence of Listed Data 

 
Label data, such as telephone numbers, is displayed in ASCII order, that is, in the  
sequence shown below:  
(1) all symbols except underscore (_)  
(2) numbers  
(3) capital letters  
(4) underscores (_)  
(5) lowercase letters 
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Creating a New Label 

 

Creating a New Label 
 
There are two ways to create a new label. You can:  
� 

 
Type the name of the new label in an empty branch or node field.  
Typing a new label name lets you create a specific label right when you need it  
during plan editing.  
When you leave the field, you are prompted to create a new label. If you choose to  
do so, the system displays a Label Builder, where you select the contents of the  
label. If you are creating an Area Code label, the system displays a Textual  
Display or Map window for you to create the label contents. Or you can continue  
working with the plan, leaving the label name as a placeholder until you create its  
contents later.  

� 
 
Choose New from the Labels menu on the Edit Plans menu bar.  
The New command lets you create several labels at once.  
The New Label dialog box prompts you for a node type and the name of the new  
label. When you choose Create, the system displays the Label Builder, where  
you can define the contents of the label. If you are creating an Area Code label,  
the system displays a Textual Display or Map window for you to create the label  
contents. After you create a label, the New Label dialog box remains displayed,  
allowing you to create additional labels.  
NOTE :  
A label name can be up to 16 characters long and can contain letters, the digits  
0 to 9, and the symbols # $ . , % & _ - + ’. The first character of a label must be a  
letter. 

 
Typing a Label Name 

 
To create a new label by typing the label name at the node or branch field, follow  
these steps:  
1. Display a local plan in the active window of Edit Plans.  
2. At an empty branch or node, type the name of the new label.  

When you leave the field, a message prompts you to create the label now.  
3. To create the label now, choose Yes at the message.  

The system displays the appropriate Label Builder. If you are creating an Area  
Code label, the system displays the Textual Display or Map window instead of a  
Label Builder.  
Or  
To leave the label name as a placeholder and continue working with the plan,  
choose No at the message.  
You are returned to the plan. 
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Chapter 5  Labels  
Creating a New Label 

 
For information on selecting the label contents using the Label Builder, see the  
section “Label Builders,” later in this chapter.  
For information on selecting the label contents of an Area Code label, see the section  
“The Textual Display and Map Windows,” later in this chapter. 

 
Using the New Command 

 
To create a label using the New command, follow these steps:  
1. Display a local plan in the active window of Edit Plans.  
2. From the Labels menu, choose New.  

The New Label dialog box appears, as shown in Figure 5-1. 

 

Figure 5-1. New Label Dialog Box  
The Plan field shows the name of the plan currently opened.  

3. From the Node Type drop-down list, choose the node type for the label you want  
to create.  

4. At the Label Name box, type the name of the new label and choose Create.  
The Label Builder for the node type selected appears. For an Area Code label, the  
Textual Display or Map window appears.  
Or  
To close the New Label dialog box without creating a label, choose Close.  
You are returned to the Edit Plans window.  

For information on selecting the label contents using the Label Builder, see the  
following section, “Label Builders.”  
For information on creating the contents of an Area Code label, see the section “The  
Textual Display and Map Windows,” later in this chapter. 
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Label Builders 
 
Label Builders are dialog boxes that help you work with labels. Use Label Builders to  
create, display, or change the contents of a label.  

NOTE :  
You can edit the contents of labels from an official plan if you save the plan locally.  
If the plan is not saved locally, Label Builders for these labels are read-only.  

There is a unique Label Builder dialog box for almost every type of label in Edit Plans.  
The following sections describe the fields of each Label Builder and show you how to  
add or change label contents. (To display or modify an Area Code label, see the  
section “The Textual Display and Map Windows,” later in this chapter.) 

 
ADR Label 

 
An ADR label contains a primary and secondary non-ATS termination. It is required in  
the node specific data field of an ADR node. Figure 5-2 shows the ADR Label Builder. 

 

Figure 5-2. ADR Label Builder  
For an existing label, the ADR Label Builder shows these fields: 

 
Primary Term 

 
The termination name or access line of the primary termination.  

Secondary  
Term 

 
The termination name or access line of the secondary termination. 

 
The Choices (...) button displays a Choices dialog box that lets you display and filter a  
list of all terminations for the Service View. You can select terminations from this  
dialog box to add to the ADR label. For instructions on using the Choices dialog box,  
see the section “Choices Button” in Chapter 2, “Using Route It! with Windows.”  
To get additional detail, select either a primary or a secondary termination and choose  
Info. To close a read-only Label Builder, choose Close. 
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Chapter 5  Labels  
Label Builders 

 
Creating or Changing an ADR Label  

To create or edit an ADR label, you type or select primary or secondary terminations  
in the Label Builder dialog box. You can specify either the termination name or access  
line for each. To close the ADR Label Builder without making any changes, choose  
Cancel.  
To be included in an ADR label, a non-ATS termination:  
� 

 
cannot subscribe to the Redirect feature  

� 
 
cannot have a service type of I800 Outbound  

� 
 
cannot have a service type of Canadian Northbound, unless the egress type is  
Direct Connect and the TRN begins with 299  

To create or change the contents of an ADR label, follow these steps:  
1. At the Primary Term box, type or select an access line or termination name.  

The Choices dialog box contains all terminations for the Service View.  
NOTE :  
The primary and secondary terminations must have the same CINFO values.  

2. At the Secondary Term box, type or select an access line or termination name.  
The Choices dialog box contains all terminations for the Service View.  

3. To save the ADR label, choose OK.  
Or  
To close the ADR Label Builder without making any changes, choose Cancel.  

4. To get additional detail, select either a primary or a secondary termination and  
choose Info. 

 
Area Code Label 

 
For a description of the Area Code Label Builder, see “The Textual Display and Map  
Windows,” later in this chapter. 
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Label Builders 

 
ATS Label 

 
An ATS label lists the terminations to which calls can be routed. You create this label  
for the node specific data field of an ATS node. Figure 5-3 shows the ATS Label  
Builder. 

 

Figure 5-3. ATS Label Builder  
For an existing ATS label, the scrolling region shows the ATS terminations in the order  
in which calls are routed to them. The Choices (...) button displays a Choices dialog  
box that lets you display and filter a list of all ATS terminations for the Service View.  
You can select multiple terminations from this dialog box to add to the ATS label. For  
instructions on using the Choices dialog box, see the section “Choices Button” in  
Chapter 2, “Using Route It! with Windows.”  
To get additional detail on one or more terminations, select each termination and  
choose Term Info.  
To close a read-only ATS Label Builder, choose Close. 

 
Creating or Changing an ATS Label  

When you work with the ATS Label Builder, you can specify a termination with either  
the termination name or the access line.  
To create or change the contents of the ATS label, complete one or more of the steps  
in Table 5-4. To save the ATS label, choose OK. To close the ATS Label Builder  
without making any changes, choose Cancel. 
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Label Builders 

 
Table 5-4. Creating or Changing an ATS Label 

 
To... 

 
Do This 

 
Add one or more  
terminations 

 
Select one or more terminations from the Choices dialog  
box and choose Add. (See “Choices Button” in Chapter  
2, “Using Route It! with Windows,” for details.)  
Each termination is added to the bottom of the scrolling  
list.  
Or  
With the insertion point in the text box, type a termination  
name or access line and choose Add.  
The termination is added to the bottom of the scrolling  
list.  

Move one or more  
terminations 

 
1. Select a termination in the scrolling list.  
2. Click the up or down arrows to move a selected  

termination up or down one position at a time.  
Remove one or  
more terminations 

 
1. Select one or more terminations in the scrolling list.  
2. Choose Remove.  

The selected termination(s) are removed from the  
label.  

Get more informa-  
tion on one or more  
terminations 

 
1. Select a termination in the scrolling list.  
2. Choose Term Info.  

The Detail on Termination window appears. 
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Label Builders 

 
Caller ID Label 

 
The Caller ID node routes calls according to the telephone number of the calling party.  
A Caller ID label, located on one or more branches following the node, contains one or  
more 10-digit telephone numbers. Figure 5-4 shows the Caller ID Label Builder. 

 

Figure 5-4. Caller ID Label Builder  
For an existing Caller ID label, the scrolling region contains callers’ telephone  
numbers. To search for a telephone number, use the Search button, as described in  
Table 5-5. To close the Caller ID Label Builder, choose Cancel. To close a read-only  
Caller Id Label Builder, choose Close.  Caller ID Label Builder, choose Close  

. 
Creating or Changing a Caller ID Label 

 
To create or change the contents of the Caller ID label, complete one or more of the  
steps in Table 5-5. To save the Caller ID label, choose OK. To close the Caller ID  
Label Builder without making any changes, choose Cancel. 
 
Table 5-5. Creating or Changing Caller ID Label 

 
To... 

 
Do This 

 
Add a caller’s telephone  
number 

 
Type a telephone number in the text box and choose  
Add.  
The number is added to the list in ascending ASCII  
numerical order. In an ASCII sort, data is listed in the  
sequence described in “Sort Sequence of Listed Data,”  
earlier in this chapter.  
If you enter an area code (NPA) and exchange (NXX)  
combination that is set to move to another NPA-NXX as  
a result of an area code split, Route It! automatically  
replaces the original NPA-NXX with the new one after  
validating the field. A status message indicates that the  
replacement has been performed. See Appendix A,  
“Managing Area Code Split Updates,” for details. 

 
AT&T—PROPRIETARY  

Use pursuant to Company Instructions 
 
AT&T Route It! 

 
    5-11 



  

 
Chapter 5  Labels  
Label Builders 

 
Table 5-5. Creating or Changing Caller ID Label (Cont’d) 

 
To... 

 
Do This 

 
Remove one or more  
telephone numbers 

 
1. Select a telephone number in the list.  
2. Choose Remove.  

The selected number is removed from the label.  
Search for a telephone  
number 

 
Type a telephone number in the text box and choose  
Search.  
The number is highlighted in the list. The contents of the  
list are in ASCII ascending numerical order for these  
labels:  
� 

 
Caller ID (all same length)  

� 
 
Dialed #  

� 
 
Call Prompter  

In an ASCII sort, data is listed in the sequence described  
in “Sort Sequence of Listed Data,” earlier in this chapter.  
If you enter an area code (NPA) and exchange (NXX)  
combination that is set to move to another NPA-NXX as  
a result of an area code split, Route It! automatically  
replaces the original NPA-NXX with the new one after  
validating the field. A status message indicates that the  
replacement has been performed. See Appendix A,  
“Managing Area Code Split Updates,” for details. 
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Table 5-5. Creating or Changing Caller ID Label (Cont’d) 

 
To... 

 
Do This 

  
Import a file containing  
Caller IDs:  
� 

 
The file must be a  
text file.  

� 
 
The file should  
contain one  
telephone number  
per line.  

� 
 
Dashes in the  
telephone numbers  
are optional.  

1. Choose Import.  
The Open dialog box appears.  

2. Navigate to the file you want to import and select it.  
3. Choose OK.  

If any errors are encountered during the transfer, a  
notice will appear. This includes files having at least  
one NPA-NXX combination that is set to move to  
another NPA-NXX as a result of an area code split.  
(Route It! automatically replaces the original  
NPA-NXX with the new one after validating the field.  
A status message indicates that the replacement  
has been performed.) See Appendix A, “Managing  
Area Code Split Updates,” for details.  
To continue the file transfer (excluding the erroneous  
Caller IDs), choose Yes. To halt the file transfer,  
importing all Caller IDs up to this point, choose No.  
The data is listed in ASCII sequence as described in  
“Sort Sequence of Listed Data,” earlier in this  
chapter. 
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Label Builders 

 
Data Rate Label 

 
NOTE :  
Currently, this label is not supported by AT&T Canada Long Distance Services.  

A Data Rate node routes nonvoice calls, based on data rate, to terminations that have  
Toll-Free Multimedia. To group multiple data rates on one branch following a Data  
Rate node, you must create a label. You cannot list multiple data rate values  
individually on a Data Rate branch. Figure 5-5 shows the Data Rate Label Builder. 

 

Figure 5-5. Data Rate Label Builder  
For an existing Data Rate label, the scrolling region shows one or more data rates.  
The drop-down list contains valid data rates. To close a read-only Data Rate Label  
Builder, choose Close. 

 
Creating or Changing a Data Rate Label 

 
To create or change the contents of a Data Rate label, complete one or more of the  
steps in Table 5-6. To save the Data Rate label, choose OK. To close the Data Rate  
Label Builder without making any changes, choose Cancel. 
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Label Builders 

 
Table 5-6. Creating or Changing a Data Rate Label 

 
To... 

 
Do This 

 
Add one or more data rates 

 
Select a data rate from the drop-down list and  
choose Add.  
The data rate is added to the list.  
Or  
1. With the insertion point in the text field, type a  

data rate. You can enter data rate values using  
the following abbreviations:  
�  
�  
�  
� 

 
56, for 56Kbps  
64c, for 64Kbps clear  
384c, for 384Kbps clear  
1536c, for 1536Kbps clear  

2. Choose Add.  
The data rate is added to the list and is sorted in  
ASCII ascending numerical order. See “Sort  
Sequence of Listed Data,” earlier in this chapter.  

Remove one or more data  
rates 

 
Select one or more data rates in the list and choose  
Remove.  
The selected data rate(s) are removed from the  
label. 
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Dialed # Label 

 
The Dialed # node routes calls based on the number dialed by the caller. The branch  
label for this node contains dialed numbers or dialed number names, including the  
names of any international numbers. Figure 5-6 shows the Dialed # Label Builder. 

 

Figure 5-6. Dialed # Label Builder  
For an existing label, the scrolling region shows the dialed numbers or dialed number  
names contained in the label. The Label Builder displays either dialed numbers or  
names, depending on the setting of the Names or IDs command. (For more  
information on this command, see the section “Displaying Names or IDs” in Chapter 4,  
“Creating or Editing a Plan.”) 
 

  NOTE :  
         When displayed from the Common Info, EDIT TRNT window, the Title Bar  
          Displays  “TRNT Dialed # Label: XXXXXXXXXXXXXXXX”; and there is no 
         IMPORT button 

 
To close a read-only Dialed # Label Builder, choose Close.  
The Choices (...) button displays a Choices dialog box that lets you display and filter a  
list of dialed numbers or names for the Dialed # label. You can select multiple dialed  
numbers from this dialog box to add to the Dialed # label. For instructions on using the  
Choices dialog box, see the section “Choices Button” in Chapter 2, “Using Route It!  
with Windows.”  
To get additional detail on a dialed number, select the dialed number and choose  
Dialed # Info 

 
. 

 
Creating or Changing a Dialed # Label 

 
To create or change the contents of the Dialed # label, complete one or more of the  
steps in Table 5-7. To save the Dialed # label, choose OK. To close the Dialed #  
Label Builder without making any changes, choose Cancel. 
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Table 5-7. Creating or Changing a Dialed # Label 

 
To... 

 
Do This 

 
Add one or more dialed num-  
bers 

 
Select one or more dialed numbers from the Choices  
dialog box and choose OK. See “Choices Button” in  
Chapter 2, “Using Route It! with Windows,” for  
details.  
Each dialed number is added to the list in ascending  
ASCII order as described in “Sort Sequence of Listed  
Data,” earlier in this chapter.  
Or  
With the insertion point in the text field, type the  
dialed number or dialed number name(s) and choose  
Add.  

NOTE:  
To include an international dialed number in the  
label, you must type the dialed number name  
and not the dialed number. The dialed number  
you enter cannot be an 11-digit Universal  
International Freephone Numbering (UIFN)  
dialed number.  

Each dialed number or name is added to the list in  
ascending ASCII order as described in “Sort  
Sequence of Listed Data,” earlier in this chapter.  

Remove one or more dialed  
numbers 

 
1. Select one or more dialed numbers in the list.  
2. Choose Remove.  

The dialed number(s) are removed from the  
label. 
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Table 5-7. Creating or Changing a Dialed # Label (Cont’d) 

 
To... 

 
Do This 

 
Import a file containing dialed  
numbers:  
� 

 
The file must be a text  
file.  

� 
 
The file should contain  
one dialed number or  
one dialed number name  
per line.  

� 
 
Dashes in dialed  
numbers included in the  
file are optional.  

� 
 
International dialed  
numbers must appear as  
dialed number names in  
the file. 

 
1. Choose Import.  

The File Open dialog box appears.  
2. Navigate to the file you want to import and  

select it.  
3. Choose OK.  

If any errors are encountered during the transfer,  
a notice will appear. To continue the file transfer  
(excluding the erroneous dialed numbers),  
choose Yes. To halt the file transfer, importing all  
dialed numbers up to this point, choose No.  
The dialed number or name is added to the list in  
ascending ASCII order as described in “Sort  
Sequence of Listed Data,” earlier in this chapter.  

 
� 

 
The file cannot contain  
an 11-digit UIFN dialed  
number.  

Get more information on one  
or more dialed numbers 

 
1. Select a dialed number in the list.  
2. Choose Dialed # Info.  

The Detail on Dialed Number window appears. 
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Exchange Label 

 
The Exchange node routes calls based on the area code and exchange (NPA-NXX) of  
the originating telephone numbers. The branch label for an Exchange node contains  
one or more area code/exchanges. Exchange labels can contain exchanges for more  
than one area code. Figure 5-7 shows the Exchange Label Builder. 

 

Figure 5-7. Exchange Label Builder  
For an existing Exchange label, the scrolling region of the Exchange Label Builder  
shows the exchanges for the area code displayed in the Area Code drop-down list.  
This drop-down list shows the area codes of the exchanges contained in the label.  
In the scrolling region of the Exchange Label Builder, exchanges included in the label  
appear as white text on a blue background; all other exchanges appear as black text  
on a white background.  
To display the exchanges in the label by area code, select an area code on the  
Exchange Label Builder from Area Code and choose Display Exchanges. The  
scrolling region displays exchanges for the selected area code. 
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Creating or Changing an Exchange Label  

To create or change the contents of an Exchange label, follow these steps:  
1. On the Exchange Label Builder, type an area code in the Area Code box, or  

select one from the drop-down list, and choose Display Exchanges.  
The exchanges for the area code selected are displayed in the scrolling region.  

NOTE :  
The Area Code drop-down list contains area codes for exchanges already  
included in the label. If you are creating a new label, you need to type an area  
code here before selecting exchanges for the label. If the area code has no  
exchanges, a message is displayed stating that no exchanges for that area  
code exist.  

2. Make exchange selections as described in Table 5-8. 
 
Table 5-8. Creating or Changing an Exchange Label 
 
To Select or Deselect... 

 
Do This 

 
Individual exchanges 

 
Click on each exchange. Use the scroll bar to display addi-  
tional exchanges.  
Or  
1. Choose Edit to bring up the Edit dialog box.  
2. Choose Select Exchange or Deselect Exchange.  
3. Type an exchange in the text box.  
4. Choose Apply.  
5. Repeat until all desired exchanges have been entered.  
6. Choose OK.  

All exchanges 
 
Select ALL under Exchanges for Area Code [area code].  

One exchange 
 
Select the desired exchange under Exchanges for Area  
Code [area code].  
Or  
1. Choose Edit to bring up the Edit dialog box.  
2. Choose Select Exchange or Deselect Exchange.  
3. Type an exchange in the text box.  
4. Choose Apply.  
5. Choose OK. 

 
Selected exchanges appear as white text on a blue background; exchanges that are  
not selected appear as black text on a white background. Choosing an exchange  
switches it between the two selection states.  

NOTE :  
When an area code (NPA) split is in progress, the exchange displayed in the list  
depends on the type of split that is set to occur, as shown in Table 5-9. 
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Table 5-9. Exchange Display 

 
If the Area Code Split Will Move... 

 
Then This Exchange (NXX) Is  

Displayed... 
 
An NXX to a new NPA 

 
In the new NPA.  

An NXX to a new NXX within the same NPA 
 
With the new NXX.  

An NPA-NXX pair to a newly created NPA-  
NXX combination 

 
With the new NXX in the new  
NPA. 

 
To select exchanges from different area codes, repeat Steps 1 and 2 in Table 5-8.  
All exchange selections for an area code are saved for the current session.  
To save the exchange selections for this label, choose OK, unless you also wish to  
import them as described below.  
A message in the status bar of the Edit Plans main window confirms that the label and  
its contents are saved.  
You may want to import a file containing the NPA-NXX (area code and exchange)  
combinations within the Exchange label. The file containing valid combinations:  
� 

 
must be a text file  

� 
 
must be in the correct format, that is,  
— An NPA must be the first three characters on the line and must be followed by  

a colon (:) and a valid NXX if the list of exchanges for that NPA contains  
multiple lines.  

— Multiple NXXs must be listed after the first NPA:NXX combination, but must  
be separated by commas.  

Spaces cannot be used after colons or commas.  
NOTE :  
To indicate that all NXXs for an NPA are to be contained in the Exchange  
label, you may enter the word all (in uppercase or lowercase) after the NPA:.  

To import a text file, follow these steps:  
1. From the Exchange Label window, choose Import.  

The Open dialog box appears.  
2. Navigate to the file you want to import and select it.  
3. Choose OK.  

If any errors are encountered during the transfer, a notice will appear. To continue  
the file transfer (excluding the erroneous NPA-NXX[s]), choose Yes (see

 
NOTE  

below). To halt the file transfer, importing all NPA-NXXs up to this point, choose  
No. 
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NOTE :  
If you entered an NXX that is set to move to a different NXX within the same  
NPA as the result of an area code split, Route It! automatically changes your  
entry to the new NXX. 

 
Removing Area Code/Exchanges from an Exchange Label  

An area code and the associated exchange(s) can be removed using the Remove  
button. To Remove an area code and the associated exchange(s), follow these steps:  
1. Select an area code from the drop-down list.  

The area code MUST be highlighted. The Remove button is dimmed until an item  
in the area code drop-down list is selected.  

2. Select the desired exchanges (ALL will override current selections).  
3. Choose Remove.  

A confirmation message is displayed indicating the area code will be removed  
from the label and confirming the removal.  
— Yes - The selected exchanges are deselected and the area code is removed  

from the drop-down list.  
— No - The Exchange Label window is displayed with the cursor in the Area  

Code field. 

 

AT&T—PROPRIETARY  
Use pursuant to Company Instructions 

 
5-22           AT&T Route It! 



  

 
Chapter 5  Labels  
Label Builders 

 
Prompter Label 

 
The Prompter node prompts a caller with a recorded announcement to enter one or  
more digits corresponding to desired destinations. It then routes the call according to  
the received digits. The label for this node contains the digits that are used to route  
calls. Figure 5-8 shows the Prompter Label Builder. 

 

Figure 5-8. Prompter Label Builder  
For an existing Prompter label, the scrolling list contains one or more sets of digits. To  
close a read-only Prompter Label Builder, choose Close. 

 
     NOTE : 
 When displayed from the Common Info, Edit TRNT window: the Title Bar displays 
  “TRNT Prompter Label: XXXXXXXXXXXXXXXX”; and the IMPORT and Keypad  
 buttons are not on the window 

 
Creating or Changing a Prompter Label  

To create or change the contents of the Prompter label, complete one or more of the  
steps in Table 5-10. To save the Prompter label, choose OK. To close the Prompter  
Label Builder without making any changes, choose Cancel.  

NOTE :  
Each set of digits can be up to 30 characters in length (including the digits 0 to 9  
and the symbols * and #). All sets must be the same length. 
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Table 5-10. Creating or Changing a Prompter Label 

 
To... 

 
Do This 

 
Add prompter digits 

 
Type the digits in the text box and choose Add.  
The digits are added to the list in ASCII ascending  
numerical order, and the text on the keypad is  
cleared.  
Or  
1. Choose Keypad.  

The Prompter Digits keypad appears.  
2. Select digits, *, or # from the keypad and choose  

Add.  
The digits are added to the list in ascending  
numerical order.  
Or  
To close the keypad without entering any digits,  
choose Close.  

Remove prompter digits 
 
Select one or more sets of digits from the scrolling list  
and choose Remove.  
The set(s) of digits are removed from the label. 
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Termination Label 

 
The Term node represents a non-ATS termination. Its node specific data field can  
contain a label consisting of either a non-ATS termination name or an access line.  
Figure 5-9 shows the Termination Label Builder. 

 

Figure 5-9. Termination Label Builder  
For an existing Termination label, the Termination box contains a non-ATS  
termination name or access line.  
The Choices (...) button displays a Choices dialog box that lets you display and filter a  
list of all non-ATS terminations for the Service View. You can select terminations from  
this dialog box to add to the Termination label. For instructions on using the Choices  
dialog box, see the section “Choices Button” in Chapter 2, “Using Route It! with  
Windows.”  
The Label Builder also shows this information about the termination: 

 
Svc Assurance 

 
Indicates whether Service Assurance is in effect for the termination  
and, if so, whether it is Customized (Customized) or Pre-Planned  
(Pre-Planned) Service Assurance.  
For more information on Service Assurance, see the section “Dis-  
playing Customer Profile Data” in Chapter 2, “Customer Profile,” of  
the AT&T Route It! Administration guide.  

Access Line 
 
The unique access line for the termination.  

Term Routing # 
 
The termination routing number associated with the termination.  

# of Lines 
 
The number of physical lines assigned to an access line. 
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Location 

 
The name assigned to the location of one or more terminations.  

Home NPA 
 
The Numbering Plan Area of the location.  

Redirect 
 
Indicates whether the termination is associated with the Redirect  
feature. This field contains one of the following entries:  
� 

 
PACR*—You subscribe to Post Answer Call Redirection,  
which uses the AT&T network to redirect calls after they have  
been answered.  

� 
 
RCP*—You subscribe to Recurrent Call Prompter, which lets  
callers return to an automated routing system after finishing  
their business with one agent to conduct additional business  
with another agent.  

� 
 
BOTH—You subscribe to both Post Answer Call Redirection  
and Recurrent Call Prompter.  

� 
 
NONE—You do not subscribe to the Redirect feature.  

*Currently not supported by AT&T Canada Long Distance Ser-  
vices.  
For more information on the Redirect feature, see the sections  
“AT&T Advanced Features (United States)” and “AT&T Advanced  
Features (Canada)” in Chapter 1, “Overview.”  

CINFO 
 
Indicates whether you subscribe to Caller Information Forwarding  
for this termination.  
For more information on the CINFO feature, see the sections  
“AT&T Advanced Features (United States)” and “AT&T Advanced  
Features (Canada)” in Chapter 1, “Overview.”  

Service Type[s] 
 
The types of AT&T Toll-Free Services purchased for this  
termination.  
For more information on Toll-Free Calling Services, see the sec-  
tions “AT&T Toll-Free Calling Services (United States)” and “AT&T  
Toll-Free Calling Services (Canada)” in Chapter 1, “Overview.” 

 
To close a read-only Termination label, choose Close. 

 
Creating or Changing a Termination Label 

 
To create or change the contents of a Termination label, do the following:  
1. Type or select a non-ATS termination name or access line in the Terminations  

box, or choose one from the Choices dialog box.  
2. To save changes, choose OK.  

Or  
To close the Termination Label Builder without making any changes, choose  
Cancel. 
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Displaying or Modifying Label Contents 
 
You can display the contents of labels used in either local or official plans. You can  
then modify the contents if the label is contained in a currently open official plan or any  
local plan (open or unopened). If the label is not used in a local plan or a currently  
open official plan, the label detail is read-only.  
There are two ways to select a label to display in Edit Plans. You can:  
� 

 
Click on a label displayed in a plan and then choose Display Detail from the Edit  
menu.  

� 
 
Choose Label Summary from the Labels menu. From the Label Summary dialog  
box, shown in Figure 5-10, select a label from a list of labels, which can be filtered  
to narrow or broaden your choices. Then choose Display Detail.  

After you choose Display Detail, the Label Builder dialog box appears. The Label  
Builder shows the contents of the label. For an Area Code label, a graphical Map or  
Textual Display window shows the label’s contents instead of a Label Builder.  

NOTE :  
If a plan has been opened in Quick Call Allocator mode, the label detail is read-  
only.  

To view or change the contents of a label displayed in a plan, do the following:  
1. In the Edit Plans window, display the node or branch containing the label.  
2. Click on the label to select it.  

The field turns yellow.  
3. From the Edit menu, choose Display Detail.  

The Label Builder or map displays the contents of the label.  
4. To modify the label, or for more information on the fields in the Label Builder  

dialog box, see the section “Label Builders,” earlier in this chapter.  
To display a label using Label Summary, do the following:  
1. From the Labels menu, choose Label Summary.  

The Label Summary dialog box appears, as shown in Figure 5-10. 
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Figure 5-10. Label Summary Dialog Box 
 
2. Under Show Labels, select one of the following: 

 
For Current Plan 

 
Includes labels for the plan currently displayed in the active  
window.  

For Plan 
 
Select a plan from the Choices dialog box, which appears  
after you use the Choices (...) button.  

For All Plans 
 
Includes labels contained in all plans for the current Account  
ID, regardless of Service Date. 

 
3. To filter the list further, under Filter By, select one or more of the following: 

 
Label 

 
Type a label name (up to 16 characters, beginning with a  
letter). You can use an asterisk (*) as a wild-card character  
to filter labels. Type at least one character (a to z, 0 to 9) fol-  
lowed by an asterisk. For example, wes* would find label  
names west1 and western. You cannot place the asterisk at  
the beginning or in the middle of an entry.  

Node Type 
 
Select a node type for the labels you want to display.  

Status 
 
To display labels that are currently being used in plans,  
select Used. To display labels that are not being used in  
plans, select Unused. Unused labels are those that were  
deleted from a plan. However, unused labels are still associ-  
ated with the plan from which they were deleted. 

 
4. To display a list of labels based on selections you have made, choose Apply.  

The scrolling area displays one or more labels. 
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5. To see more detail about a label listed in the scrolling area, select the label and  

then choose Display Detail.  
The Label Builder dialog box or area code map for the label appears.  

NOTE :  
Labels contained in a plan that is open and in the active window are editable.  
Otherwise, the Label Builder dialog box or area code map is read-only.  

6. To modify the label, or for more information on the fields in the Label Builder  
dialog box, see the section “Label Builders,” earlier in this chapter. 

 
Copying and Renaming Labels 

 
You can copy labels used in local plans and reuse their contents without re-creating  
them. There are two ways to copy a label. You can:  
�  
� 

 
Make a copy of a label within a currently opened local plan.  
Make a copy of one or more labels and copy them to a different local plan.  

You can also rename a label within a currently opened local plan.  
NOTE :  
You cannot copy or rename labels used in official plans.  

The following sections describe how to copy or rename a label. 
 
Copying a Label Within a Plan 

 
To copy a label within a plan, follow these steps:  
1. Open a local plan in an active Edit Plans window.  
2. From the Labels menu, choose Copy.  

The Copy a Label dialog box appears. The Plan field shows the name of the  
currently opened plan.  

3. Complete the fields as explained in Table 5-11. 
 
Table 5-11. Fields for Copying a Label 

 
Field 

 
Description 

 
From 

 
Node Type 

 
Select a node type for the label you want to copy.  

Label  
Name 

 
Type or select the name of a label in the currently  
opened plan that you want to copy.  

To 
 
Label  
Name 

 
Type a different name for the new label.  
A label can be up to 16 characters long and can  
contain letters, the digits 0 to 9, and the symbols  
# $ . , % & _ - + ’ . The first character of a label  
must be a letter. 
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4. To copy the label, choose OK.  

The label is copied and saved. A status bar message confirms the copy. 
 
Copying a Label to a Different Plan 

 
You can make a copy of one or more labels and copy them to a different plan. To copy  
a label to a different plan, follow these steps:  
1. From the Labels menu, choose Label Summary.  

The Label Summary dialog box appears.  
2. Display labels in the scrolling region of the Label Summary dialog box. For more  

information, see the section “Displaying or Modifying Label Contents,” earlier in  
this chapter.  

3. From the scrolling list, select one or more labels that you want to copy.  
The selected labels are highlighted.  

4. Choose Copy.  
The Copy dialog box appears. The Copy To Local Plan drop-down list contains  
all local plans for the current Service View.  

5. From the Copy To Local Plan drop-down list, select the plan name to which you  
want to copy labels.  

6. Choose OK.  
The selected labels are copied to the plan specified. A status bar message  
confirms the copy.  
Or  
To close the Copy dialog box without copying labels, choose Cancel. 

 
Renaming a Label 

 
To rename a label within a local plan, follow these steps:  
1. Open a local or official plan in an active Edit Plans window.  
2. From the Labels menu, choose Rename.  

The Rename a Label dialog box appears. The Plan field shows the name of the  
currently opened plan.  

3. Complete the fields as explained in Table 5-12. 
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Table 5-12. Fields for Renaming a Label 

 
Field 

 
Description 

 
Fro 
m 

 
Node Type  
Label  
Name 

 
Select a node type for the label you want to rename.  
Type or select the name of a label that you want to  
rename.  

To 
 
Label  
Name 

 
Type a new name for the label.  
A label name can be up to 16 characters long and  
can contain letters, the digits 0 to 9, and the symbols  
# $ . , % & _ - + ’ . The first character of a label must  
be a letter. 

 
4. To rename the label, choose OK.  

The label is renamed and saved, as indicated by a status bar message. 

 
Deleting a Label 

 
You can delete one or more labels when you no longer need them. Only labels  
contained in open or unopen local plans or in open official plans can be deleted.  
To delete labels, follow these steps:  
1. From the Labels menu, choose Label Summary.  

The Label Summary dialog box appears.  
2. Display labels in the scrolling region of the Label Summary dialog box. For more  

information, see the section “Displaying or Modifying Label Contents,” earlier in  
this chapter.  

3. Select one or more labels from the scrolling list to highlight them.  
4. Choose Delete.  
5. To delete the selected labels, choose Yes at the confirmation dialog box.  

Or  
To return to the Label Summary dialog box without deleting labels, choose No at  
the confirmation dialog box.  

6. Before sending a plan to the support system, replace any node or branch fields  
that contain deleted labels with either valid values or existing labels.  
NOTE :  
Deleting a label from one plan does not affect the same label used in a different  
plan. 
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Label Conflict Notice 

 
The Label Conflict dialog box (Figure 5-11) shows the number of conflicting labels  
found. This dialog box presents the following information:  

� 
 
Current Plan name - plan user is working with  

� 
 
Source Plan name - plan from which the contents of the clipboard came  

� 
 
Allows you to select the label definition of the plan you want to use, Current  
or Source.  
When Current is selected, the following takes place:  
� 

 
Contents of the label in the current plan are pasted.  
� 

 
Label is removed fro the list on the label notice dialog box.  

When Source is selected, the following takes place:  
� 

 
Contents of the label in the source plan are pasted.  
� 

 
Contents of the label in the current plan are replaced with the contents of  
the clipboard.  
� 

 
Label is removed from the list on the label notice dialog box. A warning is  
displayed that the current label will be replaced. Choose YES to continue  
the paste, or NO to cancel the paste action.  

� 
 
Label and Node Type of pasted label(s) that are the same as those already  
defined in the Current plan but the contents are different. This information is  
presented in a scrolling list. You can only select one label at a time.  

Buttons on the dialog box include:  
� 

 
Select All - All items in the scrolling list are highlighted (selected).  

� 
 
Rename - allows user to rename label. The “From” field includes the Node  
type and the label name. The “To” field allows you to enter the new name.  
You can only rename one label at a time. The label is renamed in the  
clipboard, then the label is removed from the list.  

� 
 
Cancel - The paste is cancelled and the Edit Plans Label Conflict Notice is  
dismissed.  

� 
 
Help - provides online help for the window. 
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Figure 5-11. Label Conflict Notice Window 

 
Exporting Label Information 

 
You can export label information for one or more selected labels to a text file. To  
select the labels to export you first display them in the Label summary dialog box. To  
export labels, follow these steps:  
1. From the Labels menu, choose Label Summary. The Label Summary dialog box  

appears.  
2. Display labels in the scrolling region of the Label Summary dialog box. For more  

information, see the section “Displaying or Modifying Label Contents”, earlier in  
this chapter.  

3. Choose Export.  
4. The Save As dialog box appears.  
5. Select the directory where you want to save the file and enter the name of the file  

you are sending the label information to. The file should have .csv extension, it  
will be appended if you do not enter it. Choose Save.  

6. The following information is sent to the text file: account ID, service date, plan  
name, label, node type, status and contents of the label.  

7. When exporting Announcement data for one or more announcements in a single  
export action, the file will contain the Announcement Number, Announcement  
Name, duration, text type, speech, announcement text, announcement set and  
Remarks. 
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Printing the Label List 
 
You can print a list of selected labels and their contents. To select the labels to print,  
you first display them in the Label Summary dialog box.  
1. From the Labels menu, choose Label Summary.  

The Label Summary dialog box appears.  
2. Display labels in the scrolling region of the Label Summary dialog box. For more  

information, see the section “Displaying or Modifying Label Contents,” earlier in  
this chapter.  

3. Select the labels to print in the scrolling region of the Label Summary dialog box.  
4. Choose Print.  

Each label listed in the scrolling list and its contents are printed, as shown in  
Figure 5-12. 

 
Acct: 999-000-5422 

 
Route It! 

 
Page: 1  

Print Date: 4/15/98  
User: lynn 

 
800 Labels Listed 

 
Print Time: 1:35pm  

ALPHA (Area Code - Local Plan: MAINPLAN)  
204, 306, 403, 416, 418, 506, 514, 519, 604, 613, 705, 709, 807, 819, 901, 902, 903, 904,  
905 

 
ANY 

 
(Caller ID - Global)  

908-805-1234, 908-805-2345, 908-805-3456, 908-805-4567, 908-805-5678  
AREA_LAB1 

 
(Area Code - Local Plan: MAINPLAN)  

201, 202, 203, 204, 205, 206, 207, 208, 209, 210, 211, 212, 213, 214, 215, 216, 217, 218,  
219, 220, 221, 222, 223, 224, 225, 226, 227, 228, 229, 230, 231, 232, 233, 234, 235, 236,  
237, 238, 239, 240  

ATSGLLABEL 
 
(ATS - Local Plan: MAINPLAN)  

Term-1, D0004, D0005, TERM-15  
EXC_LAB1 

 
(Exchange - Local Plan: MAINPLAN)  

201  
231, 232, 233, 234, 235, 236, 237, 238, 239, 240, 241, 242, 243, 244, 245, 246, 247  

609  
261, 262, 263, 264, 265, 267, 268, 269, 270, 271, 272, 273, 274, 275, 276, 278, 279, 280,  
281, 282, 283, 284, 285, 286, 287, 288, 289  

908  
307. 308. 309. 310, 311, 312, 313, 314, 315, 316, 317, 318, 319, 320, 321, 322, 323, 324,  
325, 326, 327, 328  

LAB1 (Dialed # - Local Plan: MAINPLAN)  
800-805-9876, PROMO  

MORE 
 
(Prompter - Global)  

12345, 21234, 23478, 34567, 78906 

 
Figure 5-12. Label List Printout 
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The Textual Display and Map Windows 
 
With the Textual Display and Map windows, you can display the contents of an Area  
Code label. If the label is contained in a currently open official plan or any local plan  
(open or unopened), you can also create or modify its contents.  
The Textual Display window, shown in Figure 5-13, contains three tabs. The U.S. tab  
lists area codes for the United States; the Canada tab lists area codes for provinces;  
and the International tab lists country codes. 
 

NOTE: 
 This figure shows the Termination Service Area window in its editable  
 state. The leftmost button is SEND and the EDIT button is undimmed. 

 
When accessed via the DISPLAY LABEL button (on the TRNT Summary for  
Termination window), this window is read only and the title bar reads: “TRNT Call  
Origin Label: X”, where X is the label name. Since it is read-only, the leftmost  
button will be CLOSE and the CANCEL and EDIT buttons will be dimmed. 
 
When accessed via the Edit TRNT window, the leftmost button is OK and 

 
the  

title bar reads: “TRNT Call Origin Label: X”, where X is the label name. 
 
. 

 
NOTE 1:  
For an example of the Canada tab, see Chapter 2, “Customer Profile,” of the  
AT&T Route It! Administration guide.  
NOTE 2:  
Country codes are not applicable in Canada. 

 

Figure 5-13. Textual Display Window 
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You can select or deselect area codes (or country codes) to include or exclude them  
in an Area Code label. As you make selections, the area codes change color to  
indicate their inclusion in a label.  
You can access the Map window from the U.S. or Canada tab of the Textual Display  
window.  
The Map window, shown in Figure 5-14, shows area code selections on a map of the  
United States and Canada. Each state or province is color-coded to indicate  
selections. 

 

Figure 5-14. Map Window  
You can select area codes from either the Map window or the Textual Display window.  
Both windows update automatically, and each identically reflects the selections made  
on the other.  
You can display, but not modify, the Textual Display and Map windows for an Area  
Code label if it has been opened in Quick Call Allocator mode. 

 
Using the Textual Display and Map Windows 

 
As you work with the Textual Display and Map windows, keep in mind the following:  
� 

 
Switching among the U.S., Canada, and International tabs does not change  
selections made on any of the tabs.  

� 
 
Choosing OK saves data on all three tabs, regardless of which tab appears.  

� 
 
To display the meaning of specific colors, choose Color Key on the Textual  
Display window, or choose Color Key from the Options menu on the Map 
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window.  

� 
 
To close a read-only Textual Display window, choose Close. If the window is  
editable, choose Cancel. 

 
Using the Textual Display Window 

 
On the Textual Display window, you can select and deselect area codes individually,  
or you can select many at one time. For example, if you select a state name on the  
Textual Display window, all individual area codes for that state change color to  
indicate that they are selected. You can also select all area or country codes on a tab  
at one time by selecting the ALL box.  
Use your left and right mouse buttons to perform these tasks:  
� 

 
Clicking an area, state, province, or country code box using the left mouse button  
alternates (toggles) its status between selected and deselected.  

� 
 
Clicking a state, province, or area code box using the right mouse button or  
selecting Status brings up the Selection Status dialog box, which displays read-  
only data for a selected state, province, or area code. For more information about  
the Selection Status dialog box, see the section “Displaying Area Code Selections  
for a State or Province,” later in this chapter.  

To make area and country code selections, follow these steps at the Textual Display  
window:  
1. Choose the tab (U.S., Canada, or International) on which you want to make  

selections.  
NOTE :  
When a selected termination has an I800 Inbound stand-alone or Optional  
Access Service type, the U.S. tab is read-only.  

2. To select area or county codes, do one or more of the following, as described in  
Table 5-13. 
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Table 5-13. Using the Textual Display Window 

 
Using the Mouse 

 
Using the Edit Button 

  
To change the selection status of an  
area or country code, click it with the  
left mouse button.  
To change the selection status of all  
area codes within a state or province,  
click the state or province box with  
the left mouse button.  
To toggle the status of all area codes  
for the United States or Canada,  
select ALL.  

To use the Edit dialog box to make selec-  
tions, do the following:  
1. Choose Edit to bring up the Edit dialog  

box.  
2. Choose Select Code or Deselect Code  

to include area or country codes.  
3. To specify area or country codes, type  

one of the following in the text box:  
�

 
an area or country code  

�
 
a state, province, or country  
abbreviation  

�
 
US, USA, or ALL, for all states  

�
 
CAN, for all provinces  

�
 
ALL, for all countries  

4. Choose Apply to save the selections  
and then choose Close. 

 
NOTE :  
If you select a Canadian entry on the U.S. tab, the Canada tab is updated  
with your selection. If you select a U.S. entry on the Canada tab, the U.S. tab  
is updated with your selection.  

3. To see selections displayed on a map of the United States and Canada, choose  
Show Map.  

NOTE :  
If the Edit window is open, the Map window cannot be opened. If the Edit  
window is opened after the Map window, the Map window will update  
dynamically with the Edit window.  

The Map window appears. For instructions on using the Map window, see the  
next section, “Using the Map Window.”  
To save area or country code selections on any tab, choose OK.  
Or  
To close the Textual Display window without saving any changes, choose  
Cancel. 

 
Using the Map Window  

Display the Map window to view and change area code selections on a map showing  
the United States and Canada. On the Map window, you can click a state or province  
using the left mouse button to alternate (toggle) its status between selected and  
deselected. 
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You can also click a state or province using the right mouse button or choose Status  
to bring up the Selection Status dialog box to view all area codes for a selected state  
or province. For more information about the Selection Status dialog box, see the  
section “Displaying Area Code Selections for a State or Province,” later in this chapter.  
To make selections on the Map window, follow these steps:  
1. On the Textual Display window, choose either the U.S. or the Canada tab.  
2. Choose Show Map.  

The Map window appears, as previously shown in Figure 5-14.  
3. To select or deselect area codes or country codes for a state or province, follow  

the procedures previously described in Table 5-13.  
NOTE :  
You can open the Map window and then open the Edit dialog box. However,  
you cannot open the Map window if you have opened the Edit dialog box first.  
If the Edit window is opened after the Map window, the Map window will  
update dynamically with the Edit window.  

The color of the state or province changes to reflect its status.  
4. To display a color key at any time, from the Options menu, choose Color Key.  
5. To close the Map window, either choose Close from the File menu, or choose  

Hide Map on the Textual Display window.  
6. You are returned to the Textual Display window.  

To save area or country code selections on the map and on any tab, choose OK.  
Or  
To close the Textual Display window without saving any changes, choose  
Cancel. 

 
Customizing the Map Window 

 
Use the Options menu on the Map window to customize the way the map appears.  
Choose commands on the Options menu to display or hide state or province  
abbreviations and time zone boundaries on the map. You can also display a color key.  
To customize the way the Map window appears, do any of the following, as described  
in Table 5-14. 

 
Table 5-14. Customizing the Map Window 

 
To Display... 

 
From the Options Menu, Choose... 

 
The color key 

 
Color Key  
To close the color key, choose Close on the Color Key  
dialog box. 
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Table 5-14. Customizing the Map Window (Cont’d) 

 
To Display... 

 
From the Options Menu, Choose... 

 
State and province  
abbreviations 

 
State Names  
When state names are displayed, each state and prov-  
ince is labeled with its two-letter abbreviation. The abbre-  
viations are alternately displayed or removed each time  
you choose State Names.  

Time zone boundaries 
 
Time Zones  
When time zone markers are displayed, lines show time  
zone boundaries on the map. The time zone markers are  
alternately displayed or removed each time you choose  
Time Zones. 

 
On the Options menu, a check mark appears next to any items that are selected. 

 
Displaying Area Code Selections for a State or Province  

The Selection Status dialog box shows the area codes and their selection status for a  
single state or province. Use this dialog box as a guide for making selections for a  
state or province. Area codes displayed in the dialog box are read-only.  
There are two ways to display the Selection Status dialog box. On the U.S. or Canada  
tabs, you can either choose the Status button or click the right mouse button on a  
state or province box.  
While the Selection Status dialog box appears, you can use the right mouse button to  
select area codes on the Textual Display or the Map window. The Selection Status  
dialog box automatically reflects your area code selections.  

NOTE :  
The Selection Status dialog box is not available on the International tab.  

To display and work with area codes for a single state or province, follow these steps:  
1. Choose either the U.S. or the Canada tab.  
2. Optionally display the Map window.  
3. To display area codes for a single state or province, choose the Status button,  

type an area code or a state or province abbreviation in the text box of the blank  
Selection Status window, and choose Apply.  
Or  
Click the right mouse button on a state or province box.  
The Selection Status dialog box lists the area codes for the state or province  
selected. The selection status of each area code is also shown.  

4. To select area codes, on the Textual Display window, click the right mouse button  
on one or more area code, state, or province boxes.  
Or 
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To select area codes on the Map window, click the right mouse button on one or  
more states or provinces.  
The Selection Status dialog box updates automatically to reflect any area code  
selections made for the state or province displayed.  

NOTE :  
Changing area code selections for a state or province does not affect  
selections for Area Code labels.  

5. To close the Selection Status dialog box, choose Close.  
You are returned to the Textual Display or the Map window. 

 
Combining or Removing Area Code Labels  

Use Add/Remove to add the contents of an Area Code label to the contents of the  
label currently displayed in the Textual Display window. You can also remove the  
contents of a label from the current label, and you can add or remove successive  
labels.  
Selected area or country codes in the current label may overlap with those from the  
added label. Overlapping area or country codes are displayed with diagonal stripes.  
For each successive label added, the selected codes of the current label that match  
those of the added label are displayed as overlapping labels.  
To add or remove Area Code labels, follow these steps:  
1. Display the Textual Display window for an Area Code label.  
2. For each label to be added or removed, do the following:  

a. Choose Add/Remove.  
The Add/Remove dialog box appears.  

b. Select either Add Contents of Label or Remove Contents of Label.  
c. Select an Area Code label from the drop-down list box and choose OK.  

Area codes from the selected label are added or removed, depending on the  
action you chose.  
Or  
To close the Add/Remove dialog box without making any changes, choose  
Cancel.  

3. To save all changes from the Textual Display window, choose OK.  
Or  
To close the Textual Display window without saving any changes, choose  
Cancel. 

 
Accessing the Textual Display and Map Windows 

 
This section summarizes, by task, the different ways to access the Textual Display  
and Map windows. 
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Creating a New Area Code Label  

To create a new Area Code label, display a local or official plan in the active Edit  
Plans window and do one of the following:  
� 

 
On an Area Code branch of a local plan, type the name of a new label.  

� 
 
From the Labels menu on the Edit Plans window, choose New, choose Area  
Code from the Node Type drop-down list, and choose Create.  

For the procedures on creating a new label, see the section “Creating a New Label,”  
earlier in this chapter. 

 
Displaying an Existing Area Code Label  

To display an existing Area Code label, display a local or official plan in the active Edit  
Plans window and do one of the following:  
� 

 
Click on a label displayed in a plan and then choose Display Detail from the Edit  
menu.  

NOTE :  
When Display Detail is selected for the DOM branch of an Area Code node,  
the Textual Display window is read-only.  

� 
 
Choose Label Summary from the Labels menu. Select a label from a list of  
labels, which can be filtered to narrow or broaden your choices. Then choose  
Display Detail.  

Currently, the Northwest and Yukon territories do not appear on the map. To select  
area codes for these territories, you must select them from the Textual Display  
window.  
For the procedures on displaying an existing label, see the section “Displaying or  
Modifying Label Contents,” earlier in this chapter. 
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CRP Tables 

 

 
This chapter describes how to manage your Customer Routing Point (CRP) tables.  

NOTE :  
Currently, CRP tables are not supported by AT&T Canada. 

 
CRP Tables and Intelligent Call Processing 

 
Intelligent Call Processing (ICP) is an AT&T Advanced Feature that allows you to  
implement customized, call-by-call routing based on information in your own custom  
CRP database. When ICP is in effect, network handling of an incoming call is  
temporarily suspended while your CRP database is queried for any special routing  
instructions.  
Your CRP database contains information about your products, services, and  
customers, including routing plans. Each routing plan is made up of CRP nodes. Each  
node contains the name or ID (node specific data) of the CRP database to be queried.  
From the routing plans, your database determines the desired handling treatment for  
the call and returns appropriate handling directions to the network in the form of a  
CRP code.  
The network interprets CRP codes by looking them up in a CRP table. The CRP table  
contains the CRP codes and their corresponding call-handling treatments. Depending  
on the handling treatment associated with the code, the call is routed to either a  
termination, an announcement, a ring tone, or a busy signal. 
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Managing ICP Call Routing in AT&T Route  
It! 

 
Use AT&T Route It! to build or modify a customized CRP database for ICP access.  
This is accomplished by creating, updating, or deleting CRP tables. 

 
Characteristics of CRP Tables 

 
Each CRP table contains two lists of CRP codes and corresponding values:  
�  
� 

 
codes for terminations  
codes for announcements  
Two codes in the list of announcements can optionally point to “specialized”  
announcements. The specialized announcements are a ring tone and a busy  
signal.  

Each CRP table used as part of ICP must have at least one CRP database assigned  
to it. You can assign CRP databases to a CRP table in Route It! 

 
Basic Rules for CRP Tables 

 
Keep in mind the following rules when working with CRP tables:  
� 

 
An ICP account can have up to 15 CRP tables.  

� 
 
A CRP table can have up to 12,000 codes.  

� 
 
A CRP code can consist of 1 to 10 numerics.  

� 
 
CRP code length must match for all codes contained in the same CRP table and  
must be the same length as the codes in the associated CRP databases.  

� 
 
When the first CRP ID is assigned to a CRP table and the first CRP code is  
provisioned, the length of the CRP table is set.  

� 
 
In a CRP table, each CRP code must be unique in the list of terminations, and  
each CRP code must be unique in the list of announcements.  

� 
 
In a CRP table, more than one CRP code can point to a termination in the list of  
terminations. More than one CRP code can point to an announcement in the list of  
announcements.  

� 
 
In the list of announcements of a CRP table, one code can optionally point to a  
ring tone, and one code can optionally point to a busy signal.  

� 
 
A termination used in a CRP table must be a regular termination or an ICP-only  
termination. If you use ATS terminations in a CRP table, then each ATS  
termination in a CRP table will be treated as an independent termination. In this  
scenario, although the "call in progress" counter is incremented, the call is routed  
to that termination without comparing the MCA. If you prefer to use ATS  
functionality for an ATS termination with ICP, then that termination should be  
referenced in the Post Feature Branch of the CRP node.  

� 
 
Each CRP database can be assigned to only one CRP table at a time. 
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� 

 
A CRP table can be used by more than one CRP database at the same time.  

� 
 
The codes in a CRP table must be the same length as the codes in the CRP  
database that is assigned to the CRP table. (A CRP code length is provisioned for  
each CRP database.) 

 
Specifying Future Effective Dates for CRP Tables 

 
You can simultaneously make changes to the CRP codes in a CRP table and specify  
a future date on which the changes will go into effect. To set up changes, you use the  
Future Changes feature of the CRP Tables task. These are the changes you can  
make:  
�  
�  
� 

 
Add a CRP code.  
Change the value of an existing CRP code.  
Delete a CRP code.  

Each change is called a future change. Future changes can be made only on official  
CRP tables. For details, see the sections pertaining to the Future Changes feature,  
beginning with the section “Future Changes Feature,” later in this chapter. 

 
CRP Tables Toolbar 

 
The CRP Tables toolbar, shown in Figure 6-1, appears directly below the menu bar. 

 
New CRP  
Table 

 
New Future  
Changes  
Table 

 
Save 

 
Service  
View 

 

Open CRP  
Table 

 

Open Future  
Changes  
Table 

 

Copy CRP  
Table 

 

Help 

 
Figure 6-1. CRP Tables Toolbar 

 
Opening a CRP Table 

 
This section describes how to open a new or existing CRP table from the CRP Table  
main window. 

 
Opening a New CRP Table 

 
To open a new CRP table, do the following: 
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1. From the File menu, choose New Table.  

Or  
On the toolbar, choose the New CRP Table button.  
The New CRP Table dialog box appears, as shown in Figure 6-2. 

 

Figure 6-2. New CRP Table Dialog Box  
2. Enter a name for the CRP table in the text box and choose OK.  

Route It! creates a new, local CRP table with the name you entered in the New  
CRP Table dialog box. The new CRP table appears in a CRP Tables window, as  
shown in Figure 6-3.  

NOTE :  
Notice that the CRP Tables window shows two announcement type buttons  
near the bottom of the screen: Ring and Busy. When the Terminations  
button above the list of terminations is selected, the Ring and Busy buttons  
disappear, and Announcement changes to Termination or Access Line. 

 

Figure 6-3. CRP Table Main Window  
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NOTE :  
To save time in creating a new table, you can copy an existing table as described  
in “Copying a CRP Table,” later in this chapter.  

For additional procedures used to create data in a new CRP table, see “Creating or  
Editing CRP Codes in a CRP Table,” later in this chapter. 

 
Opening an Existing CRP Table 

 
To open an existing CRP table for your Account ID, follow these steps:  
1. From the File menu, choose Open Table.  

Or  
On the toolbar, choose the Open CRP Table button.  
The Open CRP Table dialog box appears, as shown in Figure 6-4. 

 

Figure 6-4. Open CRP Table Dialog Box  
The list box shows all CRP tables for your Account ID. The L or O following each  
table name identifies the table as either a local (L) or official (O) table.  
If the Open Future Changes check box is selected and a future changes table  
exists for a CRP table, the corresponding future changes table will open when the  
CRP table opens. If an official version and a local version of the future changes  
table exist, the local version will open.  

2. To open a listed CRP table, do one of the following: 
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� 

 
Type the table name in the CRP Table text box, then choose OK.  

� 
 
Select a table name from the list and choose OK.  

� 
 
Double-click a table name in the list.  

The CRP table you requested appears.  
NOTE :  
One of the following may occur:  
— If you typed or selected the name of an official version of a CRP table for  

which a local version also exists, the local version appears. To open the  
official version, you must select it from the list.  

— A message may appear indicating that you cannot open the table  
because it is a local CRP table that also has a corresponding local future  
changes table. This “double local” situation occurs when a copy is made  
of an official CRP table that also has an official future changes table. The  
copy results in local versions of each, which is not permitted in Route It!  

If a message appears, preventing you from opening the table, do one of the  
following at the message dialog box:  
— Choose Send Table to send the local CRP table to the support system,  

where it will become official. You can open the table after it becomes  
official.  

— Choose Delete Both Locals, to delete each version of the table.  
For additional instruction, see “Creating or Editing CRP Codes in a CRP Table,” later  
in this chapter. 

 
Searching for a CRP Table 

 
To help search for a particular CRP table, you can narrow the list of choices. From the  
Open CRP Table dialog box (Figure 6-4), use either of these search methods:  
� 

 
Select one of the following under List Only, then choose Apply

 
Local Only 

 
Select to display local CRP tables only.  

Official  
Only 

 
Select to display official CRP tables only. 

 
Both 

 
Select to display both local and official CRP tables.  

CRP ID 
 
To display the CRP tables that have a specific CRP database  
assigned to them, type the CRP database ID or the name of the  
database in the CRP ID text box.  

Or  
� 

 
Select the List All button to display a list of all CRP tables for the current Account  
ID. 
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NOTE :  
If the Open Future Changes check box is selected and a future changes table  
exists for a CRP table, the corresponding future changes table will open when the  
CRP table opens. If both an official and a local version of the future changes table  
exist, the local version will open.  

After narrowing the table list, open a CRP table by doing one of the following:  
� 

 
Type the table name in the CRP Tables text box, then choose OK.  

� 
 
Select a table name from the list and choose OK.  

� 
 
Double-click a table name in the list.  

The CRP table you requested appears.  
NOTE :  
If you typed the name of an official CRP table for which a local version exists, the  
local version appears. To open the official version, you must select it from the list.  

For additional procedures, see the next section, “Creating or Editing CRP Codes in a  
CRP Table.” 

 
Creating or Editing CRP Codes in a CRP  
Table 

 
On the CRP Tables main window, you can create new CRP codes, edit existing CRP  
codes, or remove CRP codes. 

 
Applying or Saving Changes to a CRP Table When a  
Future Changes Table Also Exists 

 
Route It! prevents you from applying or saving changes to an official table when a  
corresponding local future changes table also exists. When you try to apply or save a  
change, a warning message states that you cannot save the change. You can  
continue editing the CRP table, but to save your changes (with the Save command),  
you must first delete the local future changes table. 

 
Displaying the Access Lines/Terminations or  
Announcements CRP Code List 

 
A CRP table contains two lists of codes: one for terminations and one for  
announcements. Before you work with codes, you need to select one of the lists, as  
shown in Figure 6-5. 
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Select to work with codes  
for terminations  

Select to work with codes  
for announcements 

 

Figure 6-5. List Options on a CRP Table  
Only one list of codes is active at a time.  
The listed terminations can appear as either access lines or termination names,  
depending on the settings for the Show Names or IDs command on the View menu.  
Show Names or IDs also determines whether the option for selecting the list appears  
as Access Lines or Terminations. For details, see “Displaying Names or IDs,” later  
in this chapter. 

 
Finding a CRP Code 

 
To find a CRP code in a CRP table, follow these steps:  
1. Display a local or official CRP table in the active CRP Tables window.  
2. Select either the Terminations (or Access Lines) or the Announcements  

button above the list boxes.  
3. Enter the CRP code in the CRP Code text box, or select one from the list.  

NOTE :  
If you would like to see a list of all CRP codes for a specific termination or  
announcement, see “Filtering CRP Code Lists,” later in this chapter.  

4. Choose Find.  
The CRP code appears selected in the list, along with its termination. 

 
Finding Detail Information 

 
If you need detail information on either a termination or an announcement, see the  
section “Displaying Termination or Announcement Detail Information,” later in this  
chapter. 
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Adding a CRP Code 

 
To add a CRP code, follow these steps:  
1. Display a local or official CRP table in the active CRP Tables window.  
2. Select either the Terminations (or Access Lines) or the Announcements  

button above the list boxes.  
3. Enter the new CRP code in the CRP Code text box.  
4. Below the CRP Code text box, enter the value for the CRP code by doing one of  

the following:  
� 

 
If you selected Announcements:  
a. Type an announcement name or announcement number in the  

Announcement text box.  
b. Choose either the Ring or the Busy button beside the Announcement  

text box and choose Apply.  
� 

 
If you selected Terminations (or Access Lines), type a termination name or  
access line name and choose Apply.  

The CRP code and corresponding value are added to the applicable list. The  
status bar indicates the added code.  
NOTE :  
For information on saving a local CRP table, see the section “Saving a Local CRP  
Table,” later in this chapter. 

 
Modifying a CRP Code 

 
To modify an existing CRP code, follow these steps:  
1. Display a local or official CRP table in the active CRP Tables window.  
2. Select either the Terminations (or Access Lines) or the Announcements  

button above the list boxes.  
3. Populate the CRP Code text box by doing one of the following:  

Enter the CRP code.  
Or  
Click the desired CRP code in the list.  

4. Below the CRP Code text box, select the value for the CRP code by doing one of  
the following:  
� 

 
If you selected Announcements:  
a. Type an announcement name or announcement number in the  

Announcement text box.  
b. Choose either the Ring or the Busy button beside the Announcement  

text box and choose Apply. 
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� 

 
If you selected Terminations (or Access Lines), type a termination name or  
access line name and choose Apply.  

A dialog box prompts you to confirm that you want the code modified.  
5. To complete the modification, choose Yes.  

The modified data is displayed in the list, and the status bar indicates that the  
code was modified.  
NOTE :  
For information on saving a local CRP table, see the section “Saving a Local CRP  
Table,” later in this chapter. 
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Removing a CRP Code 

 
To remove a CRP code from a table, follow these steps:  
1. Display a local or official CRP table in the active CRP Tables window.  
2. Select either the Terminations (or Access Lines) or the Announcements  

button above the list boxes.  
3. Populate the CRP Code text box by doing one of the following:  

Enter the CRP code.  
Or  
Click the desired CRP code in the list.  

4. Choose Remove.  
A message prompts you to confirm the CRP code to be removed.  

5. Respond to the confirmation prompt:  
If the CRP code appearing in the message is not correct, choose No.  
Or  
If the CRP code appearing in the message is correct, choose Yes.  
If you choose Yes, the CRP code is removed from the list, and the status bar  
states that the code was removed.  
NOTE :  
For information on saving a local CRP table, see the section “Saving a Local CRP  
Table,” later in this chapter. 

 
Deleting a Table 

 
Occasionally, you may need to delete all codes by deleting a table. The section  
“Deleting a CRP Table or a Future Changes Table,” later in this chapter, describes the  
procedure. 

 
Copying a CRP Table 

 
To save time when building a CRP table, you can copy an official CRP table into a  
new local CRP table with a different name.  
To copy an official CRP table, follow these steps:  
1. On the File menu, choose Copy.  

Or  
On the toolbar, choose the Copy CRP Table button.  
The Copy dialog box appears, as shown in Figure 6-6. 
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Figure 6-6. Copy Dialog Box 
 
2. In the Copy CRP Table text box, do one of the following:  

Type the name of the official CRP table to be copied.  
Or  
Click the Choices (...) button and select an official CRP table from the Choice List  
dialog box.  

NOTE :  
From the Choices dialog box, the Table Name Choices dialog box is  
displayed with additional options. To see details on the CRP table you have  
selected, choose Info. To narrow your table name choices, enter data in the  
text box under Filter On and select Filter. For details, see “Choices Button” in  
Chapter 2, “Using Route It! with Windows.”  

3. In the To text box, enter a new CRP table name.  
4. Choose OK.  

The status bar verifies the copy operation, unless a message appears stating that  
an official future changes table exists for the original CRP table. The message  
prompts you to copy either the CRP table only or both the CRP and future  
changes tables.  

NOTE :  
Copying both tables results in a local copy of each. Route It! permits only one  
local copy to exist at a time.  

Respond to the message:  
� 

 
To copy the CRP table only, choose Copy Table Only. (See 

 
NOTE 

 
below.)  

The status bar indicates that the CRP table has been copied to a local  
version.  
Or   

�  To copy both the CRP table and the future changes table to local data,  
choose Copy Both Table and Future. (See

 
NOTE

 
below.)  

Or  
� 

 
To cancel without copying, choose Cancel. 
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NOTE :  
If both tables still exist at the time you open either, you are offered several  
options. See “Opening an Existing CRP Table,” earlier in this chapter, for  
more information.  

You can then edit the CRP codes as described in “Creating or Editing CRP Codes in a  
CRP Table,” earlier in this chapter. 

 
Renaming a CRP Table 

 
You can rename an existing CRP table. If both local and official versions of the CRP  
table exist, they are renamed also. If a future changes table exists for the CRP table, it  
too is renamed.  
+ 

 
IMPORTANT:  
Before renaming a CRP table, close all versions (local and official) of the CRP  
table being renamed. After sending a rename request, wait until you receive a  
“successful” message from the support system before opening the respective  
CRP table.  

To rename an existing CRP table, follow these steps:  
1. On the File menu, choose Rename.  

The Rename dialog box appears, as shown in Figure 6-7. 

 

Figure 6-7. Rename Dialog Box  
2. In the Rename CRP Table text box, do one of the following:  

Type the name of the CRP table to be renamed.  
Or  
Click the Choices (...) button and select a CRP table from the Choice List dialog  
box.  

NOTE :  
From the Choices dialog box, the Table Name Choices dialog box is  
displayed with additional options. To see details on the CRP table name you  
have selected, choose Info. To narrow your table name choices, enter data in  
the text box under Filter On and select Filter. For details, see “Choices  
Button” in Chapter 2, “Using Route It! with Windows.”  

3. In the To text box, enter a new name for the CRP table. 
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4. Choose Rename, or choose Cancel. (Choosing Cancel will close the dialog box  

without renaming the official CRP table.)  
If you choose Rename, a status message indicates that the CRP table was  
renamed. Only a local version of the CRP table exists.  
If an official version of the CRP table also exists, the Rename Official Table dialog  
box appears, as shown in Figure 6-8. 

 

Figure 6-8. Rename Official Table Dialog Box  
To rename the official CRP table, choose Send.  

NOTE :  
If the Send command is unavailable due to permissions settings, see your  
Route It! system administrator.  

The status bar indicates that the request to rename the CRP table has been sent. 

 
Saving a Local CRP Table 

 
Save a local CRP table when you have done either of the following:  
� 

 
Added, deleted, or modified a CRP code in a CRP table.  

� 
 
Created a new CRP table.  
NOTE :  
You may even save an “empty” table (that is, one currently containing no codes).  

When you save an official CRP table, consider the following:  
� 

 
An official CRP table is saved as a local table.  

� 
 
If a local version of the corresponding future changes table already exists, a  
message appears, indicating that you cannot save the CRP table. Route It! lets  
you work with only one local version at a time. To save the official CRP table, first  
delete the local future changes table.  

To save a CRP table as local data, do the following:  
1. Ensure that the CRP table you want to save is in the active CRP Tables window.  
2. From the File menu, choose Save.  

Or  
From the toolbar, choose the Save button.  
If you are working with an official table and a local version already exists, a  
message prompts you to confirm that you want to overwrite the existing local 
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version.  
To overwrite an existing local version, choose Yes.  
The status bar indicates that the table was saved to local data.  
NOTE :  
For information on sending a local CRP table to the support system, see the  
section “Sending a Local CRP Table to the Support System,” later in this chapter. 

 
Saving a CRP Table When a Future Changes  
Table Also Exists 

 
Route It! prevents you from saving changes to an official CRP table when a  
corresponding local future changes table also exists. At the time you make a change,  
a message warns you that you will not be able to save the change. You can continue  
editing the CRP table, but to save your changes (with the Save command), you must  
first delete the local future changes table. 

 
Sending a Local CRP Table to the Support  
System 

 
When you have finished creating or revising a local CRP table and want to send it to  
the support system, follow these steps:  
1. In the active CRP Tables window, display the CRP table you want to send.  

NOTE :  
You may even send an “empty” table (that is, one currently containing no codes).  

2. From the File menu, choose Send.  
NOTE :  
The Send command may be unavailable if you do not have send permissions  
for the CRP Tables task. Contact your Route It! system administrator for more  
information.  

The status bar indicates whether the CRP table has been sent to the support  
system.  

3. After sending the table, check the Comm Log to see if the CRP table passed  
validation at the support system. For more information, see Chapter 7, “Comm  
Log.”  

After the CRP table passes validation at the support system, it becomes an official  
CRP table. In addition, Route It! automatically deletes the table’s local version from  
your PC. If an official version with the same name already exists on your PC, it is  
updated. 
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NOTE :  
Before you can use a newly validated CRP table for call routing, you must assign  
or reassign at least one CRP database to it. See “Assigning and Reassigning  
CRP Databases to Official CRP Tables,” later in this chapter. 

 
Future Changes Feature 

 
Use the Future Changes feature to set up changes, in advance, to codes in an official  
CRP table. The changes go into effect on a future date that you specify.  
You can make the following changes:  
�  
�  
� 

 
Add a CRP code.  
Modify the value of an existing CRP code.  
Delete a CRP code.  

Each change is called a future change.  
On the scheduled change date, the future changes are applied to the corresponding  
official CRP table. Afterward, the future changes table is automatically deleted. 

 
Opening a Future Changes Table 

 
This section describes how to open a new or existing future changes table. 

 
Opening a New Future Changes Table 

 
To open a new future changes table for your Account ID, follow these steps:  
1. From the File menu, choose New Future Changes.  

Or  
On the toolbar, choose the New Future Changes Table button.  
The New Future Changes dialog box appears, as shown in Figure 6-9. 

 

Figure 6-9. New Future Changes Dialog Box  
2. In the For CRP Table text box, type the name of an official CRP table for which  

you want to schedule future changes.  
Or  
Click the Choices (...) button and select a CRP table from the Choice List dialog  
box. 
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3. In the Scheduled Change Date text box, enter the date (in mm/dd/yy format) on  

which you want the changes to be applied.  
4. Choose OK.  

One of the following occurs:  
The new future changes table appears. (See Figure 6-10 for a sample table.)  

NOTE :  
Notice that the future changes table window shows two announcement type  
buttons near the bottom of the screen: Ring and Busy. When the  
Terminations button above the list of terminations is selected, the Ring and  
Busy buttons disappear, and the Future Announcement option changes to  
either Future Termination or Future Access Line.  

Or  
You may receive an error message that prevents you from creating the new future  
changes table. The error message describes one of the following situations:  
� 

 
A corresponding local CRP table already exists.  
Route It! does not permit both a local future changes table and a local CRP  
table to exist at the same time.  
To create the local future changes table, you must first delete the local CRP  
table. For more information, see “Deleting a CRP Table or a Future Changes  
Table,” later in this chapter.  

� 
 
An official future changes table currently exists.  
To work with a local future changes table, do one of the following:  

— Edit the existing official future changes table by doing one or both of  
the following:  
� 

 
Open the official future changes table, edit it, then save it. The  
edited table is saved as a local future changes table. For more  
information, see the following section, “Opening an Existing  
Future Changes Table.”  

� 
 
To change the scheduled change date, from the Options menu,  
choose Modify Future Date. For more information, see  
“Modifying a Future Changes Date,” later in this chapter.  

— Delete the existing official future changes table and then create a new  
local future changes table. For more information, see “Deleting a  
CRP Table or a Future Changes Table,” later in this chapter. 
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Figure 6-10. Future Changes Table  
NOTE :  
To save time in creating a new future changes table, you can copy an existing  
table, as described in “Copying a CRP Table,” earlier in this chapter.  

For other future changes procedures, see the applicable future changes sections,  
later in this chapter. 

 
Opening an Existing Future Changes Table 

 
To open an existing future changes table for your Account ID, follow these steps:  
1. From the File menu, choose Open Future Changes.  

Or  
On the toolbar, choose the Open Future Changes Table button.  
The Open Future Changes to CRP Table dialog box appears, as shown in  
Figure 6-11. 
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Figure 6-11. Open Future Changes to CRP Table Dialog Box  
The list box displays all future changes tables for your Account ID. The L or O  
following each future changes table name identifies it as either a local (L) or  
official (O) table.  
If the Open Official Table check box is selected, the corresponding official CRP  
table will open when the future changes table opens.  

2. To open a listed future changes table, do one of the following:  
� 

 
Type the future changes table name in the Future Changes for CRP Table  
text box and then choose OK.  

� 
 
Select a future changes table name from the list and choose OK.  

� 
 
Double-click a future changes table name in the list.  

The future changes table you requested appears.  
NOTE :  
One of the following may occur:  
— If you typed or selected the name of an official version of a future changes  

table for which a local version also exists, the local version appears. To  
open the official future changes table, you must select it from the list.  

— A message may appear indicating that you cannot open the table  
because it is a local future changes table that also has a corresponding  
local CRP table. (This “double-local” situation occurs when a copy is  
made of an official CRP table that also has an official future changes  
table.) The copy results in local versions of each, which is not allowed in  
Route It! 
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If a message appears, preventing you from opening the table, do one of the  
following at the message dialog box:  
— Choose Send Table to send the CRP table to the support system, where  

it will become official. You can open the future changes table after its  
corresponding CRP table has become official.  

— Choose Delete Both Locals to delete both the local future changes and  
the local CRP tables. 

 
Searching for Future Changes Tables 

 
To help search for a particular future changes table, you can narrow the list of  
choices. From the Open Future Changes to CRP Table dialog box, use either of these  
search methods:  
� 

 
Under List Only, select one of the following, then choose Apply: 

 
Local Only 

 
Select to display local future changes tables only.  

Official  
Only 

 
Select to display official future changes tables only. 

 
Both 

 
Select to display both local and official future changes tables.  

CRP ID 
 
To display the future changes tables that have a specific CRP data-  
base assigned to them, type the CRP database ID or the name of  
the database in the CRP ID text box.  

Or  
� 

 
Select the List All button to display a list of all future changes tables for the  
current Account ID.  
NOTE :  
If the Open Official Table check box is selected, the corresponding official CRP  
table will open when the future changes table opens.  

After narrowing the future changes table list, open a future changes table by doing  
one of the following:  
� 

 
Type the future changes table name in the Future Changes for CRP Table text  
box, then choose OK.  

� 
 
Select a future changes table name from the list and choose OK.  

� 
 
Double-click a future changes table name in the list.  

The future changes table you requested appears.  
NOTE :  
If you typed the name of an official future changes table for which a local version  
exists, the local version appears. To open the official version, you must select it  
from the list.  

For additional procedures, see the applicable sections for future changes, later in this  
chapter. 

 
AT&T—PROPRIETARY  

Use pursuant to Company Instructions 
 
6-20           AT&T Route It! 



  

 
Chapter 6  CRP Tables  
Creating or Editing CRP Codes in a Future Changes 

 

Creating or Editing CRP Codes in a Future  
Changes Table 

 
On the CRP Table/Future Changes main window, you can create new CRP codes,  
edit existing CRP codes, or remove CRP codes on an existing official CRP table. 

 
Applying or Saving Changes to a Future Changes Table  
When a CRP Table Also Exists 

 
Route It! prevents you from applying or saving changes to an official future changes  
table when a corresponding local CRP table also exists. When you try to apply or save  
a change, a warning message states that you cannot save the change. You can  
continue editing the future changes table, but to save your changes (with the Save  
command), you must first delete the local CRP table. 

 
Displaying the Access Lines/Terminations or  
Announcements List 

 
A future changes table contains two lists of codes: one for terminations and one for  
announcements. Before you work with codes, you need to select one of the lists, as  
shown in Figure 6-12. 

 
Select to work with codes  
for terminations  

Select to work with codes  
for announcements 

 

Figure 6-12. List Options on a Future Changes Table  
Only one list of codes is active at a time.  
The listed terminations can appear as either access lines or termination names,  
depending on the settings for the Show Names or IDs command on the View menu.  
Show Names or IDs also determines whether the option for selecting the list appears  
as Access Lines or Terminations. For details, see “Displaying Names or IDs,” later  
in this chapter. 
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Finding a CRP Code 

 
To find a CRP code in a future changes table, follow these steps:  
1. Display a local or official future changes table in the active CRP Tables/Future  

Changes window.  
2. Select either the Terminations (or Access Lines) or the Announcements  

button above the list boxes.  
NOTE :  
If you would like to see the CRP codes for a specific termination or  
announcement, see “Filtering CRP Code Lists,” later in this chapter.  

3. Enter the CRP code in the CRP Code text box, or select one from the list.  
4. Choose Find.  

The CRP code appears selected in the list, along with its termination. 
 
Finding Detail Information 

 
If you need detail information on either a termination or an announcement, see the  
section “Displaying Termination or Announcement Detail Information,” later in this  
chapter. 

 
Adding Future Changes 

 
To enter a new future change, follow these steps:  
1. Display a local or official future changes table in the active CRP Tables/Future  

Changes window.  
2. Select either the Terminations (or Access Lines) or the Announcements  

button above the list boxes.  
3. To indicate the code to be added, modified, or deleted, do one of the following:  

In the CRP Code box, type the CRP code.  
Or  
Click a CRP code in the list.  

4. Below the CRP Code text box, enter a value by doing one of the following:  
� 

 
If you selected Announcements 

 
:  

a. Type an announcement name or announcement number in the Future  
Announcement text box.  

b. Choose either the Ring or the Busy button under the Future  
Announcement text box.  

Or  
� 

 
If you selected Terminations (or Access Lines), type a termination name or  
access line name. 
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5. Beside Future Action, choose either the Add, Modify, or Delete button.  
6. Choose Apply.  

The CRP code, corresponding value, and corresponding action are added to the  
applicable list. The status bar indicates the future change.  
NOTE :  
To make a new CRP code available for call routing on the scheduled change date,  
you must save and send the future changes table containing that code. See the  
sections “Saving a Future Changes Table” and “Sending a Future Changes Table  
to the Support System,” later in this chapter. 

 
Modifying Existing Future Changes 

 
To modify the CRP code, value, and action of an existing future change in a future  
changes table, follow these steps:  
1. Display a local or official future changes table in the active CRP Tables/Future  

Changes window.  
2. Select either the Terminations (or Access Lines) or the Announcements  

button above the list boxes.  
3. Populate the CRP Code text box by doing one of the following:  

Click a CRP code in the list.  
Or  
Type the CRP code in the text box and then type a corresponding value in the  
Future Announcement or Future Termination (or Future Access Line

 
)
 
text  

box.  
4. Modify a future change by changing one or more of the following:  
� 

 
the CRP code  

� 
 
the value for the CRP code  

� 
 
the future action (Add, Modify, or Delete)  
NOTE :  
A future changes table can contain two RING or two BUSY values at one  
time. (In contrast, a CRP table can have only one RING value and one BUSY  
value at a time.) For example, in the same future changes table, you can  
delete a CRP code that has a RING value and then add a different CRP code  
with the RING value. These modifications result in two RING values.  

5. Choose Apply.  
A message prompts you to confirm that you want the code modified.  

6. To complete the modification, choose Yes.  
The status bar indicates the change. 
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NOTE :  
To modify a CRP code available for call routing on the scheduled change date,  
you must save and send the future changes table containing that code. See the  
sections “Saving a Future Changes Table” and “Sending a Future Changes Table  
to the Support System,” later in this chapter. 
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Removing Future Changes 

 
To remove a future change from a future changes table, follow these steps:  
1. Display a local or official future changes table in the active CRP Tables/Future  

Changes window.  
2. Select either the Terminations (or Access Lines) or the Announcements  

button above the list boxes.  
3. Click the CRP code in the list.  
4. Choose Remove.  

A message prompts you to confirm the removal.  
5. Respond to the confirmation prompt:  

If the CRP code appearing in the message is not correct, choose No.  
Or  
If the CRP code appearing in the message is correct, choose Yes.  
If you choose Yes, the CRP code, corresponding value, and corresponding action  
are removed from the list. The status bar indicates that the code was removed.  
NOTE :  
To remove a CRP code that is available for call routing on the future change date,  
you must save and send the future changes table from which that code was  
removed. See the sections “Saving a Future Changes Table” and “Sending a  
Future Changes Table to the Support System,” later in this chapter. 

 
Modifying a Future Change Date 

 
To change the date on which the future changes in a future changes table are to go  
into effect, follow these steps:  
1. Display the future changes table in the CRP Tables/Future Changes active  

window.  
2. From the Options menu, choose Modify Future Date.  

The Modify Future Date dialog box appears, as shown in Figure 6-13. 

 

Figure 6-13. Modify Future Date Dialog Box  
3. Enter the new date in the Modify Date To text box. 
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4. Choose Modify.  

If the future changes table is official, a message prompts you to send the modified  
future change date to the support system. You must send the modified date to the  
support system in order for the changes to become active in the network on the  
date specified.  

5. To complete the future change date modification, choose Send.  
NOTE :  
If the Send command is unavailable due to permissions settings, contact your  
Route It! system administrator for more information.  

The status bar indicates that the request to modify the scheduled change has  
been sent. 

 
Deleting a Table 

 
Occasionally, you may wish to delete a future changes table. See “Deleting a CRP  
Table or a Future Changes Table,” later in this chapter. 

 
Saving a Future Changes Table 

 
Save a future changes table when you have added, modified, or removed future  
changes or have modified a future changes date.  

NOTE :  
You may even save an “empty” table (that is, one currently containing no codes).  

When you save an official future changes table, the official version remains  
unchanged in the support system and is still scheduled for activation in the network.  
Also, local future changes tables are not scheduled in the network.  
To save a future changes table, follow these steps:  
1. Display the future changes table in the active CRP Tables/Future Changes  

window.  
2. From the File menu, choose Save.  

Or  
From the toolbar, choose the Save button.  
The table, whether originally local or official, is saved as local data.  
If a local version already exists, a message prompts you to confirm that you want  
to overwrite the existing local version. To overwrite an existing local version,  
choose Yes.  
The status bar indicates that the future changes table was saved to local data,  
regardless of its original status.  
NOTE :  
After saving your table, you must send the new future changes table to the  
support system as described in the section “Sending a Future Changes Table to  
the Support System,” later in this chapter. 
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Saving a Future Changes Table When a CRP  
Table Also Exists 

 
Route It! prevents you from saving changes to an official future changes table when a  
corresponding local CRP table also exists. At the time you make a change, a  
message warns you that you will not be able to save the change. You can continue  
editing the future changes table, but to save your changes (with the Save command),  
you must first delete the local CRP table. 

 
Sending a Future Changes Table to the  
Support System 

 
When you have finished creating or revising a future changes table or modifying a  
future changes date, you can send the table to the support system as follows:  
1. In the active CRP Tables/Future Changes window, display the future changes  

table you want to send.  
NOTE :  
You may even send an “empty” table (that is, one currently containing no codes).  

2. From the File menu, choose Send.  
NOTE :  
If the Send command is unavailable, you may not have send permissions for  
this task. Contact your Route It! system administrator for more information.  

The status bar message indicates whether the future changes table has been sent  
to the support system.  

3. After sending the table, check the Comm Log to see if the future changes table  
passed validation at the support system. For more information, see Chapter 7,  
“Comm Log.”  

After the table passes validation at the support system, it becomes an official future  
changes table. In addition, Route It! automatically deletes the table’s local version  
from your PC. If an official version with the same name already exists on your PC, it is  
updated.  

NOTE :  
Before you can use a newly validated future changes table for call routing, you  
must assign or reassign at least one CRP database to it. See the following  
section, “Assigning and Reassigning CRP Databases to Official CRP Tables.” 
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Assigning and Reassigning CRP Databases to  
Official CRP Tables 

 
Use Assign CRPs on the Options menu to assign one or more CRP databases to an  
official CRP table. An official CRP table must have at least one CRP database  
assigned to it in order for the codes in that table to be available for call routing. You  
can also use Assign CRPs to remove a CRP database from an official CRP table.  
Also, the length of the codes in the CRP database must be the same length as the  
codes in the CRP table to which the database is assigned.  
To assign one or more CRP databases to an official CRP table or to remove a CRP  
assignment, follow these steps:  
1. On the Options menu, choose Assign CRPs.  

The Assign CRPs dialog box appears, as shown in Figure 6-14. 

 

Figure 6-14. Assign CRPs Dialog Box  
2. To select the table to which you want to make or remove an assignment, do one  

of the following:  
In the For Official CRP Table text box, type the name of the official table and  
choose Apply.  
Or  
Click the Choices (...) button beside the For Official CRP Table text box, select  
a CRP table name from the list box of currently assigned CRP databases, and  
choose OK. 
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3. Assign a new CRP database to an official CRP table or remove an assignment by  

doing the following:  
a. Either type the name of the CRP database in the CRP Name text box, or  

select the CRP database from the list box.  
b. Choose either Add or Remove.  

The new CRP database appears in the database list, or the list redisplays  
without the removed CRP database.  
NOTE :  
To get information about a CRP database, do the following:  
(1) In the CRP database list, select the name of the CRP database for which  

you want to view information.  
(2) Choose Info.  
A read-only detail window appears.  
NOTE :  
For more information on the individual fields displayed, see online help.  

4. To send new or modified CRP table assignments to the support system to be  
validated and made official, choose Send.  
A dialog box prompts you to confirm the send.  

5. To complete the send, choose OK.  
The status bar indicates that the CRP table assignments have been sent. 

 
Getting Detail Information 

 
Choose commands on the Info menu to see detail information about CRP tables or  
about a termination or announcement contained in a CRP table. 

 
Displaying a CRP Tables Summary 

 
Choose CRP Tables Summary on the Info menu to display a list of CRP tables for  
the current Account ID.  
The Info on CRP Tables window appears, as shown in Figure 6-15. 
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Figure 6-15. Info on CRP Tables Window  
The window automatically displays the following information: 

 
CRP Table 

 
The name of the CRP table.  

CRP Code  
Length 

 
The CRP code length for the table. 

 
Scheduled  
Change Date 

 
The date for which future changes are scheduled for the  
CRP table. If future changes are not scheduled for a CRP  
table, this field displays two dashes (- -).  

Select a CRP table name in the list box to see the following information about the  
table: 

 
Show  
Assignments 

 
Select this option to display a list of CRP databases that are  
assigned to the selected CRP table.  

Versions 
 
Displays each version type that exists for the selected CRP  
table. Possibilities are:  
� 

 
Official CRP Table  

� 
 
Local CRP Table  

� 
 
Official Future Changes  

� 
 
Local Future Changes  

To close the Info on CRP Tables window, choose Close. 
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Displaying Termination or Announcement Detail  
Information 

 
You can display detail information for a termination or announcement contained in a  
local or official CRP or future changes table, as explained in these steps:  
1. From the File menu, display a CRP or future changes table in the active CRP/  

Future Changes window.  
2. Select either the Terminations (or Access Lines) or the Announcements  

button above the list.  
3. Click the termination CRP code or announcement CRP code for which you want  

to view detail information.  
4. From the Info menu, do one of the following:  

If you selected a termination CRP code, choose Termination Detail.  
Or  
I 
 
f you selected an announcement CRP code, choose Announce Detail.  

A read-only detail dialog box appears, showing information about the termination  
or announcement CRP code selected.  
NOTE :  
For more information on the individual fields displayed, see online help.  

5. To close the detail dialog box, choose Close. 

 
Filtering CRP Code Lists 

 
In a CRP or future changes table, you can display only CRP codes that are associated  
with a particular termination or announcement, as described in these steps:  
1. Display a CRP or future changes table in the active CRP Tables/Future Changes  

window.  
2. From the View menu, choose Filter By.  

The Filter Lists for CRP Table/Future Changes dialog box appears, as shown in  
Figure 6-16. 

 

Figure 6-16. Filter Lists for CRP Table/Future Changes Dialog Box 
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3. Specify a termination or announcement or both as follows:  
� 

 
To display all codes associated with a termination, enter a termination name  
or access line in the Termination (or Access Lines) text box.  

� 
 
To display all codes associated with an announcement, type an  
announcement name or ID in the Announcement text box.  

NOTE :  
The Ring and Busy values cannot be used in the Filter Lists for CRP  
Table/Future Changes dialog box.  

4. Make your selection by doing one of the following:  
To display associated CRP codes, choose OK.  
The Filters On indicator appears in the status bar of the main CRP Tables/Future  
Changes window. It indicates that a subset of CRP codes is currently displayed in  
the CRP or future changes table in the active window.  
Or  
To display all CRP codes, choose List All.  
Or  
To exit this dialog box without applying any selections, choose Cancel. 

 
Displaying Names or IDs 

 
You can choose to display announcements and terminations as numbers (that is, IDs)  
or as names in CRP and future changes tables. For example, to identify  
announcements more easily in your tables, you can display them as names rather  
than announcement numbers. CRP codes are unaffected by how you display names  
or IDs.  
The settings you choose remain in effect during all CRP Tables task sessions until  
you change them again. However, if you deviate from your settings when typing an  
entry, Route It! recognizes the information and displays it in the format you set.  
To customize how names or IDs appear in your CRP and future changes tables,  
follow these steps:  
1. From the View menu of the CRP Tables/Future Changes window, choose Show  

Names or IDs.  
The Show Names or IDs dialog box appears, as shown Figure 6-17. 
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Figure 6-17. Show Names or IDs Dialog Box  
2. For the Announcements category, select to display either Names or Numbers.  
3. For the Terminations category, select to display either Names or Access Lines.  
4. After you have made your selections, choose OK.  

Route It! displays data in your CRP table and future changes table fields in the  
format you selected. 

 
Changing the Service View 

 
A Service View is the routing information associated with a specific Account ID and  
Service Date. To choose the CRP table information with which you want to work,  
select or change the Service View. The Service View option is available for most  
Route It! tasks. However, since CRP tables are not associated with a particular  
Service Date, you can use only the Account ID to select a Service View. 
 
! 

 
CAUTION:  
All CRP tables and future changes tables should be closed before changing the  
Service View. If a table is open, work will be lost unless you save or send it before  
changing the Service View. 

 
To change the Service View, follow these steps:  
1. From the View menu, select Svc View.  

Or  
On the toolbar, choose the Service View button.  
The Change Service View dialog box appears, as shown in Figure 6-18. 
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Figure 6-18. Change Service View Dialog Box  
2. In the Account ID text box, do one of the following:  

Type an Account ID and choose Apply.  
If you change the Account ID field, you MUST select Apply before choosing the  
OK button.  
Or  
Click the Choices (...) button, select an Account ID from the Choice List dialog  
box, and choose OK.  

NOTE :  
From the Choice List dialog box, the Account ID dialog box is displayed with  
additional options. To see details on the Account ID you have chosen, choose  
Info. To narrow your choices, enter data in the Account ID and Dialed  
Number text boxes under Filter On and select Filter. For details, see the  
section “Choices Button” in Chapter 2, “Using Route It! with Windows.”  

Whichever method you use to display an Account ID, the Customer Name field  
for the selected Account ID appears populated.  

NOTE :  
The Change In area is unavailable when you change the Service View from  
the CRP Tables task. Service View changes are automatically applied only to  
the CRP Tables task.  

3. Choose OK.  
A message warns you about the potential loss of unsent edits and prompts you to  
confirm the Service View change.  

4. To complete the Service View change, choose Yes.  
The status bar shows the Account ID chosen for the Service View. 
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Deleting a CRP Table or a Future Changes  
Table 

 
You can delete a local CRP table or future changes table stored on your PC or an  
official CRP table or future changes table stored at the support system. When you  
delete official data, a delete request is sent to the support system.  
You cannot delete an official CRP table that has one or more CRP databases  
assigned to it. To delete the table, you must first unassign its CRP database(s). For  
more information, see the section “Assigning and Reassigning CRP Databases to  
Official CRP Tables,” earlier in this chapter.  
In some cases, Route It! may require you to delete specific versions of either the CRP  
or future changes table. These versions are automatically selected and deleted as  
follows:  
� 

 
If you delete an official future changes table and its corresponding local future  
changes table also exists, the local future changes table is automatically selected  
for deletion.  

� 
 
If you delete an official CRP table and an official future changes table also exists,  
all versions of the table (the local and official CRP tables and the local and official  
future changes tables) are automatically selected for deletion.  

� 
 
If you delete a local CRP table and a corresponding local future changes table  
also exists, the local future changes table is automatically selected for deletion.  

To delete a CRP table or future changes table, follow these steps:  
1. On the File menu, choose Delete.  

The Delete dialog box appears, as show in Figure 6-19. 

 

Figure 6-19. Delete Dialog Box  
2. In the CRP Table text box, do one of the following:  

Type the name of the CRP table to be deleted and choose Apply.  
Or  
Click the Choices (...) button and select a table name from the Choice List dialog  
box. 

 
AT&T—PROPRIETARY  

Use pursuant to Company Instructions 
 
AT&T Route It! 

 
6-35 



  

 
Chapter 6  CRP Tables  
Closing a CRP or Future Changes Table 

 
NOTE :  
From the Choice dialog box, the Table Name Choices dialog box is displayed  
with additional options. To see details on the CRP table name you have  
selected, choose Info. To narrow your table name choices, enter data in the  
text box under Filter On and select Filter. For details, see the section  
“Choices Button” in Chapter 2, “Using Route It! with Windows.”  

Regardless of the method you use to populate the CRP Table text box, Route It!  
updates the selections under Delete these versions according to the CRP table  
you selected.  

3. Under Delete these versions, select each version that you want to delete.  
An x appears in the check box for each version selected.  

4. Choose Delete.  
If you are deleting any official data, the Delete Official Table dialog box appears,  
as shown in Figure 6-20. 

 

Figure 6-20. Delete Official Table Dialog Box  
Make a selection:  
� 

 
To cancel the deletion, choose Cancel.  
Or  

� 
 
To delete the official table, choose Send.  
NOTE :  
If the Send command is unavailable due to permissions settings, contact your  
Route It! system administrator for more information.  

The status bar indicates that the delete request was either sent or cancelled. 

 
Closing a CRP or Future Changes Table 

 
When you have finished working with a table, follow these steps to close it:  
1. Make sure the CRP or future changes table you want to close is displayed in the  

active window.  
2. From the File menu, choose Close.  

The CRP or future changes table is closed if all changes have been saved. If you  
made changes but did not save them, a confirmation dialog box appears, as  
shown in Figure 6-21. 
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Figure 6-21. Confirmation Dialog Box  
If the confirmation dialog box appears, do one of the following:  
� 

 
To save any edits and close the CRP or future changes table, choose Yes.  
For an existing CRP table or future changes table, the edits are saved and the  
window is closed. For more information on saving a new CRP table or new  
future changes table, see one of these previous sections: “Saving a Local  
CRP Table” or “Saving a Local Future Changes Table.”  
Or  

� 
 
To close the CRP table or future changes table without saving the edits,  
choose No.  
The edits are not saved and the table is closed.  
Or  

� 
 
To continue working with the CRP table or future changes table without  
saving changes, choose Cancel.  
You are returned to the CRP table or future changes table in the active  
window. 

 
Exiting the CRP Tables Task 

 
To exit the CRP Tables task, do one of the following:  
� 

 
Choose Exit from the File menu.  
Or  

� 
 
Click the Close button on the CRP Tables title bar.  

If all changes have been saved in any open CRP or future changes tables, the CRP  
Tables window closes. If there are any unsaved edits in any CRP or future changes  
tables, you are prompted to save or discard them before the CRP Tables window is  
closed. 
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Comm Log 

 

 
This chapter describes how to display, print, and save messages in the  
Communications Log, or Comm Log. It also explains how to customize the look and  
contents of the log. 

 
About the Comm Log 

 
The Comm Log is a log of the requests or their corresponding responses exchanged  
between your PC and the support system. Each request to the support system  
generates a message, and the support system’s response to your PC updates an  
existing message. The support system also sends messages independent of any  
requests.  
Using the log, you can check the success of requests you or others have made to the  
support system. You can also keep track of changes to your routing plan environment,  
such as area code splits.  
The Comm Log contains three types of messages, as described in Table 7-1. 
 
Table 7-1.  Comm Log Message Types 

 
Transaction request 

 
A description of an activity you or another AT&T Route It!  
user requested, such as a send of a routing plan to the  
support system.  

Transaction response 
 
The results (success or failure) of your send request once  
the support system has attempted it.  
If the transaction request requires processing at both the  
support system and the AT&T network, the log records an  
interim success response after the activity has been vali-  
dated at the support system but before it has been com-  
pleted at the AT&T network.  

Autonomous message 
 
Information sent by the support system independent of any  
transaction requests. Autonomous messages typically  
inform you of system or network activity.  
Special notify autonomous messages inform you when  
another Route It! user or the AT&T work center has made  
data modifications to an account. 

 
The Comm Log lets you display a list of messages and view detail for each message.  
You can also filter the log to see a subset of messages, based on certain parameters  
you specify. You can print and save messages. You can also customize the way the  
log and the information in it are displayed. 
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Starting the Comm Log Task 
 
To start the Comm Log task, do one of the following at the Route It! main window:  
� 

 
Double-click the Comm Log icon.  

� 
 
From the Route It! Tasks menu, choose Comm Log.  

The Comm Log window appears. 

 
Displaying the Message List 

 
In the past, the Comm Log was updated every five seconds while your PC was  
connected to the support system. Now it is updated when both of these conditions  
exist:  
� 

 
The Transaction Manager is polling according to settings you specified, as  
described in Chapter 4, “System Administration,” in the AT&T Route It!  
Administration guide.  

� 
 
The Transaction Manager detects changes to the Comm Log.  

In general, new items are displayed at the top of the scrolling list. Figure 7-1 shows a  
sample Comm Log. 

 

Figure 7-1.  Comm Log  
Request messages are displayed in black in the Comm Log. To help you quickly  
determine whether a request succeeded or failed, each response message from the  
support system is color-coded in the Comm Log, as described in Table 7-2.  
The status bar shows the number of active messages and the total number of  
messages in the log.  
Each entry in the message list (except a request) contains a Status indicator in the  
leftmost column. (The column does not have a heading.) The Status indicator  
identifies the log entry as either a transaction response, transaction request, or  
autonomous message (see Table 7-2). For descriptions of these log entries, see  
Table 7-1. 
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Table 7-2.  Status Indicator Values 

 
Status 

 
Default Color 

 
Entry Type 

 
Blank 

 
Black 

 
A transaction request.  

S 
 
Green 

 
A transaction response. Indicates that the transaction  
requested was completed successfully. Refers to any of  
these successful transactions:  
� 

 
The transaction was successfully completed at the  
support system. AT&T network communications  
were not required.  

� 
 
The transaction was successfully completed in the  
AT&T network after having been processed at the  
support system.  

� 
 
A local area code split was successful.  
(For more information on area code splits, see  
Appendix A, “Managing Area Code Split Updates.”)  

(S) 
 
Blue 

 
A transaction response. Indicates that a transaction  
requested was successfully validated at the support  
system but has not yet been completed in the AT&T  
network.  

F 
 
Red 

 
A transaction response. Indicates that the transaction  
requested has failed. Also refers to failed local area  
code splits.  

->> 
 
Green 

 
An autonomous message sent by the support system.  

(P) 
 
Black 

 
A transaction request that has not yet left the sending  
PC.  

(V) 
 
Black 

 
A transaction request that is currently being validated at  
the support system. 

 
NOTE :  
For each Status indicator type, you can change the default color. For information  
on changing the default colors, see “Customizing the Comm Log,” later in this  
chapter. 
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Each entry in the message list also contains this information: 

 
State 

 
The status of messages for transactions that have not yet completed.  
Indicates one of the following:  
� 

 
queued 

 
—the transaction request has not yet left the sending PC.   

�  
 
sending—Route It! is sending a transaction request to the support  
system.   

�  
 
waiting—Route It! is waiting for a response from either the support  
system or from the AT&T network.   

�  
 
receiving—Route It! is receiving a transaction response from the  
support system.   

�  
 
processing—Route It! is processing a transaction response from the  
support system.   

�  
 
[blank] —indicates either an autonomous message (->>) or a  
message for a completed transaction (either S or F).  

% 
 
Indicates, by a percent amount, the status of a message that is being  
sent, received, or processed. This column is blank for any other type of  
message.  

Date/Time 
 
The PC date and time the transaction occurred. Indicates one of the  
following:  
� 

 
when the message was sent to the support system  

� 
 
when the message was received by the support system  

� 
 
when the message was received by the AT&T network  

The letter after the time identifies one of the following: a = a.m., p = p.m.,  
n = noon, m = midnight.  

SMW ID 
 
Service Management Workstation identification number associated with  
Route It! installations. Must be unique for each PC or workstation.  
Each TMF and TMG will display the SMW ID associated with the  
machine. Autonomous messages will have the SMW ID of a Route It!  
installation, and from_att if from a non-Route It! installation.  
Format - 8 alphanumerics  

User 
 
The user name of the user associated with the transaction. The user  
name from_att indicates an autonomous message, except from a non-  
Route It! installation.  

Account ID 
 
The Account ID associated with the transaction.  

Activity 
 
A description of the transaction. 
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Status bar 

 
Appears at the bottom of the base window and has these components,  
starting from the left of the window:  
� 

 
message bar 

 
—displays status messages.   

�  
 
Filters On indicator—indicates whether filters have been applied  
through the Filters dialog box. Indicator has two states:   
—  

 
mapped—means filters have been applied; space displays  
Filters On.   

—  
 means filters have not been applied or you selected 
unmapped  
List All from the Options menu; space is blank.  

� 
 
Active Messages indicator 

 
—the number of messages that:  

— are currently active, that is, have the status (P), (V), or (S)  
— are not autonomous, that is, have the status ->>  
— do not have a final status, that is, S or F   

�  
 
Total Messages indicator—the total number of messages currently in  
the scrolling region, regardless of their status. 

 
Sorting Messages in Comm Log Window 

 
You can quickly change the sort order of messages in the Comm Log list. By default,  
messages in the Comm Log window appear in chronological order, from most recent  
to least recent. Changes you make to the sort order are retained from session to  
session until you change the sort order again.  
To change the sort order, click a column head to sort the list according to the type of  
data in the column. Data is sorted in descending order.  
; 

 
USAGE TIP:  
To reverse the sort order of a column, click the column head again. Each time you  
click the column head, the sort order for the column toggles between descending  
and ascending order.  

After the message list is sorted, new messages appear at the top of the list. To place  
new messages in the sort order specified, press F5 or, from the Options menu,  
choose Refresh. 

 
Displaying Message Detail 

 
You can display additional detail for all messages in the Comm Log. Display message  
detail to see:  
� 

 
Details of a successfully completed transaction or response.  

� 
 
Errors generated by a failed transaction request.  

� 
 
Reports you generated with the Refresh function, such as an activities list. For  
more information, see Chapter 3, “Refresh,” in the AT&T Route It! Administration 
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guide.  

� 
 
Details of an area code split that affects your accounts. For more information on  
area code splits, see Appendix A, “Managing Area Code Split Updates.”  

+ 
 
IMPORTANT:  
To ensure that the date and time information for a message is accurate, check the  
date and time settings for your PC clock. Do this by clicking Start on the Windows  
taskbar, pointing to Settings, then clicking Control Panel. Double-click the Date/  
Time icon, then choose the correct time settings.  

To display message detail:  
Double-click a message in the Comm Log.  
Or  
Select the message to highlight it and do one of the following:  
� 

 
Choose Display Detail from the Messages menu.  

� 
 
Click the right mouse button and choose Display Detail from the pop-up  
menu.  

� 
 
Press Enter. 

 
; 

 
USAGE TIP:  
You can also select a message, then click the right mouse button to display a  
shortcut menu. The shortcut menu contains the Display Detail command and  
commands for printing and saving messages.  

The Display Detail dialog box appears, as shown in Figure 7-2. 

 

Figure 7-2.  Display Detail Dialog Box 
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The Display Detail dialog box contains this read-only information about a log entry: 
 
SMW ID 

 
Service Management Workstation identification number (8-character). Must  
be unique for each PC or workstation.  
Each TMF and TMG will display the SMW ID associated with the machine.  

Date/Time  
Sent 

 
The PC date and time the transaction was sent. This field contains dashed  
lines (--) for autonomous messages.  

Date/Time  
Rec’d 

 
If a request takes place in the network (such as a quick change), the user’s  
PC shows the date and time that the support system validated the request.  
The support system time is converted to the user’s time zone. (See the  
following Date/Time Updated field description.)  
For a request that does not affect the network (for example, a Refresh), the  
user’s PC shows the date and time that the support system completed the  
activity requested. The support system time is converted to the user’s time  
zone.  

Date/Time  
Updated 

 
Shows the date and time an activity took place in the network.  
For autonomous messages, shows the following:  
� 

 
For a notify message, shows the date and time the message originated in  
the network or at the support system, depending on the type of activity.  

� 
 
For any other autonomous message, shows the date and time the  
message originated at the support system.  

Dashed lines (--) indicate no applicable information exists for this field.  
Status 

 
Identifies the log entry as either Successfully Completed, Successfully  
Validated, Failed, Autonomous, Pending, Validating, or blank. For more  
information, see the section “Displaying the Message List,” earlier in this  
chapter, and online help.  

Trans ID 
 
A unique eight-character identifier of the transaction assigned by Route It! A  
transaction response and its associated transaction request have the same  
Trans ID. Dashed lines (--) indicate an autonomous message.  

AT&T Trans  
ID 

 
A unique seven-digit identifier assigned to the transaction by GSS. 

 
User 

 
The user name of the user associated with the transaction. The user name  
from_att indicates an autonomous message.  

Account ID 
 
The Account ID associated with the transaction.  

Svc Date 
 
The Service Date affected by the transaction. A plus sign ( + ) indicates that  
the Onward indicator is set to Yes. A dash ( – ) indicates that the Onward  
indicator is set to No. 
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Message  
Detail 

 
Additional descriptive information about the transaction. When necessary,  
vertical and horizontal scroll bars are included.  
Descriptive information about a transaction request and additional information  
about associated responses are shown in chronological order, starting with  
the detail for the most recent transaction.  
If the support system downloads a network time, it appears in this box, and a  
time received message appears. The time shown on the user’s PC has been  
converted to the user’s local time zone. If you were logged off when the  
transaction was sent, the time received is the time that you logged back on  
and received the transaction. 
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Filtering the Comm Log 
 
You can filter the Comm Log to see a subset of entries. For example, to search for a  
transaction that failed, you can filter the log to show only messages for the current  
date that have the Failed status. The filtered log helps you narrow your search for the  
specific message. You can also use List All in the Options menu to display all  
messages in the Comm Log.  
To filter the Comm Log, follow these steps:  
1. From the Options menu, choose Properties.  

The Property Sheet dialog box, containing the Filters tab, appears, as shown in  
Figure 7-3. 

 

Figure 7-3.  Filters Tab in the Property Sheet Dialog Box 
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2. Type or select entries for one or more of the fields on the Filters tab. The [all]  

choice, available for some of the fields, selects all possible items for that field.  
NOTE :  
To reset a selection to its previous setting, click the Reset button. To remove  
all filter selections on this tab, click the Clear button.  

User 
 
Select up to 10 user names, including from_att (the user  
name for autonomous messages), to see transactions for  
selected users.  

Start with 
 
Enter a date and time to display only those messages having  
that date or later.  

� 
 
Date 

 
Type a start date (in the format mm/dd/yy). If this field is left  
blank, the current date is used by default.  
The dates of the messages in the resulting filtered list are the  
same as or later than the start date specified.  

� 
 
Time 

 
Type a start time (in the format hh:mm:x, where x is one of  
the following: a = a.m., p = p.m., n = noon, m = midnight). If  
this field is left blank, the start time is set to 12:00a by  
default.  
The times of the messages in the resulting filtered list are the  
same as or later than the start time specified.  

NOTE :  
If a start time is entered but a start date is not, Route It!  
sets and displays the current date in the Date field.  

Autofilter after 
 
Specify the length of time, in days and hours, that messages  
should appear in the Comm Log window. Messages older  
than the days and hours specified do not appear in the  
Comm Log.  

� 
 
Days 

 
Enter the number of days from 0 to 99.  

� 
 
Hours 

 
Enter the number of hours from 0 to 23.  

Account ID 
 
Select one or more Account IDs.  

Message Status 
 
Select a message status type. (The default is [all], which dis-  
plays all messages, regardless of their status.)  
Pending at PC refers to transaction requests that have been  
sent but have not yet left the PC. Validating at AT&T refers  
to transaction requests for which responses are still out-  
standing from the support system. 

 
NOTE :  
To return settings on this tab to the setting last saved during the current  
session, click the Reset button. 
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3. Do one of the following:  
� 

 
To display the message list without closing the Property Sheet dialog box,  
choose Apply.  
The Comm Log displays the filtered list of messages. The status bar displays  
Filter On while the filter is in effect.  

� 
 
To display the message list and close the Property Sheet dialog box, choose  
OK.  
The Comm Log displays the filtered list of messages. The status bar displays  
Filter On while the filter is in effect.  

� 
 
To close the Property Sheet dialog box without making any changes, choose  
Cancel. 

 
Removing Filters 

 
You can remove any filters applied to the Comm Log to display all messages in the  
Comm Log main window.  
To remove filters, do one of the following:  
� 

 
From the Options menu, select List All.  

� 
 
Type Ctrl + L.  

The complete, unfiltered log appears. 

 
Printing Messages 

 
You can print one or more messages and the accompanying message details. If you  
choose to print more than one message, the messages will print out one after another,  
in the order in which they are displayed on the screen.  
You can also print the list of messages in the Comm Log. 

 
Printing One or More Messages and Message Detail 

 
To print one or more messages and accompanying message details, follow these  
steps:  
1. At the Comm Log window, select one or more messages. From the Messages  

menu, choose Print Detail.  
Or  
Double-click a message to display the Display Detail dialog box for that message  
and choose Print.  
The Print dialog box appears.  

2. At the Print dialog box, make selections for your printing preferences and choose  
OK. 
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Printing the Current Comm Log Display 

 
To print the current Comm Log display, follow these steps:  
1. From the Comm Log main window, do one of the following:  
� 

 
From the Messages menu, choose Print List.  

� 
 
Click the right mouse button, then choose Print List.  

The Print dialog box appears.  
2. At the Print dialog box, make selections for your printing preferences and choose  

OK. 

 
Deleting Messages 

 
You can delete one or more Comm Log messages that meet the following criteria:  
� 

 
The message is associated with your user name.  

� 
 
The status of the message is one of the following:  
— Successful—Transaction request was successful (designated by S in the  

Comm Log window)  
— Failed—Requested transaction failed (designated by F in the Comm Log  

window)  
— Autonomous—Information the support system sent independent of any  

transaction request (designated by ->> in the Comm Log window)  
+ 

 
IMPORTANT:  
If you logged in with the user name ADMIN, you can delete a message with the  
above statuses for any user.  

To delete messages, follow these steps:  
1. At the Comm Log window, select one or more messages that you wish to delete.  
2. Do one of the following:  
� 

 
From the Messages menu, choose Delete.  

� 
 
Press the Delete key.  

3. At the confirmation message, choose Yes.  
The messages are deleted.  
NOTE :  
You can only delete messages if you have permission and the permissions are  
set up by the ADMIN user. 
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Saving Messages 
 
You can save a single message, multiple messages, or all messages and their  
accompanying details to a file. The file is saved as a comma-separated list in a text  
(.TXT) file for easy import to Microsoft Word or Excel.  

NOTE :  
To save a subset of messages that contain common information, you can filter the  
Comm Log and then save all messages. For more information on filtering, see the  
section “Filtering the Comm Log,” earlier in this chapter.  

To save one, some, or all messages to a file, follow these steps:  
1. To save one or more messages, select the message(s) and, from the Messages  

menu, choose Save.  
Or  
To save the entire message list, from the Messages menu, choose Save All.  
; 

 
USAGE TIP:  
You can also click the right mouse button to access the Save or Save All  
command.  

The Save (or Save All, if applicable) dialog box appears, as shown in Figure 7-4. 

 

Figure 7-4.  Save Dialog Box  
2. Make selections in the Save (or Save All, if applicable) dialog box as follows:  

a. At the Save in box, select the drive and folder in which you want to save the  
file.  

b. Type the name of the file in the File name text box.  
3. To save the selected message(s), choose the Save button. 
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Customizing the Comm Log 
 
You can customize the amount of information displayed in the Comm Log and the way  
in which it appears. For example, you can opt to show messages for the current date  
only instead of showing all messages in the log.  
To customize the Comm Log, follow these steps:  
1. From the Options menu, choose Properties.  

The Property Sheet dialog box appears.  
2. Choose the Display Options tab.  

The Display Options tab moves to the front, as shown in Figure 7-5. 

 

Figure 7-5.  Display Options Tab in the Property Sheet Dialog Box  
3. Make selections as follows: 

 
Columns 

 
Select which columns you want appear in the Comm Log window  
and arrange their order by doing one or more of the following in the  
list box:  
� 

 
To display a column, select the check box for the column  
name that you want displayed.  

� 
 
To hide a column, clear the check box for the column name  
that you want hidden.  

� 
 
To change the order of the column, select the column name,  
then click the up or down arrow. 
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Message Color 

 
For each message type, choose between the default color and  
black. To select, either type the name of the color in the box, or  
select a choice from the list.  
The message types are:  
Successfully Validated—A transaction was successfully vali-  
dated at the support system but not yet completed in the AT&T  
network. Default color: blue.  
Successfully Completed—A transaction was successfully com-  
pleted at the support system and, if necessary, in the AT&T net-  
work. Also refers to successful local area code splits. Autonomous  
messages denoting success are displayed in the color selected  
here. Default color: green.  
Failed—A transaction failed. Also refers to failed local area code  
splits. Autonomous messages denoting failure are displayed in the  
color selected here. Default color: red.  

4. To display the message list without closing the Property Sheet dialog box, choose  
Apply.  
Or  
To display the message list and close the Property Sheet dialog box, choose OK.  
Or  
To close the Property Sheet dialog box without making any changes, choose  
Cancel. 

 
Maintaining the Size of the Comm Log 

 
You can limit the amount of information retained in the Comm Log by having Route It!  
purge Comm Log data automatically according to your specifications. This involves  
changing the system default of 30 days message retention to any period you choose.  
To limit the size of the Comm Log, follow the procedure described in the section  
“Purging Messages from the Comm Log” in Chapter 4, “System Administration,” in the  
AT&T Route It! Administration Guide. 
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Displaying Mail Messages 

 

 
This chapter explains how to manage your AT&T Route It! mail messages. 

 
About the Mail Task 

 
The Mail task allows you to receive electronic Route It! mail messages from the  
support system. Mail messages are sent most commonly to inform you of upcoming  
Route It! releases, Numbering Plan Area (NPA) splits (also known as area code  
splits), and other current information about Route It! These messages are read-only.  
Using the Mail task, you can:  
� 

 
View a summary of all mail messages  

� 
 
Open and close mail messages  

� 
 
View details of mail messages  

� 
 
Sort mail messages  

� 
 
Print mail messages  

� 
 
Delete mail messages  

� 
 
Retain messages according to your specifications  

For Route It! users connected to individual PCs, the Mail task is specific to each Route  
It! user name. When a mail message is sent to a particular Service Management  
Workstation (SMW) ID, all user names associated with that SMW ID receive the  
message. If a user name is associated with two SMW IDs, that user name receives  
two mail messages for each mail message the support system sent.  
For a Local Area Network (LAN) environment, each Route It! user name receives a  
mail message. 

 
The Mail Main Window 

 
The Mail main window is shown in Figure 8-1. 
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Figure 8-1.  Route It! Mail Main Window  
As shown in Figure 8-1, the Route It! Mail main window has two scrolling regions:  
� 

 
Message Summary—The upper list box which contains a line of information (also  
referred to as a message summary) for each message received.  

� 
 
Message Detail—The lower text box which displays identifying information and  
the message text.  

Each time you start the Mail task, the information displayed is updated from the last  
session. 

 
Mail Toolbar 

 
The Mail toolbar, shown in Figure 8-2, appears below the menu bar on the Mail main  
window. Use the toolbar to activate menu commands quickly. 

 
Read  
Next 

 
Delete 

 
Help 

 

Read  
Previous 

 

Print 

 
Figure 8-2.  Mail Toolbar 
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Status Bar 

 
The status bar at the bottom of the Mail main window consists of:  
� 

 
Message pane (the left portion of the status bar) in which status messages  
are displayed.  

� 
 
Number of messages indicator, which tallies and displays the number of  
messages currently in the Message Summary scrolling region. 

 
Starting Mail Task 

 
To start the Mail task, do one of the following:  
� 

 
At the Route It! main window, double-click the Mail icon.  

� 
 
From the Route It! Tasks menu, choose Mail.  
; 

 
USAGE TIP:  
If you have existing, unopened mail messages, this blinking icon appears in  
the Windows taskbar: 

 

To display the messages, click the icon.  
The Mail main window appears, with one or more message summaries displayed  
in the Message Summary list box. If a message has not been opened yet, a  
closed envelope icon appears beside that message summary entry in the list box.  
If a message has been opened, an opened envelope icon appears beside that  
message summary item.  
To change the size of either the Message Summary or the Message Detail portion  
of the Mail main window, drag the split bar up or down. 

 
Opening Mail Messages 

 
You can open mail messages in the sequence most convenient for you. To open mail  
messages, do one of the following:  
� 

 
To open a mail message, select a line in the Message Summary portion of  
the Mail main window.  

� 
 
To open the next or previous mail message, do one of the following:  
— Click the up or down arrow button in the Mail toolbar.  
— From the Message menu, choose the Read Next or Read Previous  

command.  
— Click the message line. 
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Sorting Mail Messages 
 
To sort the mail messages according to your preference, click on a column head in the  
upper portion of the Message Summary list box. By default, messages are sorted by  
date and time and appear in chronological order from most recent to least recent. New  
message summaries appear at the top of the list, regardless of how the list is sorted.  
To sort your messages, click on a column head to sort the list according to the type of  
data in the column. Data is arranged in descending order.  
To reverse the sort order of a column, click the column head again. Each time you  
click the column head, the sort order for the column toggles between descending and  
ascending order. 

 
Printing Mail Messages 

 
To print mail messages, follow these steps:  
1. Select one or more message summaries in the upper portion of the Mail main  

window.  
2. Do one of the following:  

• Click the Print icon in the Mail toolbar.  
• From the Message menu, choose Print.  

The Print dialog box appears.  
3. At the Print dialog box, optionally make selections for printer settings, then choose  

OK.  
If you printed more than one message, they are separated by page breaks. 

 
Deleting Mail Messages 

 
To delete mail messages, follow these steps:  
1. Select one or more message summaries in the upper portion of the Mail main  

window.  
2. Do one of the following:  

— Click the Delete icon in the Mail toolbar.  
— From the Message menu, choose Delete.  

3. At the confirmation message, choose Yes to delete the selected message(s). 

 
Quitting Mail Task 

 
To quit the Mail task, from the Message menu, choose Exit. 
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Managing Area Code Split Updates 

 

 
This appendix explains possible changes made to your routing plans when a new  
area code/local exchange combination is created for a geographic region. 

 
What Is an Area Code Split? 

 
To meet the demand for new telephone numbers, a new area code/local exchange  
combination can be created for a geographical area. This process is known as an  
area code split. The schedule for area code splits is determined by Bell  
Communications Research (Bellcore) as part of their role in maintaining the North  
American Numbering Plan (NANP). During the area code split process, the Local  
Exchange Carrier (LEC) does one of the following:  
 � 

 
Moves some of the existing telephone numbers in the region to the new area  
code—The remaining telephone numbers keep the original area code. As a result  
of the split, two area codes exist in the same region that previously had only one,  
potentially doubling the number of telephone numbers.  
Example: 201-805-1111 changes to 908-805-1111.  

 � 
 
Changes the area code and the exchange of some of the existing telephone  
numbers in the region to the new area code and exchange combination—This is  
called a six-digit area code split. As a result of the split, two area code/local  
exchange combinations exist in the same region that previously had only one,  
potentially doubling the number of telephone numbers.  
Example: 201-805-1111 changes to 908-456-1111.  

 � 
 
Changes only the exchange of some of the existing telephone numbers in the  
region to the new exchange. As a result of the split, two exchanges exist in the  
same region that previously had only one, potentially doubling the number of  
telephone numbers.  
Example: 201-805 changes to 201-345.  

It is also possible to overlay the geographic area of an exhausted area code with a  
new area code without moving any exchanges to the new area code. This is called an  
area code overlay.  
Under the NANP, a telephone number consists of these three parts:  
 � 

 
a three-digit NPA, more commonly known as an area code  
• the local exchange (NXX)  
• a line number (XXXX)  

For example, NPA-NXX-XXXX represents the telephone number 212-555-1212. 
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How an Area Code Split Affects Service  
Areas for Terminations 

 
An area code split can affect a service area for a termination if it contains the old area  
code/local exchange combination. Assume, for example, that a service area with the  
area code 201 will gain a new area code, 908, in an area code split. The new 908 area  
code will be added to the service area.  
After an area code split, AT&T automatically updates your terminations for which  
service areas have changed. You do not need to update any service area for  
termination information in Customer Profile. However, you may want to review the  
information that has changed.  
For instructions on viewing the service area for a termination, see “Terminations” in  
Chapter 2, “Customer Profile,” of your AT&T Route It! Administration guide. 

 
How an Area Code Split Affects Routing  
Plans 

 
An area code split can affect call routing if branches in your routing plans contain the  
old area code/local exchange combination. Assume, for example, that a region with  
the area code 201 will gain a new area code, 908, in an area code split. You may have  
a plan that routes calls originating from the 201 area code, as shown in Figure A-1. 

 
201 

 
AREA 

 
#  

DOM 

 
INTL 

 
Figure A-1. Sample Area Code Branch—Before Update  
After the area code split, if no changes were made to your plan, it would route calls  
originating from the 201 area code along the 201 branch. Calls originating from the  
908 area code would be routed along the DOM branch. By default, this branch routes  
calls with area codes not accounted for on other Area Code branches.  
To prevent unexpected changes in call routing, AT&T automatically updates branches  
and labels in your routing plans that are affected by an area code split. It makes  
updates to your official plans stored at the host support system and also to any  
affected local plans.  
In the previous example, AT&T would automatically add area code 908 to the branch,  
as shown in Figure A-2. 
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201,908 

 
AREA 

 
#  

DOM 

 
INTL 

 
Figure A-2. Sample Area Code Branch—After Update 

 
What You Need to Do 

 
During an area code split, you should check the Comm Log for messages about the  
split process. These messages show you the status of automatic updates to your  
routing plans and also alert you to changes you may need to make. After AT&T  
updates your local routing plans, you may need to modify some local routing plans to  
eliminate errors and to ensure that your call-routing needs are being met.  
For more information on specific messages for which you should look and actions you  
may need to take, see the section “Monitoring the Area Code Split Process and  
Making Changes,” later in this appendix. 

 
The Grace Period 

 
The grace period is a transition period during which the LEC converts telephone  
numbers to the new area code. During this period, a call can be routed, regardless of  
whether its originating telephone number has transitioned to the new area code/local  
exchange combination. This period, also called the permissive dialing period, usually  
lasts several months. 

 
Changes to Your Routing Plans 

 
During the grace period, AT&T performs conversions in its network to allow call  
routing from the new and old area code/local exchange combinations. As a result,  
your plans do not have to be updated throughout to include both area code/local  
exchange combinations. For example, assume the NPA-NXX 201-805 is changing to  
908-805. Both NPA-NXXs are maintained in the AT&T network during the grace  
period, allowing your routing plans to handle calls from either area code. 
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Changes to Nodes and Labels in Your Plans 

 
At the start of the grace period, AT&T automatically converts data first in your official  
plans and then in your local routing plans. The one-time conversion of your official  
plans allows them to handle call routing during the grace period and also after the  
area code split has been completed.  
The conversion consists of updates to values and labels on branches for these nodes:  
 � 

 
Area Code  
• Exchange  
• Caller ID  

The following three sections show sample updates made to each type of branch data. 
 
Area Code Branch Update 

 
Prior to an area code split, an Area node branch contains the area codes you entered  
on that branch. The top branch in Figure A-3 represents a branch on which you  
entered one area code. 

 
201 

 
AREA 

 
#  

DOM 

 
INTL 

 
Figure A-3. Sample Area Node Branch—Before Split Update  
After an area code split, AT&T updates your local and official plans by adding new  
area codes where an area code has split. The top branch in Figure A-4 represents the  
same top branch in Figure A-3 after an area code split update. 

 
201,908 

 
AREA 

 
#  

DOM 

 
INTL 

 
Figure A-4. Sample Area Node Branch—After Split Update 
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In Figure A-4, the 201 area code region was split into two regions, adding the 908  
area code.  

NOTE :  
If the addition of new area codes on a branch exceeds the allowed field length, a  
label is created. See Chapter 5, “Labels,” for details. 

 
Exchange Branch Update  

Prior to an area code split, an Exchange node branch contains any NPA-NXX  
combination you entered on that branch. The top branch in Figure A-5 represents a  
branch on which you entered one NPA-NXX combination. 

 
201-805 

 
# 

 
EXCHANGE 

 
DEFAULT 

 
OTHER 

 
Figure A-5. Sample Exchange Node Branch—Before Split Update  
After an area code split, AT&T updates your local and official plans by replacing any  
old NPA-NXX with the new NPA-NXX. The top branch in Figure A-6 represents the  
same top branch in Figure A-5 after an area code split update. 

 
908-805 

 
EXCHANGE 

 
#  

DEFAULT 

 
OTHER 

 
Figure A-6. Sample Exchange Node Branch—After Split Update  
In this example, the 201 area code region was split into two regions, adding the 908  
area code. The NPA-NXX you entered on the top branch is now part of the new 908  
area code region.  
Also, suppose the NPA and the NXX changed; that is, a six-digit area code split  
occurred. For example, the 201 area code changed to 732, and the 805 exchange  
became 456. The top branch in Figure A-7 represents a branch on which you entered  
one NPA-NXX combination. 

 
AT&T—PROPRIETARY  

Use pursuant to Company Instructions 
 
AT&T Route It! 

 
A-5 



  

 
Appendix A  
The Grace Period 

 

201-805 
 
# 

 
EXCHANGE 

 
DEFAULT 

 
OTHER 

 
Figure A-7. Sample Exchange Node Branch—Before Six-Digit Area Code Split Update  
After a six-digit area code split, AT&T updates your local and official plans by  
replacing the old NPA-NXX combination with the new NPA-NXX combination. The top  
branch in Figure A-8 represents the same branch in Figure A-7 after a six-digit area  
code split. 

 
732-456 

 
EXCHANGE 

 
#  

DEFAULT 

 
OTHER 

 
Figure A-8. Sample Exchange Node Branch—After Six-Digit Area Code Split Update  
In this example, the 201-805 NPA-NXX combination was split into two regions, adding  
the 732-456 NPA-NXX combination. The NPA-NXX you added on the top branch is  
now part of the new 732-456 NPA-NXX region. 
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Caller ID Branch Update  

Prior to an area code split, a Caller ID node branch contains any NPA-NXX-XXXX you  
entered on that branch. The top branch in Figure A-9 represents a branch on which  
you entered one NPA-NXX-XXXX. 

 
201-555 -1212 

 
CALLER ID 

 
#  

OTHER 

 
DEFAULT 

 
Figure A-9. Sample Caller ID Node Branch—Before Split Update  
After an area code split, AT&T updates your local and official plans by replacing any  
old NPA-NXX-XXXX with the new NPA-NXX-XXXX. The top branch in Figure A-10  
represents the same top branch in Figure A-9 after an area code split update. 

 
908-555 -1212 

 
CALLER ID 

 
#  

OTHER 

 
DEFAULT 

 
Figure A-10. Sample Caller ID Node Branch—After Split Update  
In this example, the 201 area code region was split into two regions, adding the 908  
area code. The NPA-NXX-XXXX you entered on the top branch is now part of the new  
908 area code region. Had a six-digit split occurred, both the area code and the  
exchange would have been updated. 
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Plan Updates Resulting from an Area Code Split 

 
Table A-1 summarizes the changes made to branch values and labels for different  
node types. 
 
Table A-1. Plan Updates Resulting from an Area Code Split 
 
Node Type 

 
Changes to Branch Value 

 
Changes to Branch Label 

 
Area Code 

 
The new area code is added to  
the branch. 

 
The new area code is added to  
the label.  

NOTE:  
If the addition of new area  
codes on an Area Code  
branch exceeds the allowed  
field length, a label is created.  

Exchange 
 
The old NPA-NXX is replaced  
with the new NPA-NXX. 

 
The old NPA-NXX is replaced  
with the new NPA-NXX in the  
label.  

Caller ID 
 
The old NPA-NXX-XXXX is  
replaced with the new  
NPA-NXX-XXXX. 

 
The old NPA-NXX-XXXX is  
replaced with the new  
NPA-NXX-XXXX in the label. 

 
Editing Plans During the Grace Period 

 
After the update of your local plans, but before the end of the grace period, you may  
notice some differences when you create or edit routing plans in the Edit Plans task.  
During this period, if you enter an old NPA-NXX combination in a plan, AT&T Route It!  
replaces it with the new NPA-NXX combination during field validation. A status  
message indicates that the replacement is due to an area code split.  
The replacement occurs as Route It! validates the field when you have entered the old  
NPA-NXX combination in any of these branches or labels:  
 �  
 � 

 
Exchange branch  
Exchange label  
• Caller ID branch  
• Caller ID label  

In addition, after the update of your local plans, the Exchange Label Builder does not  
list old NPA-NXX combinations.  
Following the grace period, if you enter an old NPA-NXX combination, Route It!  
displays an error message stating that the exchange is not valid for the area code. 
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Monitoring the Area Code Split Process  
and Making Changes 

 
You should check the Comm Log for messages about an area code split. These  
messages notify you of any changes to your local and official data. They also help you  
to identify each stage of the area code split.  
For each step of the split process, Table A-2 shows the messages you can receive  
and identifies any action you may need to take. 

 
Table A-2. Area Code Split Messages and Activities 

 
Message 

 
Activity/Action Required 

 
NPA SPLIT. Notification received. 

 
This Comm Log message notifies you that an area code  
split will take place.  
Action Required:  
Display the detail of this message to see the following  
information:  
�the date and time AT&T is scheduled to update your  

official routing plans  
• a list of NPA-NXXs that are moving to the new area  

code/local exchange  
• the end date of the permissive dialing period  

NPA SPLIT. Official Plans updated. 
 
AT&T updates your official plans.  
AT&T also updates your company’s contact telephone  
number at the support system if it is affected by the area  
code split. 
 
! 

 
CAUTION:  
To avoid routing inconsistencies, make sure that  
users do not perform the following activities in Route  
It! during the official plan update:  
•  
•  
• 

 
create a routing plan  
modify a routing plan  
modify the service area for a termination  

Action Required:  
Display the message detail to see a list of changes made  
to your official plans. You may also want to check the  
Comm Log for a notice that the update of your local plans  
has started.  

NOTE :  
If you receive any error messages about updates to  
your official plans, contact the AT&T support center. 
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Table A-2. Area Code Split Messages and Activities (Cont’d) 

 
Message 

 
Activity/Action Required 

 
LOCAL NPA SPLIT. Updating local  
data for all accounts. 

 
This message triggers the local NPA split process and  
informs you that it has started.  
AT&T begins updating your local plans. 
 
! 

 
CAUTION:  
While your local plans are being updated, do not  
perform the following activities in Route It!:  
•  
•  
• 

 
create a routing plan  
modify a routing plan  
modify the service area for a termination  

During the update, access to Route It! may be  
temporarily interrupted.  

Action Required:  
None.  

NOTE :  
You may display the detail of this message to see  
the following NPA split information:  

• IDs of affected accounts  
• grace period (start and end dates) for each split  
• old affected area code/exchanges and new area  

code/exchanges  
• first LEC conversion date  

LOCAL NPA SPLIT. Local data  
updated. 

 
AT&T has successfully completed the update of your  
local plans.  

NOTE :  
You can resume use of all Route It! functions.  

Action Required:  
Display the message detail to see a list of changes made  
to your local plans. You may also want to check your  
local plans to make sure that they reflect your routing  
objectives. 
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Table A-2. Area Code Split Messages and Activities (Cont’d) 

 
Message 

 
Activity/Action Required 

 
LOCAL NPA SPLIT. Local data  
updated.EXCEPTIONS. 

 
AT&T has completed the update of your local plans, but  
not all plans were updated, most likely because of errors  
contained in one or more plans.  

NOTE :  
You can resume use of all Route It! functions.  

Action Required:  
To see which plans were not updated, display the mes-  
sage detail. You may need to correct validation errors.  

LOCAL NPA SPLIT FAILED. Local  
data not updated. 

 
AT&T could not update your local plans because of  
errors in the plans.  

NOTE :  
You can resume use of all Route It! functions.  

Action Required:  
For help in resolving this situation, contact the AT&T  
support center.  

NPA SPLIT COMPLETE. Grace  
period ended. 

 
The area code split has been completed. The grace  
period ends.  
Action Required:  
None.  

NOTE :  
Route It! will no longer accept the old area code/local  
exchanges when creating or editing routing plan  
branches. 
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Country Code Updates 

 

 
This appendix explains possible changes made to your routing plans when a new  
country code is created for a geographic region. 

 
What Is a Country Code Update? 

 
When service is opened to a new International carrier, a country code is established  
which identifies the carrier of the international telephone service. These country codes  
are used to support the Geographic Routing feature, Country Code Routing.  
Country Code Routing enables you to direct calls to different terminations based upon  
the country where the call originates. Country Code Routing is implemented via the  
Area node in your routing plan. The feature is provisioned using terminations and area  
code branches.  
� 

 
Terminations are provisioned with service areas, which define the country codes  
from which the termination is allowed to receive incoming calls.  

� 
 
Area code branches within the call routing plan are provisioned with country  
codes. These branches route the call to the appropriate termination. 

 
How a Country Code Update Affects Service  
Areas for Terminations 

 
A country code update can affect a service area for a termination when it does not  
contain the new country code. When a new country code is made available, any pre-  
existing termination which has “All” country codes selected in its service area must be  
updated. For example, a termination references “All” country codes in their service  
area. The new country code will be added to the service area.  
After a country code update, AT&T automatically updates your terminations for which  
service areas have changed. You may want to review the information that has  
changed.  
For instructions on viewing the service area for a termination, see “Terminations” in  
Chapter 2, “Customer Profile,” of your AT&T Route It! Administration Guide. 
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How a Country Code Update Affects Routing  
Plans 

 
Country code updates will not affect call routing. Area Code nodes are required to  
have a default “INTL” branch when routing to a termination with International service  
type. If branches in your routing plans do not contain the new country code, the INTL  
branch will handle the call routing. 

 
What You Need to Do 

 
During a country code update, you should check the Comm Log for messages about  
the country code update process. These messages show you the status of automatic  
updates to your official routing plans. After AT&T updates your local routing plans, you  
may need to modify some local routing plans to ensure that your call-routing needs  
are being met.  
For more information on specific messages for which you should look and actions you  
may need to take, see the section “Monitoring the Country Code Updates and Making  
Changes,” later in this appendix.  

NOTE :  
Only official routing plans will be re-validated and re-sent to the NCP. 

 
Monitoring the Country Code Update  
Process and Making Changes 

 
You should check the Comm Log for messages about the country code update  
process. These messages notify you of any changes to your official data. They also  
help you to identify each stage of the country code update process.  
For each step of the country code update process, Table B-1shows the messages you  
can receive and identifies any action you may need to take. 
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Table B-1.  Country Code Update Messages and Activities 

 
Message 

 
Activity/Action Required 

 
CC ADD. Notification received. 

 
This Comm Log message notifies you that a country  
code update will take place.  
Action Required:  
Display the detail of this message to see the following  
information:  

• the date and time AT&T is scheduled to update  
your official routing plans and terminations.  

• the Country Code(s) that are scheduled to be  
added.  

NOTE :  
Terminations with “ALL” country codes selected in  
their service area will be updated to include the new  
country code.  

CC ADD. Official Plans updated. 
 
AT&T updates your official plans. 
 
! 

 
CAUTION:  
To avoid routing inconsistencies, make sure that  
users do not perform the following activities in Route  
It! during the official plan update:  
•  
•  
• 

 
create a routing plan  
modify a routing plan  
modify the service area for a termination  

Action Required:  
Display the message detail to see a list of changes made  
to your official routing plans.  

NOTE :  
If you receive any error messages about updates to  
your official plans, contact the AT&T support center. 
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A 
 
Access Line   

The telephone line that permanently connects one of your  
terminations with the

 
Local Exchange Carrier

 
or your 

 
Private Branch  

Exchange
 
. Each termination is associated with a unique access line.  

(An access line is made up of five characters: The first character is an  
uppercase letter, and the last four characters are numeric. For  
example, M3788.)  

Account ID  
A unique customer account identifier.  
(An Account ID is made up of 10 digits: The first three are always  
999. For example, 999-000-3001.)  

Active Plan  
The 

 
plan that is currently being used to route calls, as determined by  

the plan schedule.  
Active Service Date  

The latest pastService Date for which the Auto Activate indicator is  
set to YES. The date may also be the current date. See also 

 
Service  

Date
 
.  

ADR  
See 

 
Alternate Destination Routing 

 
.  

ADR Node   
A 

 
node that allows calls to be redirected to an alternate termination if  

they are not answered at the primary destination in a predefined  
period. It also allows calls to be redirected if network congestion or  
egress

 
failure prevents the calls from going to the target termination.  

Advanced Features  
The Global Transaction Network call-routing features, also known as  
Advanced Toll-Free Features. See also

 
Custom Routing Features

 
.  

ALL BUSY  
The condition in which all terminations in an 
Sequence

 
are busy. 

 
Alternate Termination  

 
Allocator Node  

A 
 
decision node that allocates percentages of calls to two or more  

call-processing paths. 
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Alternate Destination Routing (ADR)   

An AT&T Advanced Feature that allows you to redirect calls to an  
alternate termination rather than to the primary destination if not  
answered in a predetermined period or if calls cannot be completed to  
the primary termination because of network congestion or

 
egress  

failure. 
Alternate Termination Sequence (ATS)   

An AT&T Advanced Feature, available as a routing plan node, that  
allows you to specify a sequence of alternate terminations to which  
calls can be rerouted when the previous terminations in the sequence  
are busy or unable to answer calls. This feature tries each alternate,  
in sequence, until an available termination is found, or until the  
sequence is exhausted, at which time a customer-specified treatment  
is applied. 

ANI  
See 

 
Automatic Number Identification 

 
.  

Announcement Name  
An optional name you can use to simplify identification of  
announcements. The default name is the

 
announcement number

 
.   

(An announcement name can consist of up to 16 alphanumerics,  
including the symbols # $ . , % & _ - + ’. The first character must be a  
letter. For example, GREETING&ADV.)  

Announcement Number  
A unique number, 1 through 65,535, that identifies an announcement  
within a particular

 
announcement set

 
.  

Announcement Set  
The machine on which all your account announcements reside.  
(This site is identified by a single letter, A to G, S, or the generic  
identifier X.)  

Area Code Split  
A process in which new area code/exchange combinations are  
created in a geographical area. Area code splits are implemented to  
increase the number of available telephone numbers. During an area  
code split, one of the following can happen:  
• An existing exchange moves to a new area code. For example,  

908-460 changes to 732-460.  
• An exchange moves to a new exchange within the same area  

code. For example, 908-949 changes to 908-351.  
• An area code/exchange pair moves to a completely new area code/  

exchange combination. For example, 908-460 changes to 732-  
351. 
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Area/Country Code Routing   

An AT&T Advanced Feature that allows you to specify different  
routes for calls that originate in different geographical areas, as  
defined by one or more area codes or, for I800 Service only

 
country  

codes 
 
. 

Area Node   
A 

 
decision node that routes calls according to the originating area  

code 
 
Numbering Plan Area

 
or, for I800 Service only, to the originating  

country code
 
.  

ATS  
See 

 
Alternate Termination Sequence 

 
.  

ATS Node  
A 

 
node that defines a sequence ofATS-type terminations for  

receiving calls or, when no termination is available, holds a call within  
an assigned network

 
queue

 
.  

ATS-Type Termination  
A termination to which calls can be rerouted when the previous  
terminations in the sequence are busy or unable to answer calls.  

AT&T Customer Direct  
A software package that formerly provided a common means to  
access and manage information you received from several AT&T  
network services. Also referred to as the AT&T Customer Direct  
platform. Was omitted as a software requirement by Release 98.1 of  
the AT&T Route It! software.  

Automatic Number Identification (ANI)  
A number that identifies the origin of a phone call.  
(An ANI is made up of 10 digits, separated by hyphens. For example,  
908-555-8056.)  

Automatic Number Identification (ANI) Routing  
The process of routing a call based upon the number from which the  
call originated. 

 
Autonomous Message  

A message, viewable from the Comm Log, generated by the
 
support  

system
 
and sent to the PC autonomously—independently of any  

transaction from your PC. 
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B 
 
Branch   

A call-routing treatment coming out of anode in a 
 
plan 

 
diagram; that  

is, a line segment in a call-routing
 
plan

 
diagram that forms a routing  

path by connecting one
 
node

 
to another

 
node

 
. 

 
C 

 
Call Path  

In a 
 
routing plan, the series of nodes and branches through which a  

call travels to get from the
 
root node

 
to the

 
terminating node 

 
.  

Call Prompter  
An AT&T Advanced Feature that allows callers to route their own  
calls to one of several destinations by entering one or more digits in  
response to a prompting announcement stored in the network.  

Call Type Node  
A 

 
routing plan node that directs calls to either a voice or a data call-  

processing path. (Currently not supported by AT&T Canada Long  
Distance Services.)  

Caller Entered Digits (CEDs)  
The digits entered by a caller in response to prompter or digit  
prompter announcements.  

Caller ID Node   
A 

 
decision node that routes calls according to the caller’s billing  

number (the full 10-digit
 
ANI

 
number).  

Caller Information Forwarding (CINFO)  
An AT&T Advanced Feature that allows special information to be  
forwarded with a call when it is routed to a termination. With CINFO,  
Caller Entered Digits

 
are collected and passed on with a call.  

Caller Recognition Routing  
An AT&T Advanced Feature that allows you to route a call based  
upon the number from which the call originated.  

CC  
See 

 
Country Code . (Currently not supported by AT&T Canada Long  

Distance Services.)  
CEDs  

See 
 
Caller Entered Digits 

 
. 
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CED Aggregation   

A field that specifies the wayCaller Entered Digits  
forwarding to you. Possible values are: 

 
are collected for  

 
• To aggregate CEDs for all Digit Prompter nodes in each call-  

processing path, select Digit Prompter Only.  
• To aggregate CEDs for all Prompter and Digit Prompter nodes,  

select All.  
• To collect only the digits from the last Digit Prompter node, select  

None.  
CINFO  

See 
 
Caller Information Forwarding 

 
.  

CIP (Calls in Progress) Counter  
A counter, maintained by the network, that records the number of  
simultaneous calls in progress at an

 
ATS-type termination

 . Each 
 

ATS-type termination
 
has its own CIP counter.  

CIP Time  
The time that the CIP counter for an account will be reset to 0. The  
time is always central standard time.  
The format of the CIP Time field is hh:mmxx, where hh represents  
the hour (1 to 24), mm represents minutes (always 00), and xx  
represents a.m. or p.m.  

Connecting Node  
A 

 
node that connects an incomplete routing path in one portion of a  

routing plan
 
to a

 
feature node

 
in another routing path in the same  

plan 
 
.  

Country Code (CC)  
An abbreviation used to identify a country name. (Currently not  
supported by AT&T Canada Long Distance Services.)  
A country code is made up of two alphanumerics, usually an  
abbreviation of a country’s name.  

Courtesy Response  
An AT&T Advanced Feature that allows you to direct calls to an  
announcement as the final handling for the call.  

CRP  
See 

 
Customer Routing Point . (Currently not supported by AT&T  

Canada Long Distance Services.) 
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CRP Code  

A unique number used in a CRP table to identify a termination, an  
announcement, a ring tone, or a busy signal.  
(A CRP code can consist of up to 10 numbers. Each CRP code  
contained in the same CRP table must be the same length. For  
example, a CRP table might contain the CRP codes 001246, 027629,  
and 100475.)  

CRP ID  
A unique number used to identify a CRP database.  
(A CRP ID consists of six digits. For example, 625010.)  

CRP Name  
A unique name you can specify for a CRP database to more easily  
identify it.  
(A CRP name can consist of up to 16 characters, including any  
letters, numbers, and the symbols # $ . , % & _ - + ’. The first  
character must be a letter. For example, SALES&CUST.SERV.)  

CRP Node  
A 

 
routing plan node that provides routing instructions on a call-by-call  

basis. It receives information about a call, such as the calling number  
or area code, and queries a database table to determine where to  
route the call. 

CRP Query  
The process of consulting the database containing your routing  
information.  

CRP Table Name  
A unique name you can specify for a CRP table to more easily identify  
it.  
(A CRP table name can consist of up to 16 characters, including any  
letters, numbers, and the symbols # $ . , % & _ - + ’. The first  
character must be a letter. For example, DEPARTMENT.TERM .)  

Custom Routing Features  
The name AT&T Canada Long Distance Services uses for 

 
Advanced  

Features.  
Customer Routing Point (CRP)  

The term used to refer to the database containing your routing  
information. This database is used as part of

 
Intelligent Call  

Processing.
 
(Currently not supported by AT&T Canada Long  

Distance Services.) 
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D 
 
Data Rate Node   

A 
 
routing plan node that routes data calls based on their rate of data  

transfer. (Currently not supported by AT&T Canada Long Distance  
Services.)  

Day Manager   
An AT&T Advanced Feature that allows you to specify call routing  
based on the day of the week.  

Day Node  
A 

 
decision node 

 
that routes calls according to the day of the week.  

Decision Node  
A category of 
decision

 
node

nodes that implements AT&TAdvanced Features 
routes calls based on call input. 

 
. A  

 
Dedicated Egress  

A 
 
Local Exchange Carrier 

termination. 

 
that connects the AT&T network and a  

 
Dialed Number  

The toll-free service number dialed by the caller to reach a  
destination.  
(A dialed number is made up of 10 hyphen-separated digits. For  
example, 800-555-8767.)  

Dialed Number Decision   
An AT&T Advanced Feature that allows you to specify call routing  
based on the toll-free

 
dialed number

 
.  

Dialed # Node  
A 

 
decision node 

number
 
. 

 
that routes calls according to the toll-free  

 
dialed  

 
Dialog Box  

An interactive window on your PC through which you can enter or  
select information from a variety of input fields, lists, and buttons.  

Digit Prompter Node  
A 

 
routing plan node that prompts a caller with a recorded  

announcement to enter digits corresponding to specific customer  
information, such as a customer account number.  

Direct Connect Egress  
A direct physical connection of the AT&T network to a termination. 
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E 
 
Egress  

The physical connection between the AT&T network and a  
termination. The types of physical connections are:  
• Switched  
• Dedicated to 

 
Local Exchange Carrier  

• Direct Connect  
• International  

Enroute Announcement  
An AT&TAdvanced Feature 
to a caller. 

 
that allows you to play an announcement  

 
Enroute Node  

A 
 
decision node that plays an announcement to a caller, then  

continues call processing to the next
 
node

 
in the path.  

Exchange  
The exchange code portion of a telephone number that immediately  
follows the area code portion and is determined by the geographical  
area of the caller.  
The exchange portion of a telephone number is represented by the  
NXX 

 
in

 
NPA-NXX-XXXX

 
.  

Exchange Node  
A 

 
decision node 

exchange
 
. 

 
that routes calls according to the originating  

 
Exchange Routing  

An AT&T Advanced Feature that allows you to specify call routing  
based on the geographical area of the originating number, as defined  
by the 

 
exchange

 
. 

 
F 

 
Feature Name  

The AT&T 
 
Advanced Feature 

 
associated with a 

 
node 

 
.  

Feature Node  
A 

 
node at which the implementation of an AT&T 

determines call routing. 

 
Advanced Feature  

 
Final-Handling Arrangement  

The final handling of toll-free calls. The possibilities are: 
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• Courtesy Response  
• No Answer (Ring or Busy)  
• Termination  

Final-Handling Node   
A 

 
node that routes a call to a terminating toll-free 

announcement. 

 
access line  

 
or an  

 
Fix Queue Node   

A 
 
node that directs calls (destined for one specific 

 
ATS-type  

termination
 
) into a

 
fixed queue

 
within the AT&T network. An  

announcement or music can be played for the caller while in
 
queue

 
.  

(Currently not supported by AT&T Canada Long Distance Services.)  
Fixed Queue  

A 
 
Network Queuing feature, available as a routing plan node , that  

enables you to
 
queue

 
calls (for an

 
ATS-type termination 

 
) within a  

fixed 
 
queue

 
of the network until the termination served by that

 
queue  

is available to receive that call. (Currently not supported by AT&T  
Canada Long Distance Services.)

 
G 

 
Go To Node  

A 
 
connecting node that redirects call processing to another 

within the same
 
plan

 
. 

 
node  

 
I 

 
ICP   

See 
 
Intelligent Call Processing . (Currently not supported by AT&T  

Canada Long Distance Services.)  
Intelligent Call Processing (ICP)  

An AT&T Advanced Featur e that allows you to implement  
specialized, call-by-call routing based on information in your own  
custom database. (Currently not supported by AT&T Canada Long  
Distance Services.)  

Inter-Nodal Validation  
A process that ensures that a call-routingplan meets all system and  
call-routing requirements. This type of validation is performed at the  
host support system.  

Intra-Nodal Validation  
The process of ensuring that the appropriate entry for a

 
node type,  

node specific data, or
 
branch

 
type is correct. This form of validation is  

performed by AT&T Route It! 
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L 
 
Label   

A name that can represent one or more values or names for anode  
or 

 
branch

 
within a

 
routing plan

 
. Labels are used to group names or  

values to be routed identically in a
 
plan

 
.  

(A label can consist of up to 16 alphanumerics, including the symbols  
# $ . , % & _ - + ’. The first character must be a letter. For example,  
BIG$CUSTOMERS.)  

Label Builder  
The 

 
dialog box from which you create 

names for a
 
node

 
or

 
branch

 
field. 

 
labels 

 
to group values or  

 
LEC  

See 
 
Local Exchange Carrier 

 
.  

Local Exchange Carrier (LEC)  
A telephone company, the first point of call processing, that provides  
local and intrastate telephone service. The LEC switch receives a  
dialed number

 
from the caller and routes it, usually, to the 

 
Originating  

AT&T Switch
 
.  

Local Plan  
A call-routingplan stored on a PC but not yet sent to the  
system

 
for

 
validation

 
. 

 
support  

 
M 

 
Maximum Calls Allowed (MCA)  

The maximum number of simultaneous calls an  
may handle at a given date and time. 

 
ATS-type termination 

 
An MCA value must not exceed the number ofegress  
termination. The default MCA matches the number of  
a termination. 

 
lines at a  

egress 
 
lines at  

 
Maximum Calls in Queue (MCQ)  

The maximum number of calls that can be simultaneously queued  
(within a network

 
queue

 
) for an

 
ATS-type termination 

 
. (Currently not  

supported by AT&T Canada Long Distance Services.)  
An MCQ value must not exceed the number of 
for a 

 
queue

 
. 

 
queue  

 
slots purchased  

 
MCA  

See 
 
Maximum Calls Allowed 

 
. 
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MCQ   

See 
 
Maximum Calls in Queue . (Currently not supported by AT&T  

Canada Long Distance Services.) 

 
N 

 
NAAR  

See 
 
Next Available Agent Routing 

 
.  

NCP  
See 

 
Network Control Point 

 
.  

Network  
The AT&T transaction network that manages your

 
Toll-Free Services 

The network stores your
 
routing plans

 
and announcements, and  

routes calls according to your schedules. 

 
.  

 
Network Control Point (NCP)  

A computer system with a database containing call-processing logic  
and information for routing, billing, and network control.  

Network Queuing  
An AT&T Advanced Feature that allows a call to be held in 

 
queue in  

the network until an
 
ATS-type termination

 
served by the 

 
queue

 
is  

available to receive the call. With this feature, you can route calls to a  
delay announcement and music while calls are held in the AT&T  
network. (Currently not supported by AT&T Canada Long Distance  
Services.) 

Network Time   
The central standard time employed by thesupport system  
Network Control Points

 
of the Global Transaction Network.

 
and  

 
Next Available Agent Routing (NAAR)  

An AT&TAdvanced Feature that allows you to specify a sequence of  
alternate terminations to which calls can be rerouted when the  
previous terminations in the sequence are busy or unable to answer  
calls.  

No Answer Node  
A 

 
terminating node 

 
that directs calls to a ringing or busy tone.  

Node  
The representation of a particular feature in a call-routing

 
plan . A  

node is a decision point in a
 
plan

 
at which call-routing assignments  

occur, or where a particular
 
branch

 
from the node is chosen. A node  

can also be a termination point. 
NPA  

See 
 
Numbering Plan Area 

 
. 
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NPA-NXX-XXXX   

A telephone number as defined by the North American system for  
assigning telephone numbers.

 
NPA

 
represents the area code, 

 
NXX  

represents the
 
exchange

 
, and

 
XXXX

 
represents the individual line.  

See also
 
Numbering Plan Area

 
. 

NPA Split  
See 

 
Area Code Split 

 
.  

Numbering Plan Area (NPA)  
The area code. Indicates a particular calling region.  

NXX (Exchange Area)  
The 

 
exchange 

 
code portion of a telephone number. 

 
O 

 
OAS  

See 
 
Originating AT&T Switch 

 
.  

Official Plan  
A call-routingplan 
support system

 
. 

 
that has been successfully validated at the  

 
Originating AT&T Switch (OAS)  

A switch in the Common Channel Signaling (CCS) network that  
detects a call, then requests call-routing instructions from a remote  
database, the

 
Network Control Point

 
.  

Override Plan   
An external routing plan, residing at the Network Control P 

 
oint,  

designated as an override plan and available for activation on  
demand. Override plans can be used to quickly change the active  
routing plan

 
for the current call-processing environment. 

 
P 

 
PACR  

See 
 
Post Answer Call Redirection 

Canada Long Distance Services.)

 
. (Currently not supported by AT&T  

 
PBX  

See 
 
Private Branch Exchange 

 
.  

Plan  
A diagram that defines how calls will be routed. A plan is composed o 
nodes 

 
and

 
branches

 
and their associated values, names, and

 
labels

 
.  
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Post Answer Call Redirection (PACR)   

An AT&T Redirect Feature that enables agents to use their  
telephones to transfer callers to other agents. (Currently not  
supported by AT&T Canada Long Distance Services.)  

Post Feature Code   
A code that is used withIntelligent Call Processing  
processing provided in the path of a

 
routing plan 

 
. 

 
for additional call  

 
Private Branch Exchange   

A small telephone switching system located at your private premises  
and connected to a

 
Local Exchange Company

 
.  

Prompter Node  
A 

 
decision node that prompts a caller with a recorded announcement  

and routes the call according to the caller’s responses. 

 
Q 

 
Queue  

A storage location within the AT&T network for temporarily holding  
calls that cannot be immediately routed to an

 
ATS-type termination  

that is currently busy or unavailable.  
Quick Call Allocator  

An AT&T Advanced Feature that allows you to change the  
percentage of calls to be routed to each of two or more answering  
locations in five minutes or less.  

Quick Change  
A routing capability that allows you to quickly:  
• specify an MCA override value for an 

 
ATS-type termination  

• change MTQ  
• specify a different MCQ value for a network 

 
queue  

• activate an override 
 
routing plan  

• specify different distribution percentages for the 
 
branches 

 
of an  

Allocator node  
• change the query status of a CRP database  
• undo any of the above quick changes  

Quick Change Mode  
An edit mode that allows you to make a 

 
quick change 

 
to a 

 
plan 

 
. 
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R 
 
RCP   

See 
 
Recurrent Call Prompter. (Currently not supported by AT&T  

Canada Long Distance Services.)  
Recurrent Call Prompter (RCP)   

An AT&T Redirect Feature that enables agents to return toll-free  
callers to the initial

 
call prompter

 
announcement, from which they can  

reach other agents. (Currently not supported by AT&T Canada Long  
Distance Services.)  

Redirect Feature  
An AT&T feature that allows your agents to use the AT&T network to  
redirect toll-free calls after they have answered them.  

Response Node  
A 

 
terminating node 

final handling. 

 
for directing calls to a recorded announcement as  

 
Ring/Busy  

An AT&T Advanced Feature that allows you to direct calls to an  
audible ring or busy tone. This is a

 
final-handling arrangement

 
.  

Root Node  
The first 

 
node 

 
in a 

 
routing plan 

 
.  

Routing Plan  
A diagram that defines how calls will be routed. A routing plan is  
composed of

 
nodes

 
and

 
branches

 
and their associated values,  

names, and
 
labels

 
.  

Routing Telephone Number (RTN)  
A telephone number for inbound service used to route calls to one of  
your terminations.  
(An RTN consists of 10 digits separated by hyphens. For example,  
629-555-9565.)  

RTN  
See 

 
Routing Telephone Number 

 
. 
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S 
 
Schedule Set   

A set of one or more dialed numbers, all of which use  
from the same plan schedule for call processing. 

 
routing plans  

 
(A schedule set can consist of up to 16 alphanumerics, including the  
symbols # $ . , % & _ - + ’. The first character must be a letter. For  
example, SALES#SET.)  

Service Area  
A geographical region for which you have purchased service  
coverage.  

Service Date  
An effective date of service that defines your network capabilities for  
one or more

 
Routing Telephone Numbers

 
at the

 
support system

 
and  

Network Control Point
 
.  

The format for the Service Date field is mm/dd/yy, where mm  
represents the month, dd represents the day, and yy represents the  
year.  

Service View  
The current view of your service, as determined by the currently  
selected

 
Account ID

 
and

 
Service Date

 
.  

Shortcut Menu  
A menu that can be used to create, edit, and delete

 
nodes and  

branches
 
without moving your mouse. The Shortcut menu is  

accessed by clicking your right mouse button on a
 
node 

 
or 

 
branch 

a 
 
routing plan

 
. 

 
in  

 
SMW ID  

Service Management Workstation identification number associated  
with Route It! installation. Must be unique for each PC or workstation. 

 
Status  

An indication in the Comm Log window that identifies a log entry as  
one of the following:  
• Successfully completed  
• Successfully validated  
• Failed  
• Autonomous 
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• Pending at PC  
• Validating at AT&T  

Support System  
The network component that receives your data and service data,  
combines that data into customer records, and transmits those  
customer records to the

 
Network Control Point

 
.  

Switched Egress  
The switch between the AT&T network and a termination.  

System-Defined Value   
A value required duringplan building for a branch 

 
field. The value is  

necessary for proper call routing. For example, a branch often must  
contain the value DEFAULT in order to handle calls not specified by  
the other

 
branches

 
. 

 
T 

 
Term Node  

A 
 
terminating node 

calls. 

 
that specifies a non- 

 
ATS 

 
termination for receiving  

 
Terminating Node  

A category of routing plan nodes used to represent features that  
perform some final process or action on a call, then terminate the call.  

Terminating Number  
The telephone number that represents the set of

 
egress telephone  

lines to your premises for the ultimate receipt and handling of a call.  
Termination Routing Number (TRN)   

A number used by a telephone switch to route a call to an 
line 

 
. 

 
access  

 
(TRNs consist of 10 digits for domestic and 7 to 15 digits for  
international, separated by hyphens. For example,  
616-555-9647.)  

Terminating Routing Number Translation (TRNT)  
A service that provides your answering agents detailed information  
about incoming calls before they are answered. There are two types  
of TRNT services you can purchase for a termination:  
• Call Origin  
• Call Type 
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Termination Name  

A name you can assign to a termination to simplify identification.  
(A termination name can consist of up to 16 alphanumerics, including  
the symbols # $ . , % & _ - + ’. The first character must be a letter. For  
example, RING.NO.ANSWER.)  

Time Manager   
An AT&T Advanced Feature that allows you to specify call routing  
based on time intervals within a day.  

Time Node  
A 

 
decision node 

 
that routes calls according to the time of day.  

Toll-Free Service  
A family of services that offers calls at no charge to the caller.  
Businesses typically use Toll-Free Services to help sell and market  
their products.  

Transaction Request  
A request you make to the  
routing. 

 
support system 

 
to initiate or change call 

 
A message describing this request appears in the Comm Log. For  
example, if you send a request for a

 
Quick Call Allocator 

 
change, the  

Comm Log will display a message similar to this:  
— Quick Change: Modify alloc % for Plan [Plan Name].  

Transaction Response  
The response thesupport system sends to you following the success  
or failure of a transaction you requested. This response appears in  
the Comm Log.   
The message consists of a description of the success or failure of the  
requested transaction. For example, if you have sent a request for a  
Quick Call Allocator

 
change, the Comm Log will display a message  

similar to one of these:  
— Quick Change: Alloc % in Plan [Plan Name] Modified.  
— Quick Change of Alloc % failed.  

Transfer Connect  
An AT&T Redirect Feature that enables agents to use their phones to  
transfer callers to other agents.  

TRN  
See 

 
Termination Routing Number 

 
.  

TRNT  
See 

 
Terminating Routing Number Translation 

 
. 
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U 
 
UIFN  

See 
 
Universal International Freephone Numbering 

 
.  

Universal International Freephone Numbering (UIFN)  
A scheme that allows a caller to dial the same numbering format for a  
toll-free call, regardless of the country from which the call originates.  
This allows the same toll-free number to be dialed universally. This  
numbering scheme requires that the traditional 10-digit dialed number  
be expanded to 11 digits, that is, 800-XXX-XXXXX. Only the  
International Access Code that precedes the UIFN number will  
remain specific to the country of origin. 

 
V 

 
Validation  

A process that ensures that a call-routingplan meets all system and  
call-routing requirements. Validation is performed by Route It! and at  
the host support system.  

Var Queue Node  
An 

 
ATS-type node that directs calls into a network queue  

not supported by AT&T Canada Long Distance Services

 
. (Currently  

 
Variable Queue  

A 
 
Network Queuing feature that enables you to direct calls for one or  

more 
 
ATS-type terminations

 
in a network variable 

 
queue 

 
until a  

termination served by that queue is available to receive the call.  
(Currently not supported by AT&T Canada Long Distance Services.) 
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A  
Adding  

branches 4-9  
CRP codes to a CRP table 6-9  
future changes 6-22  
nodes 4-10  

ADR node 3-3  
ADR. See Alternate Destination Routing node  
Allocator node  

rules 3-7  
Alternate Destination Routing (ADR) (United States) 1-5  
Alternate Destination Routing node  

Label Builder for 5-7  
rules 3-5  

Alternate Termination Sequence (ATS)  
Canada 1-8  
United States 1-5  

Alternate Termination Sequence (ATS) (United  
States) 1-5  

Alternate Termination Sequence node 3-10  
Label Builder for 5-9  
rules 3-10  

Announcements  
replacing 4-62  

Area Code label  
adding another Area Code label to 5-41  
Map window 5-35  
Textual Display window 5-35  

Area code overlay A-1  
Area Code Routing (Canada) 1-8 

 
Enroute Announcement 1-9  
Exchange Routing 1-9  
Quick Call Allocator 1-9  
Ring/Busy 1-9  
Time of Day 1-9  

AT&T Advanced Features (United States) 1-5  
Alternate Destination Routing (ADR) 1-5  
Alternate Termination Sequence (ATS) 1-5  
Area Code/Country Code Routing 1-5  
Call Prompter 1-5  
Caller Information Forwarding (CINFO) 1-6  
Caller Recognition Routing 1-5  
Courtesy Response 1-6  
Day Manager 1-6  
Dialed Number Decision 1-6  
Enroute Announcement 1-6  
Exchange Routing 1-6  
Intelligent Call Processing (ICP) 1-6  
Network Queuing 1-7  
Quick Call Allocator 1-7  
Ring/Busy 1-7  
Time Manager 1-7  

AT&T READYLINE  
Canada 1-3  
United States 1-2  

AT&T Toll-Free Calling Services  
Canada 1-3  
United States 1-2  

ATS. See Alternate Termination Sequence node  
Autobuild 4-5  
Autonomous message 7-1 

 
Area code split A-1, B-131  

Area Code branch update A-4  
Caller ID branch update A-7  
editing plans A-8  
Exchange branch update A-5  
grace period A-3  
monitoring A-9, B-141  

Area Code/Country Code Routing (United States) 1-5  
Area node  

rules 3-8  
AT 1-3  
AT&T Advanced Features (Canada) 1-8  

Alternate Destination Routing (ADR) 1-8 

 
B  
Branches  

adding 4-9  
deleting 4-11  
fields 3-4  

displaying detail data about 4-38  
editing 4-12  
typing data into 4-18  

finding 4-56  
inserting 4-9  

Alternate Termination Sequence (ATS) 1-8  
Call Prompter 1-8  
Caller Information Forwarding 1-8  
Caller Recognition Routing 1-8 

 
C 

 
Courtesy Response 1-8 

 
Call Prompter  

Day of Week 1-8 
 
Canada 1-8  

Dialed Number Decision 1-9 
 
United States 1-5 
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Call Type node  

rules 3-12 

 
plans 4-6  

CRP node  
Caller 1-6 

 
rules 3-14  

Caller ID node 
 
CRP tables  

Label Builder for 5-11 
 
assigning CRP databases to 6-28  

rules 3-13 
 
closing 6-36  

Caller Information Forwarding  
Canada 1-8 

 
copying 6-11  
CRP codes  

United States 1-6 
 
adding 6-9  

Caller Recognition Routing 
 
finding 6-8  

Canada 1-8 
 
modifying 6-9  

United States 1-5 
 
removing 6-11  

Canada Northbound (Canada) 1-4  
Cascade command 2-3 

 
deleting 6-35  
displaying information about 6-29  

Change Node command 4-22 
 
displaying names or IDs 6-32  

Choices button 2-4 
 
opening 6-3  

Choices dialog box 4-3, 4-14 
 
renaming 6-13  

Choices toolbar 4-3, 4-14 
 
rules for 6-2  

CINFO. See Caller Information Forwarding 1-6, 1-8  
Classic 800 

 
saving 6-14  
searching for 6-6  

Canada 1-3 
 
sending 6-15  

United States 1-2 
 
Custom Routing. See AT&T Advanced Features  

Closing 
 
(Canada) 1-8  

CRP tables 6-36 
 
Customizing  

future changes tables 6-36  
plans 4-47 

 
Comm Log 7-14  
Edit Plans window 4-70  

Comm Log 
 
Map window 5-39  

displaying messages 7-2 
 
CustomNet  

filtering 7-9 
 
Canada 1-4  

message detail 7-5 
 
United States 1-3  

message list 7-2  
message types  

autonomous message 7-1  
transaction request 7-1 

 
D   

transaction response 7-1  
printing 7-11  
properties 7-14 

 
’
 
7-15  

purging 7-15  
removing a filter 7-11  
saving messages 7-13  
size of 7-15  

Connecting nodes 3-3  
Copying  

CRP tables 6-11  
labels 5-29  
plan portions 4-52  

Courtesy Response  
Canada 1-8  
United States 1-6  

Courtesy Response (United States) 1-6  
Creating  

CRP tables 6-3  
future changes tables 6-16  
labels 5-5  

Data Rate node  
Label Builder for 5-14  
rules 3-16  

Day Manager (United States) 1-6  
Day node  

rules 3-18  
Day of Week (Canada) 1-8  
Deleting  

branches 4-11  
labels 5-31, 5-33  
nodes 4-11  
plans 4-66  

Dialed Number Decision  
Canada 1-9  
United States 1-6  

Dialed Number node  
Label Builder for 5-16  
rules 3-19  

Digit Prompter node  
rules 3-20
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Displaying  

Comm Log messages 7-2 

 
in a future changes table 6-22  

nodes 4-56  
detail data about node or branch fields 4-38 

 
Route It! information xxii  

label contents 5-27 
 
Fix Queue node 3-23  

multiple windows 2-3 
 
Fixed Queue node  

names or IDs 
 
rules 3-23  

in a CRP table 6-7  
in a future changes table 6-21 

 
FTS2000 (United States) 1-3  
Future changes  

in a plan 4-11 
 
adding 6-22  

summary information about a plan 4-69 
 
modifying 6-23  

toolbars 2-2, 4-71 
 
removing 6-25  

Documentation 
 
Future changes tables  

ordering xxv  
updates xxvi 

 
changing the date of 6-25  
creating 6-16  

Drag-and-drop editing 4-54 
 
deleting 6-35  
opening 6-18  
saving 6-26  

E 
 
searching for 6-20  
sending 6-27  

Edit Plans  
quitting 4-47  

Editing  
allocator branch fields 4-29  
branch fields 4-12 

 
G  
Go To node  

drag-and-drop 4-4, 4-53  
node fields 4-12 

 
’ 
 
4-54 

 
rules 3-24  

Grace period  
Enroute Announcement 

 
area code split A-3  

Canada 1-9 
 
editing plans A-8  

United States 1-6  
Enroute node  

rules 3-21  
Exchange 1-6 

 
H  

Exchange node  
Label Builder for 5-19 

 
Help xxvi 

 
rules 3-22  

Exchange Routing  
Canada 1-9  
United States 1-6 

 
I  
I800 Inbound  

Canada 1-4 
 
F  
feature 1-6  
Feature nodes 3-2  
Final-handling nodes 3-2  

Connecting node 3-3  
No Answer node 3-3  
Response node 3-3  
Term node 3-3  

Find and replace  
(nodes and branches) 4-2  
Finding  

branches 4-56  
CRP codes  

in a CRP table 6-8 

 
United States 1-2  

I800 Outbound  
Canada 1-4  
United States 1-2  

ICP. See Intelligent Call Processing 1-6  
IDs  

displaying in a CRP table 6-7  
displaying in a future changes table 6-21  
displaying in a plan 4-11  

Importing into labels  
Caller IDs 5-13  
dialed numbers 5-18  

Inserting  
nodes 4-10 
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Intelligent Call Processing (ICP) (United States) 1-6  
Intra-nodal validation 

 
Enroute 3-21  
Exchange 3-22  

turning on or off 4-49 
 
Fixed Queue 3-23  
Go To 3-24  
No Answer 3-25   

L  
Label Builders 4-4, 5-7  
Labels  

changing label contents 5-7, 5-27  
copying 5-29 

 
’
 
5-30  

creating 4-33, 5-5  
deleting 5-31, 5-33

 
’
 
5-6 

 
importing  

Caller IDs 5-13  
dialed numbers 5-18  

Label Builders 5-7  
printing 5-34  
renaming 5-30  
uses 5-2  

List view control 2-5, 2-7  

Prompter 3-26  
Response 3-28  
Termination 3-29  
Time 3-30  
Var Queue 3-31  

Node specific data field 3-3  
Node type field 3-3  
Nodes  

adding 4-10  
deleting 4-11  
fields 3-3  

changing 4-22  
displaying detail data about 4-38  
editing 4-12  
node specific data 3-3  
node type 3-3  
option 3-4 
typing data into 4-16   

M  
Mail. See Route It! Mail 8-1  
Moving  

plan portions 4-52  

finding 4-56  
inserting 4-10  
renumbering 4-56  
rules 3-5 ’

 
3-32  

nodes and branches 4-9  
NPA split. See Area code split A-1, B-131 

 
N 

 
O   

Names 5-2  
displaying in a CRP table 6-7  
displaying in a future changes table 6-21  
displaying in a plan 4-11  

Network Queuing (United States) 1-7  
Next Available Agent Routing (NAAR). See Alternate  

Termination Sequence 1-5  
No Answer node  

rules 3-25  
Node rules 3-5 

 
’ 
 
3-32 

 
Online help xxvi  

accessing 2-3  
Opening  

CRP tables 6-3  
future changes tables 6-18  
plans 4-6  
plans in Quick Call Allocator mode 4-23  

Option field 3-4  
Ordering documentation xxv   

Allocator 3-7  
Alternate Destination Routing 3-5  
Alternate Termination Sequence 3-10  
Area 3-8  
Call Type 3-12, 3-14, 3-16, 3-23, 3-31  
Caller ID 3-13  
Customer Routing Point 3-14  
Data Rate 3-16  
Day 3-18  
Dialed # 3-19  
Digit Prompter 3-20 

 
P  
PACR. See Post Answer Call Redirection 1-7, 1-9  
Plans  

activating 3-4  
basic concepts 3-1  
changing the size of 4-73  
closing 4-47  
copying portions 4-52  
deleting 4-66 
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getting information about 4-33  
getting summary information about 4-69 

 
United States 1-7  

 
moving portions 4-52 

 
Rotue It! Mail  

opening 4-6 
 
deleting mail messages 8-4  

printing 4-45 
 
Route It! Mail 8-1  

routing 4-1 
 
opening mail messages 8-3  

saving 4-38  
selecting portions of 4-50 

 
printing mail messages 8-4  
quitting mail task 8-4  

sending to the support system 4-42 
 
sorting mail messages 8-4  

validating 3-34 
 
Route It!starting Mail task 8-3  

Post Answer Call Redirection (United States) 1-7 
 
Routing plans. See Plans  

Printing 
 

 
Comm Log messages 7-11  
labels 5-34  
plans 4-45  

Prompter node 

 
S  

Label Builder for 5-23  
rules 3-26 

 
Saving  

Comm Log messages 7-13  
CRP tables 6-14  
future changes tables 6-26  

Q 
 

plans 4-38  
Security xxvi  

Quick Call Allocator  
Canada 1-9 

 
Sending  

CRP tables 6-15  
United States 1-7 

 
future changes tables 6-27  

Quick Call Allocator changes 4-23 
 
plans 4-42  

Quick changes 3-4 
 
Quick Call Allocator changes 4-31  

Quick toolbar 4-31 
 
Service Date  

Quitting  
CRP Tables task 6-37 

 
definition 3-33  

Service View  
Edit Plans 4-47 

 
changing  

in CRP Tables task 6-33  
in Edit Plans 4-64  

R  
RCP. See Recurrent Call Prompter 1-7  
Recurrent Call Prompter (RCP) (United States) 1-7  
Recurrent Call Prompting 1-7  
Redirect 1-7, 1-9  
Redirect Features (United States) 

 
definition 3-33  

Shortcut Menu 4-3  
Some 3-4  
Sorting columns of data. See List view control 2-7  
Status bar 2-1  
System-defined values 3-4 

 
Post Answer Call Redirection 1-7  
Recurrent Call Prompter 1-7  

Redo 4-5 

 
T 

 
Redo command 4-2, 4-4 

 
’ 
 
4-5 

 
Term node 3-3  

Renaming  
CRP tables 6-13 

 
Term node. See also Termination node 3-3  
Termination 3-3  

edit plans 4-39 
 
Termination node  

labels 5-30 
 
Label Builder for 5-25  

Renumbering nodes 4-56 
 
rules 3-29  

Response node 
 
Terminations  

rules 3-28  
Ring 1-7, 1-9 

replacing 4-62  
’ 

Ring/Busy 
 
Tile command 2-3  

Canada 1-9 
 
Time Manager (United States) 1-7 
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Time node  

rules 3-30 

 
Numbering dialed number 4-8, 4-57, 5-17  

Undo command 4-4 

 
’ 

 
5-18 

 
Time of Day (Canada) 1-9 

 
Uniline-Option 1 (Canada) 1-4  

Toll-Free Calling Services 
 
Universal International Freephone Numbering 3-19  

Canada 1-3 
 
Universal International Freephone Numbering dialed  

United States 1-2 
 
number 4-8, 4-57, 5-17 

 
’ 
 
5-18  

Toll-Free Canada Northbound Service  
Canada 1-4 

 

 
Toll-Free Classic 800 Service  

Canada 1-3  
United States 1-2 

 
V  

Toll-Free CustomNet Service  
Canada 1-4  
United States 1-3  

Toll-Free FTS2000  
United States 1-3  

Toll-Free I800 Inbound Service  
Canada 1-4  
United States 1-2  

Toll-Free I800 Outbound Service  
Canada 1-4 

 
Validation 3-34  

field 3-34  
inter-nodal 3-34  
intra-nodal 3-34  

turning on or off 4-49  
Values 3-3, 5-2  
Variable Queue node  

rules 3-31  
Viewbox 4-72 

 
United States 1-2  

Toll-Free Masterline  
Canada 1-3  
United States 1-2  

Toll-Free MasterLine Service 

 
Y  

 
Canada 1-3  

Toll-Free MEGACOM  
Canada 1-3  
United States 1-2  

Toll-Free Multimedia  
Canada 1-4  
United States 1-3  

Toll-Free READYLINE  
Canada 1-3  

Toll-Free READYLINE Service  
United States 1-2  

Toll-Free Unicom 800  
Canada 1-4  

Toolbars  
displaying 2-2  
moving 2-2  

Training xxvi  
Transaction request 7-1  
Transaction response 7-1  
Transfer Connect. See Post Answer Call Redirection 1-  

7 

 
U  
UIFN. See Universal International Freephone  

Numbering 3-19, 4-8  
UIFN. See Universal International Freephone 
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